Serial number for product registration:

To register on-line with Sonic Foundry, please follow the steps outlined in the registration wizards upon installation of this product.

Registering your product will provide you with technical support, notification of product updates, and special promotions exclusive only to Vegas Pro registered users.

Registration is required within 7 days of installation or your product will expire.

Sonic Foundry product registration helps protect against software copyright infringement and allows us to provide support exclusively to registered users.

If you do not have access to the Internet, registration assistance (in English) is available (Monday through Friday, 7:00 am-10:00 pm CST).

- In the North America, phone: 1-800-577-6642.
- From outside North America, phone: 800-000-76642.
- Fax in the US: 1-608-256-7300. Fax outside the US: 001-608-256-7300.

Sonic Foundry, Inc.
754 Williamson Street
Madison, WI  53703

Sales/Customer Service Only (in North America): 1-800-57-SONIC
Technical Support: 608-256-5555
Fax: 608-256-7300

Sonic Foundry Europe
PO Box 2903
2601 CX Delft
Netherlands
The information contained in this manual is subject to change without notice and does not represent a commitment on the part of Sonic Foundry. The software described in this manual is provided under the terms of a license agreement or non-disclosure agreement. The software license agreement specifies the terms and conditions for its lawful use. No part of this manual may be reproduced or transmitted in any form or by any means for any purpose other than the purchaser's personal use, without written permission from Sonic Foundry, Inc.

Sonic Foundry and Vegas Pro are trademarks of Sonic Foundry, Inc. All other products mentioned in this manual are trademarks or registered trademarks of their respective holders.

© 1999 Sonic Foundry, Inc.
# Table of Contents

Introduction ................................................................. 11

Welcome to Sonic Foundry Vegas Pro™ .......................... 11
System requirements .................................................. 12
Technical Support ..................................................... 12
  Web site support .................................................. 12
  Email support ..................................................... 12
  Fax support ......................................................... 13
  Telephone support ............................................... 13
Installing Vegas Pro. ................................................... 13
Starting Vegas Pro. ..................................................... 14
  Using the shortcut ............................................... 14
  Using the Start button ......................................... 14
Serial number and activation code ............................... 15
Registration .............................................................. 15
  Registering online .............................................. 15
  Registering via the telephone ................................ 16
Using the online help .................................................. 17
  Accessing help .................................................. 17
Overview ................................................................. 19
  Main window ...................................................... 19
  Toolbar ........................................................... 20
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marker bar</td>
<td>20</td>
</tr>
<tr>
<td>Ruler</td>
<td>21</td>
</tr>
<tr>
<td>Track List</td>
<td>21</td>
</tr>
<tr>
<td>Track View</td>
<td>22</td>
</tr>
<tr>
<td>Transport bar controls</td>
<td>22</td>
</tr>
<tr>
<td>Scrub control</td>
<td>22</td>
</tr>
<tr>
<td>Window Docking Area</td>
<td>23</td>
</tr>
<tr>
<td>Keyboard command reference</td>
<td>25</td>
</tr>
<tr>
<td>Signal Flow</td>
<td>28</td>
</tr>
<tr>
<td>Quick Start</td>
<td>29</td>
</tr>
<tr>
<td>Media Files</td>
<td>29</td>
</tr>
<tr>
<td>What type of media can you use?</td>
<td>29</td>
</tr>
<tr>
<td>Starting a project</td>
<td>30</td>
</tr>
<tr>
<td>Finding media files to use</td>
<td>30</td>
</tr>
<tr>
<td>Previewing a media file</td>
<td>32</td>
</tr>
<tr>
<td>Placing a media file on a track</td>
<td>33</td>
</tr>
<tr>
<td>Placing a event on the Video Ruler</td>
<td>34</td>
</tr>
<tr>
<td>Audio event basics</td>
<td>34</td>
</tr>
<tr>
<td>Moving events along the timeline</td>
<td>34</td>
</tr>
<tr>
<td>Track navigation</td>
<td>36</td>
</tr>
<tr>
<td>Track Number</td>
<td>36</td>
</tr>
<tr>
<td>View buttons</td>
<td>37</td>
</tr>
<tr>
<td>Track FX button</td>
<td>37</td>
</tr>
<tr>
<td>Bus assignment</td>
<td>37</td>
</tr>
<tr>
<td>Arm for Record button</td>
<td>38</td>
</tr>
<tr>
<td>Mute button</td>
<td>38</td>
</tr>
<tr>
<td>Solo button</td>
<td>38</td>
</tr>
<tr>
<td>Scribble Strip</td>
<td>39</td>
</tr>
<tr>
<td>Volume fader</td>
<td>39</td>
</tr>
<tr>
<td>Multipurpose slider</td>
<td>40</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Video event basics</td>
<td>41</td>
</tr>
<tr>
<td>Moving the video event</td>
<td>41</td>
</tr>
<tr>
<td>Removing the video’s audio</td>
<td>42</td>
</tr>
<tr>
<td>Playing back the project</td>
<td>42</td>
</tr>
<tr>
<td>Play back within Vegas Pro</td>
<td>42</td>
</tr>
<tr>
<td>Previewing to media player</td>
<td>44</td>
</tr>
<tr>
<td>Using project properties</td>
<td>45</td>
</tr>
<tr>
<td>Saving the project</td>
<td>45</td>
</tr>
<tr>
<td>Saving your project the first time</td>
<td>45</td>
</tr>
<tr>
<td>Renaming or rendering a project (using Save As...)</td>
<td>46</td>
</tr>
<tr>
<td>Rendering a Vegas project</td>
<td>47</td>
</tr>
<tr>
<td>Tutorial</td>
<td>49</td>
</tr>
<tr>
<td>Getting the tutorial folder</td>
<td>49</td>
</tr>
<tr>
<td>Using the Explorer window</td>
<td>50</td>
</tr>
<tr>
<td>Placing the video</td>
<td>50</td>
</tr>
<tr>
<td>Displaying the Video Preview</td>
<td>51</td>
</tr>
<tr>
<td>Playing back the video</td>
<td>52</td>
</tr>
<tr>
<td>Placing the new voice-over</td>
<td>52</td>
</tr>
<tr>
<td>Aligning new voice-over with video</td>
<td>53</td>
</tr>
<tr>
<td>Editing the voice-over</td>
<td>54</td>
</tr>
<tr>
<td>Locking the original audio</td>
<td>54</td>
</tr>
<tr>
<td>Editing a time selection</td>
<td>55</td>
</tr>
<tr>
<td>Splitting an event using time selection</td>
<td>55</td>
</tr>
<tr>
<td>Editing an event</td>
<td>56</td>
</tr>
<tr>
<td>Aligning the remaining voice-over events</td>
<td>56</td>
</tr>
<tr>
<td>Grouping the voice-over and video</td>
<td>57</td>
</tr>
</tbody>
</table>
Working with the music bed. ........................................... 58
  Placing the music bed ........................................... 58
  Adding a volume envelope ..................................... 58
  Setting the volume envelope .................................. 59
Adding equalization (EQ) to the voice-over .................... 60
Saving a Vegas project (*.veg) .................................... 61
Rendering the project as an *.avi .................................. 62
  Setting the format ................................................ 62
  Applying compression ......................................... 63

General Editing ..................................................... 65
  Using the cursor ................................................ 65
Editing event and time selections ................................. 66
  Selecting multiple events ..................................... 66
  Selecting a time range ....................................... 67
  Selecting events and a time range ............................ 68
Basic event editing ................................................ 69
  Copying events .................................................. 69
  Pasting events .................................................. 70
  Cutting events .................................................... 73
  Trimming/Cropping events ................................. 74
  Deleting events .................................................. 75
Using the Undo and Redo commands .................... 77
  Undo command ................................................... 77
  Redo command ................................................... 78
  Clearing the edit history .................................... 79
Using project markers and regions ............................. 80
  Working with markers ........................................ 80
  Working with regions ......................................... 83
  Working with command markers ............................. 86
Using a sound editor program. .............................................. 90
Setting up the sound editor program. ................................. 90
Opening the sound editor from Vegas Pro ............................. 92

Advanced Audio Editing ....................................................... 93
Snapping events ............................................................... 93
  Using the event snap offset ............................................. 93
  Snapping to grid lines .................................................... 94
  Snapping to markers ..................................................... 95
  Disable snapping .......................................................... 95
  Splitting events ........................................................... 96

Using the Ripple Edits ....................................................... 98
  Cutting events in ripple mode .......................................... 98
  Deleting events in ripple mode ....................................... 100
  Pasting events in ripple mode ....................................... 101

Accessing event properties ............................................... 103
  Changing the active take’s name .................................... 104
  Using the pitch shift ..................................................... 106
  Setting event switches ................................................ 107

Using event switches ....................................................... 107
  Muting an event .......................................................... 108
  Locking an event ......................................................... 109
  Looping an event ......................................................... 110
  Normalizing an event .................................................. 111

Using event envelopes (ASR) .............................................. 113
  Setting an event’s volume .............................................. 113
  Setting an event’s fade in and out .................................. 113

Crossfading events ......................................................... 115
  Automatic crossfades .................................................... 115
  Manually setting a crossfade ......................................... 116
  Changing crossfade curves ............................................ 116
Using Track FX ................................................. 142
  Creating a track plug-in chain ............................... 142
  Arranging the plug-in’s chain order ......................... 145
  Removing plug-ins from a chain ............................. 147
  Saving plug-in chains as presets ............................ 148
Vegas Pro plug-in reference .................................... 149
  Using the Equalization (EQ) plug-in ......................... 149
  Using the Compression plug-in ............................... 152
  Using Noise Gate plug-in .................................... 156
  Using the Dither plug-in .................................... 158
Using track envelopes .......................................... 160
  Adding a volume envelope .................................... 160
  Hiding the volume envelopes ................................. 163
  Removing track volume envelopes ......................... 163
  Adding a panning envelope .................................. 164
  Hiding the panning envelopes ............................... 166
  Removing track panning envelopes ......................... 166
Mixing multiple tracks to a single track .................. 167
Using the Mixer .................................................. 169
  Using the Mixer window ...................................... 169
    Viewing the Mixer window ................................ 169
    Using the Mixer tool bar .................................. 170
    Using the Mixer Preview fader ............................ 170
  Using busses .................................................. 173
    Adding busses to the project ............................. 173
    Deleting busses from the project ......................... 175
    Routing busses to hardware .............................. 176
    Working with busses ..................................... 177
    Adding plug-in chains to busses ......................... 181
    Arranging bus plug-ins on the chain ................. 183
    Deleting plug-ins from the bus chain .................. 185
Using Assignable FX controls ........................................ 186
  Adding Assignable FX controls ................................ 186
  Arranging Assignable FX plug-ins on the chain ............. 189
  Routing Assignable FX to busses ................................ 192
  Working with Assignable FX controls ......................... 192
Working with preset plug-in chains ............................ 196
  Creating new preset plug-in chains ........................... 196
  Editing preset plug-in chains .................................. 198
  Organizing your plug-ins ........................................ 198

Recording ............................................................ 199
  Setting up your equipment ...................................... 199
    Basic setup ..................................................... 199
    Setup with mixer .............................................. 200
    Setup with digital multitrack ................................ 200
  Arming the track for recording ................................. 201
    Using the Sound Mapper for stereo or mono recording .... 201
    Assigning tracks to input devices .......................... 202
    Starting and stopping recording ............................. 203
  Recording into an empty track ................................ 204
  Recording into a time selection ............................... 205
  Recording into an event ........................................ 206
  Recording into an event with a time selection .............. 207
  Working with multiple recorded takes ....................... 208
    Previewing takes ............................................. 208
    Choosing an active take after loop recording ............. 209
    Renaming an event take ..................................... 210
    Deleting an event take ..................................... 211
    Specifying where recordings are stored .................... 213
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving and Rendering projects</td>
<td>215</td>
</tr>
<tr>
<td>Saving your project</td>
<td>215</td>
</tr>
<tr>
<td>Creating a copy of a project (using Save As...)</td>
<td>216</td>
</tr>
<tr>
<td>Rendering projects</td>
<td>218</td>
</tr>
<tr>
<td>Rendering to an audio format</td>
<td>219</td>
</tr>
<tr>
<td>Rending to a video format</td>
<td>220</td>
</tr>
<tr>
<td>Rending to a streaming media format</td>
<td>221</td>
</tr>
<tr>
<td>Using rendering format controls and templates</td>
<td>222</td>
</tr>
<tr>
<td>Using *.aif controls and templates</td>
<td>223</td>
</tr>
<tr>
<td>Using *.wav controls and templates</td>
<td>225</td>
</tr>
<tr>
<td>Using *.mp3 controls and templates</td>
<td>227</td>
</tr>
<tr>
<td>Using *.wma controls and templates</td>
<td>230</td>
</tr>
<tr>
<td>Using *.avi controls and templates</td>
<td>232</td>
</tr>
<tr>
<td>Using *.asf controls and templates</td>
<td>236</td>
</tr>
<tr>
<td>Using *.rm controls and templates</td>
<td>239</td>
</tr>
<tr>
<td>Customizing Vegas Pro</td>
<td>243</td>
</tr>
<tr>
<td>Dockable Vegas Pro windows</td>
<td>243</td>
</tr>
<tr>
<td>Docking a window</td>
<td>244</td>
</tr>
<tr>
<td>Using the Explorer window</td>
<td>245</td>
</tr>
<tr>
<td>Managing your media files</td>
<td>246</td>
</tr>
<tr>
<td>Using the Explorer window Transport bar</td>
<td>250</td>
</tr>
<tr>
<td>Changing the Explorer window views</td>
<td>251</td>
</tr>
<tr>
<td>Changing the Ruler settings</td>
<td>253</td>
</tr>
<tr>
<td>Grid spacing</td>
<td>254</td>
</tr>
<tr>
<td>Working with the Toolbar</td>
<td>255</td>
</tr>
<tr>
<td>Moving the Toolbar</td>
<td>255</td>
</tr>
<tr>
<td>Resizing the Toolbar</td>
<td>256</td>
</tr>
<tr>
<td>Hiding and displaying the Toolbar</td>
<td>256</td>
</tr>
<tr>
<td>Reordering the Toolbar buttons</td>
<td>257</td>
</tr>
<tr>
<td>Adding buttons to the Toolbar</td>
<td>258</td>
</tr>
</tbody>
</table>
Removing buttons from the Toolbar ................................................. 259

Using the Time Display window ................................................. 261
  Changing the Time Display window’s settings ............................... 261
  Changing the Time Displays colors ........................................... 262
  Setting the Time Display to monitor MIDI time code ..................... 263

Working with project properties ................................................. 263
  Using the Summary properties tab ............................................ 264
  Using the Audio properties tab .............................................. 265
  Using the Video properties tab .............................................. 266
  Using the Ruler properties tab .............................................. 267

Using Vegas Pro preferences ..................................................... 268
  Viewing the Preferences dialog .............................................. 268
  Using the General preferences tab ......................................... 269
  Using the Routing preferences tab ......................................... 270
  Using the Audio preferences tab ......................................... 272
  Setting advanced audio preferences ..................................... 274
  Using the Sync. preferences tab ............................................ 275
  Setting advanced Sync. preferences ....................................... 276

Troubleshooting ................................................................. 281
  Why are some of my DirectX plug-ins not working correctly? ........ 281
  Why do I hear gaps in my audio playback? ............................... 281
  Why can’t I get my other DirectX plug-ins to work as Track effects? 283
  MPEG and Quicktime Video Audio/Video Synchronization Issues ....... 284
  Some AVI's that open in Windows Media Player don’t open in Vegas Pro 284
  Why does a mono event increase 6 dB when panning a track hard to either side? 284

Glossary ................................................................. 285

Index ................................................................. i
Welcome to Sonic Foundry Vegas Pro™

Sonic Foundry introduces Vegas Pro, an innovative and advanced multitrack media editing system. Vegas Pro was designed to create an efficient audio/video production environment without sacrificing the quality and processing power that you expect from Sonic Foundry.

Vegas Pro removes the barriers commonly found between your creativity and sophisticated multitrack recording and editing. Whether it's the standard and familiar Windows navigation commands, or the clean and uncluttered interface throughout, you'll find Vegas Pro a tool that will be mastered in minutes. But don't let that fool you. Beneath the Vegas Pro unique and customizable interface, you'll find a product so powerful and flexible, you'll forget you've just completed your project in half the time.

This table lists some of the features available in Vegas Pro, the perfect multitrack media editing system for your studio or production environment:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-destructive editing</td>
<td>Unlocked tracks</td>
</tr>
<tr>
<td>Unlimited undo/redo</td>
<td>Multiple file formats (.wav/.aif) on a single track</td>
</tr>
<tr>
<td>Automatic crossfade functionality</td>
<td>EQ and compressor inserts available on every track</td>
</tr>
<tr>
<td>Quick-edit media trimmer with direct link to *.wav editor</td>
<td>Simultaneous multitrack record &amp; play</td>
</tr>
<tr>
<td>Loop recording</td>
<td>Plug-in manager</td>
</tr>
<tr>
<td>Real time event resampling</td>
<td>32 assignable DirectX FX sends</td>
</tr>
<tr>
<td>Audio/video scrub control</td>
<td>DirectX Plug-In support</td>
</tr>
<tr>
<td>Video preview window</td>
<td>Dual processor support</td>
</tr>
<tr>
<td>Edit detail list management</td>
<td>Multiple I/O support</td>
</tr>
<tr>
<td>24-bit/96 kHz</td>
<td>MIDI Time Code generate &amp; chase</td>
</tr>
<tr>
<td>28 Auxiliary outputs</td>
<td>Dual monitor support</td>
</tr>
<tr>
<td>Internet streaming file authoring (Windows Media Technologies 4.0 and RealNetworks G2)</td>
<td>Ability to incorporate timeline metadata (markers/captions) for Internet content authoring</td>
</tr>
<tr>
<td>Imports: .wav, .aif, .avi, .mov (using Microsoft DirectShow), .mpg (video), .bmp</td>
<td>Exports: .wav, .aif, .avi, .wma, .asf, .rm, .mp3 (with optional plug-in)</td>
</tr>
</tbody>
</table>
System requirements

Your system’s components affect how well Vegas Pro performs.

Common
• Microsoft® Windows™ 9x or NT 4.0
• CD-ROM drive
• 20 MB hard-disk space for program installation
• Windows-compatible sound card
• Internet Explorer™ 4.0 (included on CD-ROM) or later to view online help

Minimum
• 200 MHz processor
• VGA display
• 32 MB RAM
• DirectX Media 6.0 (included on CD-ROM) or later

Recommended
• 400 MHz processor
• 128 MB RAM
• 16-bit color display

Technical Support

If you experience problems or have questions while using Vegas Pro, there are a few ways to get the information that you need from Sonic Foundry: Web site support, Email support, Fax support, and Telephone support.

Web site support

Visit our Web site at www.sonicfoundry.com/support. You will find technical information, reference information, program updates, tips and tricks, and a Frequently Asked Questions (FAQ) archive.

Email support

Send your questions or comments to support@sonicfoundry.com. Our Technical Support Department will respond to you within 36 business hours.
Fax support

Send your questions or comments via fax 24 hours a day at (608) 256-7300. You will receive a response within 36 business hours.

Telephone support

Our technical support representatives are available Monday-Friday from 8am to 7pm (CST) at (608) 256-5555.

Before You Call Support

Before you contact our technical support department, we ask that you do the following:

• Check to see if your question may be answered in the manual or online help.
• Use a telephone that is near the computer where Vegas Pro is installed.
• Make sure you have registered the product. For more information, see Registration on page 15.

Installing Vegas Pro

Before you install Vegas Pro, we recommend that you exit all open programs and temporarily disable any virus protection.

1. Insert the Vegas Pro CD-ROM. The Vegas Pro Installation screen appears (if CD-ROM AutoPlay is enabled).

   If the CD-ROM AutoPlay is disabled, click on the button and choose Run.

   In the Run window that appears, type the CD-ROM drive's letter and add :\setup.exe. Click the OK button to start the installation.

2. Click Install Software. The installation process begins.

3. Follow the screen prompts and enter the necessary information when required.

   • Use the button to continue the installation.
   • Use the button to suspend the installation and review previous screen prompts.
   • Use the button to terminate the installation process.

4. At the last screen prompt, click the button to conclude the installation.
Starting Vegas Pro

Starting Vegas Pro is exactly the same as starting most Windows programs that you may use already. After Vegas Pro has been installed on your computer, there are two ways to start the program.

Using the shortcut

You may have noticed a new icon on your desktop ( ) upon completion of the installation procedure. This icon is a shortcut to the Vegas Pro program located on your hard drive. By double-clicking on this icon, you will start Vegas Pro directly from the desktop.

Using the Start button

The second method to start also allows you to start Vegas Pro right from the desktop. This procedure is exactly the same as other Windows-based programs.
1. Click the button on the task bar. The menu appears.
2. From the menu, choose Programs. The Programs list menu appears.
3. From the Programs menu, choose Sonic Foundry Vegas. A sub-menu appears.
4. From the sub-menu, choose Sonic Foundry Vegas to start the program. The registration dialog window appears. (Once you register Vegas Pro, this dialog will not appear again.)
5. Enter either the serial number or the activation code and click to start using Vegas Pro. (The serial number is located on the title page of the manual.)
Serial number and activation code

The first time you start Vegas Pro, the registration dialog appears. You need to enter either the serial number or the activation code. Either number will start Vegas Pro so that you may immediately begin your first project.

The serial number allows you to run Vegas Pro for 7 days. After the 7 days expire, Vegas Pro will time out. If you purchased Vegas Pro, you can receive your activation code by registering either online or by telephone.

Note: If you have started a project and Vegas Pro times out, you will not lose the project. It will be available when you start the program after you have registered, received, and entered your activation code.

An activation code is based on the Computer ID number where Vegas Pro is loaded. Each computer has a unique number, similar to a license plate. An activation code is created based on that unique number. When you register Vegas Pro, Sonic Foundry will generate an activation code for you. Once the activation code is entered, Vegas Pro will not time out; it is yours. Because the activation code is based on the Computer ID, it is important that you have Vegas Pro loaded on the computer where you will be using it.

The Computer ID is automatically detected and provided to you when you install Vegas Pro.

Registration

The registration dialog that appears when you start Vegas Pro allows you to quickly and easily register to get your activation code. You may register via the Sonic Foundry web site or via the telephone.

Registering online

When you register online, your activation code is sent to your email address within minutes after you complete and submit the online registration form.

To register online, do the following:

1. Select the second radio button labeled I would like to register online.
2. Click the button. Your internet browser automatically starts (if it is not already running) and the Sonic Foundry online registration form appears.
3. Fill in the form’s required fields, which are indicated with an asterisk (*). You will notice that some of the information is already inserted for you, most notably the Computer ID number.

4. Make sure that your email address is entered correctly. This address is where the activation code will be sent.

5. Submit the form to register. In a few minutes, your activation code is sent to your email address.

6. Copy the activation code from the email message and paste it into the registration field on the Vegas Pro Registration dialog.

7. Click the Finish button to activate Vegas Pro and become a fully registered customer.

Registering via the telephone

When you register via telephone, a Customer Service Representative will help you to obtain your activation code.

To register via telephone, do the following.

1. Select the third radio button labeled I would like to register over the phone.

2. Click the button. A new dialog will appear with a field where you will enter the activation code. Your Computer ID number appears below this field.

3. When the Customer Service Representative gives you the activation code, type it in the field.

4. Click the Finish button to activate Vegas Pro and become a fully registered customer.
Using the online help

Vegas Pro includes HTML online help. To view the online help, you need to have Internet Explorer 4.0 or higher loaded on your system (included on the Vegas Pro CD-ROM).

Accessing help

The online help is available in two forms: in a Main help window or What’s This? help window. Both forms are available via the keyboard or the Help menu.

Main help window

The Main help window is accessed either by choosing Contents and Index from the Help menu or pressing the F1 key. This window has three tabs that you can use to find the information that you need.

The Contents tab provides a categorized listing of available help topics. Click on the book ( ), then on the topic page ( ) you want information about.

The Index tab provides a complete listing of the help topics available. Use the scroll bar to scroll through the list of available topics or type a word in the text field to quickly locate topics related to the word. Select the topic and click the button.

The Search tab allows you to enter a keyword and display all of the topics in the online help that contain the keyword you have entered. Type a keyword in the text field and click on the List Topics button. Select the topic from the list and click the button.

What’s This? help

What’s This? help allows you to view pop-up window descriptions for Vegas Pro menus, buttons, and dialog boxes. Choose What’s This? from the Help menu or press the Shift + F1 keys, and then click on any Vegas Pro item. To use What’s This? help in a dialog box, click on the question mark ( ) in the upper-right hand corner of the dialog box, then on an item.
Tip of the Day

The Tip of the Day displays functional tips to increase your productivity with Vegas Pro. To view and scroll through the Tip of the Day messages, choose Tip of the Day from the Help menu.

PDF manual

There is a more current manual available on the Vegas Pro CD-ROM. The PDF manual contains information that was written during this manual’s press time. To view this manual, you will need Adobe® Acrobat® Reader (also included on the Vegas Pro CD-ROM).

Help on the web

Additional Vegas Pro help and information is available on the Sonic Foundry web site. Choose Sonic Foundry on the Web from the Help menu to view a listing of web pages pertaining to Vegas Pro and Sonic Foundry. If your browser is not already open, Vegas Pro will automatically start it for you.
Overview

Vegas Pro is designed to be an easy-to-use program with many tools that provide power and flexibility when creating and working with media files. As you will learn, many of the Vegas Pro operations, menu items, and shortcut keys are common to other popular software applications.

Vegas Pro is a unique and powerful program that gives you tremendous flexibility. The following sections are a graphical tour of the Vegas Pro work area. Please take a moment to get familiar with the Vegas Pro interface. Many of the procedures in this manual use terminology found in these sections.

Main window

This is the window that appears when you open Vegas Pro. The work area is primarily three frames: the Track List, the Track View, and the Window Docking Area. The other parts of the interface are tools and features used while working with your project.
**Toolbar**

The Toolbar allows you to quickly access the most commonly-used functions and features in Vegas Pro.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create new project" /></td>
<td>Create new project</td>
</tr>
<tr>
<td><img src="image" alt="Open existing project" /></td>
<td>Open existing project</td>
</tr>
<tr>
<td><img src="image" alt="Save project" /></td>
<td>Save project</td>
</tr>
<tr>
<td><img src="image" alt="Open project properties" /></td>
<td>Open project properties</td>
</tr>
<tr>
<td><img src="image" alt="Cut selected events or time range" /></td>
<td>Cut selected events or time range</td>
</tr>
<tr>
<td><img src="image" alt="Copy selected events or time range" /></td>
<td>Copy selected events or time range</td>
</tr>
<tr>
<td><img src="image" alt="Paste items from clipboard into project" /></td>
<td>Paste items from clipboard into project</td>
</tr>
<tr>
<td><img src="image" alt="Undo command" /></td>
<td>Undo command</td>
</tr>
<tr>
<td><img src="image" alt="Redo command" /></td>
<td>Redo command</td>
</tr>
<tr>
<td><img src="image" alt="Enable snapping to grid lines" /></td>
<td>Enable snapping to grid lines</td>
</tr>
<tr>
<td><img src="image" alt="Automatic crossfades" /></td>
<td>Automatic crossfades</td>
</tr>
<tr>
<td><img src="image" alt="Ripple edits" /></td>
<td>Ripple edits</td>
</tr>
<tr>
<td><img src="image" alt="Edit tool" /></td>
<td>Edit tool</td>
</tr>
<tr>
<td><img src="image" alt="Envelope tool" /></td>
<td>Envelope tool</td>
</tr>
<tr>
<td><img src="image" alt="Selection tool" /></td>
<td>Selection tool</td>
</tr>
<tr>
<td><img src="image" alt="Zoom tool" /></td>
<td>Zoom tool</td>
</tr>
</tbody>
</table>

**Marker bar**

The Marker bar is the area where informational tags may be placed, named, and positioned along the project’s timeline.
Ruler

The Ruler is the timeline for your project. You may specify how the Ruler measures time: seconds, measures and beats, frames, etc.

Track List

This list identifies the track order in your project. Each track’s controls are also available in the Track List.
Track View

All arranging and editing is done in the Track View. This area contains all the project's events.

Transport bar controls

The Transport bar contains the playback and cursor positioning buttons frequently used while working on your project.

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎧</td>
<td>Record into track</td>
</tr>
<tr>
<td>🎧</td>
<td>Loop playback</td>
</tr>
<tr>
<td>⏯️</td>
<td>Play back from beginning of project</td>
</tr>
<tr>
<td>⏯️</td>
<td>Play back project from cursor position</td>
</tr>
<tr>
<td>🕳️</td>
<td>Pause project playback</td>
</tr>
<tr>
<td>■</td>
<td>Stop playback</td>
</tr>
<tr>
<td>⏯️</td>
<td>Move cursor to start of project</td>
</tr>
<tr>
<td>⏯️</td>
<td>Move cursor to end of project</td>
</tr>
<tr>
<td>⏯️</td>
<td>Move cursor left at grid increments</td>
</tr>
<tr>
<td>⏯️</td>
<td>Move cursor right at grid increments</td>
</tr>
</tbody>
</table>

Scrub control

The Scrub control is used to play your project forward or backward for editing purposes. You may adjust playback speed by setting the Speed Control Marker located beneath the Scrub control.

Click and drag either forward or backward for playback.
Window Docking Area

This area allows you to keep frequently-used windows available, but out of the way while you are working with a project. To dock a window, simply drag and drop it to the Docking Area. This area has three regions in which a window can be placed: right, middle, and left. As a result, the Docking Area can display up to three windows at a time.

When windows are docked, they will either be displayed on top of the other windows, or each window's tab will appear above the task bar. Simply click the window's tab to bring it to the top.

Explorer window

The Explorer window works similarly to the Windows 9x and NT file management Explorer included with your operating system. Use the Vegas Pro Explorer window to select media files to place into your projects.

Select drive or folder

Preview selected media file before you place it in the project

Select media to place in the project by dragging and dropping or double-clicking
Video Preview window

This window displays a project’s video event during project editing and playback. If a video event is not placed in the project, you will see “--No Video--” in the center of this window.

Trimmer window

The Trimmer window is a good place to edit an audio event. When an event is placed in the Trimmer window, you may take portions of the event and place them on separate tracks by dragging and dropping. For more information, see Using the Trimmer window on page 120.

Mixer window

The Mixer window gives you access to your project’s properties, bus assignments, output levels, and plug-in chains.
Keyboard command reference

Vegas Pro keyboard commands are shortcuts that you can use while working with your project.

**Project file commands**
These commands refer to the overall project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open existing project or media file</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Open project’s properties</td>
<td>Alt+Enter</td>
</tr>
</tbody>
</table>

**Window view commands**
These commands display and hide the dockable windows included with Vegas Pro.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track view</td>
<td>Alt+0</td>
</tr>
<tr>
<td>Explorer</td>
<td>Alt+1</td>
</tr>
<tr>
<td>Trimmer</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Mixer</td>
<td>Alt+3</td>
</tr>
<tr>
<td>Edit Details</td>
<td>Alt+4</td>
</tr>
<tr>
<td>Plug-ins</td>
<td>Alt+5</td>
</tr>
<tr>
<td>Video Preview</td>
<td>Alt+6</td>
</tr>
</tbody>
</table>

**Edit commands**
These commands refer to the event editing that you can use while you are working on a project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z or Alt+Backspace</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Shift+Z</td>
</tr>
<tr>
<td>Cut selection</td>
<td>Ctrl+X or Shift+Delete</td>
</tr>
<tr>
<td>Copy selection</td>
<td>Ctrl+C or Ctrl+Insert</td>
</tr>
<tr>
<td>Paste from clipboard</td>
<td>Ctrl+V or Shift+Insert</td>
</tr>
<tr>
<td>Select all</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Unselect all</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Delete selection</td>
<td>Delete</td>
</tr>
<tr>
<td>Select left by grid marks</td>
<td>Shift+Ctrl+PageUp</td>
</tr>
<tr>
<td>Select right by grid marks</td>
<td>Shift+Ctrl+PageDown</td>
</tr>
<tr>
<td>Restore selection</td>
<td>Backspace</td>
</tr>
<tr>
<td>Paste repeat from clipboard</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Split event(s)</td>
<td>S</td>
</tr>
<tr>
<td>Trim/Crop selected events</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Open in Sound Editor</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Mix to new</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Mix to preview</td>
<td>Ctrl+Shift+M</td>
</tr>
<tr>
<td>Make a selection during play back</td>
<td>I (in) and O (out)</td>
</tr>
</tbody>
</table>
**Cursor placement commands**

These commands refer to cursor navigation within the Track View.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of selection or view (if no selection)</td>
<td>Home or W</td>
</tr>
<tr>
<td>Go to end of selection or view (if no selection)</td>
<td>End or E</td>
</tr>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
</tr>
</tbody>
</table>

**Playback commands**

These commands refer to the playback controls, which are also found on the Transport bar.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/stop playback</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Stop playback</td>
<td>Esc</td>
</tr>
<tr>
<td>Looped playback</td>
<td>L</td>
</tr>
<tr>
<td>Pause</td>
<td>Enter</td>
</tr>
<tr>
<td>Record</td>
<td>Ctrl+R</td>
</tr>
</tbody>
</table>

**Event commands**

These commands refer to moving selected events.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move selected event(s) one pixel</td>
<td>Right (arrow) number pad</td>
</tr>
<tr>
<td>Move selected event(s) one pixel</td>
<td>Left (arrow) number pad</td>
</tr>
<tr>
<td>Move selected event(s) up one track</td>
<td>Up (arrow) number pad</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move selected event(s) down one track</td>
<td>Down (arrow) number pad</td>
</tr>
<tr>
<td>Move selected event(s) right on grid</td>
<td>Ctrl+Right (arrow) number pad</td>
</tr>
<tr>
<td>Move selected event(s) left on grid</td>
<td>Ctrl+Left (arrow) number pad</td>
</tr>
</tbody>
</table>
### Track view commands

These commands refer to editing functions related to the tracks in your project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New audio track</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td>Enable/disable snapping</td>
<td>F8</td>
</tr>
<tr>
<td>Snap to markers</td>
<td>Shift+F8</td>
</tr>
<tr>
<td>Snap to grid</td>
<td>Ctrl+F8</td>
</tr>
<tr>
<td>Ripple edit mode</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Auto crossfade mode</td>
<td>X</td>
</tr>
<tr>
<td>Edit tool selection</td>
<td>D</td>
</tr>
<tr>
<td>Normal edit tool</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>New audio track</td>
<td>Ctrl+Q</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group selected events</td>
<td>G</td>
</tr>
<tr>
<td>Mark in point</td>
<td>I or [</td>
</tr>
<tr>
<td>Mark out point</td>
<td>O or ]</td>
</tr>
<tr>
<td>Insert/Remove track-volume envelope</td>
<td>V</td>
</tr>
<tr>
<td>Insert/Remove track-panning envelope</td>
<td>P</td>
</tr>
<tr>
<td>Insert Region</td>
<td>R</td>
</tr>
<tr>
<td>Insert Marker</td>
<td>M</td>
</tr>
<tr>
<td>Insert Command Marker</td>
<td>C</td>
</tr>
<tr>
<td>Group selected events</td>
<td>G</td>
</tr>
</tbody>
</table>

### View commands

These commands refer to magnification of tracks and the events contained on them.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase track height</td>
<td>Ctrl+Shift+Up (arrow)</td>
</tr>
<tr>
<td>Decrease track height</td>
<td>Ctrl+Shift+Down (arrow)</td>
</tr>
<tr>
<td>Zoom in time (incremental)</td>
<td>Up (arrow)</td>
</tr>
<tr>
<td>Zoom out time (incremental)</td>
<td>Down (arrow)</td>
</tr>
</tbody>
</table>

### Miscellaneous commands

These commands allow you to access help related items and refresh the screen.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online help</td>
<td>F1</td>
</tr>
<tr>
<td>What’s This? help</td>
<td>Shift+F1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Popup menu</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>Refresh screen</td>
<td>F5</td>
</tr>
</tbody>
</table>
Signal Flow
The Vegas Pro environment is a new way of thinking in multitrack mixing. Whether you are experienced at mixing or brand-new to it, you will find Vegas Pro easy to use and powerful. As you use Vegas Pro, experiment with different features and listen to the results in real-time.

This chapter was designed to help you get familiar with the interface and describe the essential operations for using Vegas Pro. Using this chapter will get you into the program quickly to begin your first project or to begin experimenting with Vegas Pro. In the next chapter, we take you through a sample project from start to finish, using sample media files included on the Vegas Pro CD-ROM. For more information, see Tutorial on page 49.

Media Files

Before we get started in Vegas Pro, there are a few terms that need to be defined:

- Media files - audio and video files that may be placed within your project.
- Events - playable portions of media files within a track. Events have fully editable starting and ending points.
- Tracks - timeline containers where events are placed and arranged.

What type of media can you use?

A media file is an audio file that can be placed on a track or a video file that can be placed on the video ruler.

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wave (Microsoft)</td>
<td>*.wav</td>
<td>Standard audio format used on Windows-based computers</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>*.avi</td>
<td>Standard audio/video format used on Windows-based computers</td>
</tr>
<tr>
<td>AIFF</td>
<td>*.aif</td>
<td>Standard audio format used on Macintosh computers</td>
</tr>
<tr>
<td>QuickTime</td>
<td>*.mov</td>
<td>Standard audio/video format used on Macintosh computers (using Microsoft DirectShow)</td>
</tr>
<tr>
<td>Bitmap</td>
<td>*.bmp</td>
<td>Standard graphic format used on Windows-based computers</td>
</tr>
<tr>
<td>MPEG3</td>
<td>*.mp3</td>
<td>Highly compressed media file. This file type can only be placed via plug-in.</td>
</tr>
</tbody>
</table>
A media file is referred to as an event after you have placed it on a track. Tracks are the containers for audio events. Each track can contain more than one event.

You may place events on separate tracks, or place all events on the same track:

In addition, you may place a video file on the Video Ruler. If the video has audio included, Vegas Pro automatically creates a new track and places the video's audio on it.

Starting a project

When you first open Vegas Pro, it displays an empty project. You may begin finding, previewing, and placing media files and start building your project. Vegas Pro supports many types of media file formats for placement, editing, and rendering to new media formats.

The following sections briefly explain the process of finding media files, previewing them, and placing them within your project.

Finding media files to use

There are two ways to find media to place in a project: using the Explorer window or the File menu and choosing Open.

The Explorer Window

The media Explorer window in Vegas Pro works similarly to the Windows 9x and NT file management Explorer included with your operating system. You can expand and collapse drives and folders in the tree view. The content of selected drives and folders appears in the list view.
Note: If you cannot see the Explorer window, it may be “under” another window. Click the Explorer tab to display the window. If you do not see the Explorer tab, choose Explorer from the View menu to display it.

Using the Vegas Pro Explorer allows you to place multiple file types into your project simultaneously. To find media using the Explorer window, do the following:

1. From the drop-down list or tree view, choose the drive or folder where the media is located.

Note: Vegas Pro is preset to display all supported file types. However, you may change the list view to display all files within a selected drive or folder.

2. From the list view, you may place the file into your project by dragging and dropping or double-clicking it.
The File>Open option

An alternative to the Explorer window, you may find media in the more traditional method using the File menu and choosing Open. With the File>Open option, you specify the media file type that you want to use in the project: *.wav, *.avi, etc.

To find media using File>Open, do the following:

1. From the File menu, choose Open. The Open dialog appears.
   Or, click the Open button on the Toolbar.

2. Select the media's location in the Open dialog by doing one of the following:
   - Specifying it from the Look in drop-down list.
   - Double-clicking drives and folders in the list view.
   - Typing the file's path in the File name field.

3. Select the media format from the Files of type drop-down list.

4. Press the Open button to automatically place the file in the project.

Previewing a media file

Once you have located media files, you may preview them before placing them in your project. The Explorer window has a mini-transport bar with Play, Stop, and Auto Preview buttons.

When you preview a file, its signal is sent to the Mixer window's preview bus. This bus displays levels, which you can adjust with its Volume fader.

To preview the audio file, do the following:

1. Select an event in the list view.

2. Press the Play button to listen to the file.

3. Press the Stop button, select a different file, or place the file in the project to stop previewing to the file.

Note: To automatically preview selections, press the Auto Preview button on the Explorer's Transport bar. To turn off Auto Preview, press the Auto Preview button again.
Placing a media file on a track

Audio media files may be placed in your project by either dragging and dropping or double-clicking them. Either method places the media file in its entirety in the Track View. After the file is placed, it becomes (and is referred to as) an event along the project's timeline.

Dragging and dropping an event

This method controls the event's occurrence on the Track View's timeline. You can create a new track by dragging an event to a blank area in the Track View and dropping it in place. Vegas Pro tracks can contain multiple events, so you can place different events next to each other on a track.

In addition, you may place multiple events at the same time and control their arrangement in the track view. Vegas Pro is preset to place the events on separate tracks.

To place multiple events, do the following:

1. Select a range of adjacent media files by holding down the Shift key and clicking files in the list view.

   Or, select files that are not adjacent by holding down the Ctrl key and clicking files.

2. Drag the files to the Track View.

3. Cycle through the placement options by right-clicking. As you click, Vegas Pro displays outlines of the selected events and the placement option. When you see the option that you want, drop the events in place. Below is a list of placement options:

   - Place events on separate tracks
   - Place events next to each other on the same track
   - Place events as takes on a track

You will see one event on the track. The other events are listed at takes "beneath" the topmost event.
Double-clicking an event
This method creates a new track and places the event at the cursor's position along the timeline. However, once the events are placed, you can move them from one track to another or change their position on the timeline.

Placing an event on the Video Ruler
A video media file may be placed in your project by either dragging and dropping or double-clicking. The video is placed on the Video Ruler, located above the audio tracks. If the video file includes audio, the audio is placed below the Video Ruler on a newly-created audio track.

Dragging/dropping or double-clicking a video event
Video event placement is the same as placing an audio event; dragging and dropping controls timeline placement and double-clicking places the event at the cursor's position.

The Video Ruler supports one video event at a time. So, whether or not an event exists on the Video Ruler only affects what happens in your project when you place a video event. The following table describes placement scenarios:

<table>
<thead>
<tr>
<th>Event to place</th>
<th>Video ruler status</th>
<th>Placement method</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video only</td>
<td>No event</td>
<td>Drag/drop or double-click</td>
<td>Video placed on ruler</td>
</tr>
<tr>
<td>Video with audio</td>
<td>No event</td>
<td>Drag/drop or double-click</td>
<td>Video placed on ruler and audio on a new track</td>
</tr>
<tr>
<td>Video with audio</td>
<td>event placed</td>
<td>Drag/drop or double-click</td>
<td>Audio on new track</td>
</tr>
<tr>
<td>Video with audio</td>
<td>event placed</td>
<td>Drag/drop to video ruler</td>
<td>Video placed on ruler and audio on a new track</td>
</tr>
<tr>
<td>Video only</td>
<td>event placed</td>
<td>Double-click</td>
<td>No affect (existing video is not replaced)</td>
</tr>
</tbody>
</table>

Audio event basics
There are a number of ways to work with events once they have been placed in your project. Whether you are working to achieve a specific project goal, or experimenting with sound and video, the events that you placed are fully editable. The following sections describe basic event editing techniques.

Moving events along the timeline
An event, by definition, is an occurrence along the project's timeline. Events, as a result, may be moved along the timeline either individually or as a group. The left edge of an event is its starting point. Therefore, where the left edge lines up on the ruler determines when the event starts.

Events may overlap each other or be placed on top of each other. You may crossfade overlapping events automatically or with envelopes.
Moving a single event
You can move an event along the timeline within a track or move it to a different track.
1. Select the event by clicking on it. The event is highlighted.
2. Click and drag the event along the timeline.
   If you move the event along the original track’s timeline, the event’s appearance (color) remains the same.

   ![Original track position](image1)

   However, you may move the event to a different track’s timeline. If you do, the event appears as a simple outline and you will see its original track and position on the timeline. Once you release the mouse, the event will assume the new timeline position and track color.

   ![New track and position](image2)

3. Release the mouse to set the event’s timeline occurrence.
4. Repeat Steps 1-3 to move more events along the timeline.

Moving multiple events
You can move multiple events along the timeline within a track or move them to a different track, similar to the previous procedure. In addition, selected events do not need to be within the same track. You may select events on different tracks and move them as a group along the timeline.

1. Use the `Ctrl` key, the `Shift` key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 49.
2. Place the mouse cursor over one of the selected events.
3. Click and drag the events along their respective timelines.
   If you move the events along their original tracks’ timeline, their appearance (color) remains the same.
You may move the events to different track timelines. In that case, the events appear as simple outlines and you will see their original tracks and positions. When you release the mouse, Vegas Pro automatically creates new tracks as needed for events.

4. Release the mouse to set the events' timeline occurrences.
5. Repeat Steps 1-4 to move more events collectively along the timeline.

**Track navigation**

Once an event is placed on a track, Vegas Pro automatically displays track controls that you can use to affect the event or events contained within the track.

**Track Number**

This area identifies the track’s order number in a multitrack project. You may rearrange the track order by dragging and dropping selected tracks “up” or “down” within the Track List.

**Track color**

Change the color by right-clicking and choosing Track Color, and then selecting the color you prefer.
View buttons

These buttons control the track’s appearance (size) in the Track View.

- **Minimized**
- **Normal**
- **Maximized**

Track FX button

This button accesses Noise Gate, equalization (EQ), and compression FX controls that can be applied to the track’s event(s). For more information, see Using Track FX on page 142.

Bus assignment

This button allows you to designate and assign a track to a specific output bus. This option is available for projects being mixed for multiple stereo busses. (A bus is where various track signals are mixed together and output.) For more information, see Assigning a track to a bus on page 138.
Arm for Record button

This button allows you to prepare a track for recording. You may record directly into tracks. A track is ready when you see the recording meter appear on it. For more information, see Setting up to record into tracks on page 141.

Mute button

This button enables you to temporarily disable playback of the track, so you can focus on another track's event(s). When a track is muted, it appears “grayed out” on the Track View. For more information, see Muting a track on page 137.

Solo button

This button, as its name implies, isolates a track's events for playback, while muting the other tracks’ events. For more information, see Soloing a track on page 137.
Scribble Strip

This area lets you label a track. Simply double-click in the strip and type the track’s name. Or, right-click anywhere in the Track List and choose Rename from the shortcut menu and then type the track’s name. If you do not see the Scribble Strip, expand the track. For more information, see Changing track height on page 135.

Volume fader

This fader controls the track’s loudness relative to the other tracks when it is played back. Vegas Pro tracks are preset at 0.0 decibel (dB). Use this fader to emphasize or de-emphasize a particular track. A track’s volume range is -inf. to 12 dB.

To move the fader, do the following:
1. Place the mouse cursor on the fader.
2. Press and hold the left mouse button.
3. Move the fader left or right and release the mouse.

Note: You may also move the fader by clicking it and using the right or left arrow keys on the keyboard.
### Multipurpose slider

If you do not see this slider, expand the track. This slider controls the track’s stereo panning and auxiliary bus volume. You may select what the slider controls by clicking its label. Each item’s slider position is independent from the others.

**Panning**

Vegas Pro tracks are preset to center the signal. Move the slider to adjust the signal’s output left or right. As you move the slider, Vegas Pro displays the signal’s percentage going to either the left or right channel. For example, moving the slider to $60\%L$ means that 60 percent of the signal is mixed to the left channel, while 40 percent is mixed to the right. For more information, see Adding a panning envelope on page 164.

**Auxiliary bus**

Vegas Pro projects that have multiple busses enable you to send track signals to primary and secondary (auxiliary) busses. The primary bus is set using the Bus button (A) on a track. For more information, see Bus assignment on page 37. The auxiliary bus sends signal to a separate bus independent of the primary bus without affecting the project’s overall playback.

When you select an auxiliary bus, you need to adjust its playback volume with the slider. A auxiliary tracks’ volume are preset to $-\infty \text{ dB (mute)}$ for playback. For more information, see Assigning a track to an auxiliary bus on page 138.

### Assignable FX send

If you add an Assignable FX control to your project, Vegas Pro adds it to the multi-purpose slider’s shortcut menu. You will be able to adjust the control’s volume using this slider.
Video event basics

Video events are placed on the Video Ruler. If the video event has audio, Vegas Pro creates an audio track and places the video's audio on the “top” track in the track list. For more information, see Placing an event on the Video Ruler on page 34.

Once the event is in place, you may move the video event along the timeline, delete its audio, and preview the event in the Video Preview window. You may also replace the video by placing a new event on the Video Ruler. For more information, see Dragging/dropping or double-clicking a video event on page 34.

Moving the video event

Moving a video event is identical to moving an audio event. However, a video event is slightly different in that it may have audio grouped with it. If a video event has audio, Vegas Pro is preset to group the video event with its audio when it is placed. As a result, the video event and its audio will always be moved together along the project’s timeline.

To move a video event, do the following:

1. Place the mouse pointer on either the video event or its audio.
2. Click and drag the events to the desired starting point on the timeline.
3. Release the mouse when the events are in the desired location.

Note: Ungroup a video and audio by right-clicking either event. From the shortcut menu, choose Group, and then Clear.
Removing the video’s audio

As mentioned earlier, video events with audio get placed together in your project. However, you may delete the original audio completely or replace it with new audio. This feature is nice for redubbing poor quality audio.

To remove the audio, do the following:

1. Right-click either the video or its audio event to display a shortcut menu.
2. From the shortcut menu, choose Group, then Clear to ungroup the video and audio. Otherwise, both events will be removed.
3. Click to select the video’s audio event.

4. Right-click to display the shortcut menu. From the shortcut menu, choose Delete.
   Or, from the Edit menu, choose Delete.

Playing back the project

Vegas Pro allows you to play back your project in two ways: directly within Vegas Pro, or by mixing the entire project to a preview file.

Play back within Vegas Pro

Vegas Pro has a Transport bar that allows you to play back your entire project or portions of your project based on a either a time selection or current cursor position. Only non-muted tracks and events are played back.
If your project includes video, make sure the Video Preview window is displayed for playback: from the View menu, choose Video Preview or press the Alt+G keys.

**Play back entire project**
1. Press the ▶ button to position the cursor at the beginning of the project.
2. Press the ▶ button to start playback.  
   Or, press the ▶ button to begin playback at the beginning of the project.
3. Press the ■ button to stop playback.

**Play back a time selection**
1. Place the mouse pointer above the ruler (on the Marker bar). The mouse arrow includes a left/right arrow (→←).
2. Click and drag to select the time region. To increase or decrease the time selection, click and drag its start and end points.
3. Press the ▶ button to begin playback. Only the non-muted tracks and events within the time selection will play back.
4. Press the ▶ button to have Vegas Pro continually play back the events within the time selection.
5. Press the ■ button to stop playback.

**Playback reference**
The following table describes all the playback buttons and keyboard equivalents. You may use these playback functions at any time while working in your project.

<table>
<thead>
<tr>
<th>Button</th>
<th>Keyboard</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin recording into record-enabled tracks</td>
<td>Ctrl+R</td>
<td></td>
</tr>
<tr>
<td>Turn on/off loop play during time selection playback</td>
<td>L</td>
<td></td>
</tr>
<tr>
<td>Begin playback from the start of the project</td>
<td>Ctrl + Shift + Space</td>
<td></td>
</tr>
<tr>
<td>Begin playback from cursor position</td>
<td>Space</td>
<td></td>
</tr>
<tr>
<td>Pause playback, cursor stops and holds at pause position</td>
<td>Enter</td>
<td></td>
</tr>
<tr>
<td>Stop playback, cursor stops and returns to prior cursor position</td>
<td>Space or Esc</td>
<td></td>
</tr>
<tr>
<td>Place cursor at the beginning of project</td>
<td>Ctrl + Home</td>
<td></td>
</tr>
<tr>
<td>Place cursor at the end of the project</td>
<td>Ctrl + End</td>
<td></td>
</tr>
<tr>
<td>Moves the cursor to the left in grid increments (if grid is displayed)</td>
<td>Page Up</td>
<td></td>
</tr>
<tr>
<td>Move the cursor to the right in grid increments</td>
<td>Page Down</td>
<td></td>
</tr>
</tbody>
</table>
Previewing to media player

A preview file is mixed according to the project’s properties that you set and is played back using the media player associated with the file type.

Mixing project for preview

This feature mixes all non-muted events to a file and automatically plays it back on the associated media player.

1. From the Tools menu, choose Mix to Preview. The Preview dialog appears.

2. Select the preview option from the drop-down list.

3. Click the OK button to begin the mixing process. A status bar appears in the lower left portion of Vegas Pro.

Note: You may cancel the Mix to Preview by clicking the_cancel_button on the status bar.

When mixing is completed, the associated media player appears and begins playback.
Using project properties

You can view and set the project’s properties by choosing Properties from the File menu. The Properties dialog appears. There are more details on properties later in this manual. For more information, see Working with project properties on page 263.

Saving the project

The first time a project is saved you will have two options. The one you select will affect the project’s file size and its portability.

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vegas Pro Project</td>
<td>*.veg</td>
<td>Saves all of the information about a single project. This file format does not contain any media. It saves the references to media files used in the project. Also saved is project information, track FX, envelopes, bus assignments, and output properties.</td>
</tr>
<tr>
<td>Vegas Pro Project with External Media</td>
<td>*.veg</td>
<td>When the Copy all media with project check box is selected, all of the media in the project will be copied into the same folder as the project file. This option makes transporting the project easy and convenient.</td>
</tr>
</tbody>
</table>

Saving your project the first time

To save the project, do the following:

1. Select one of the save methods:
   - From the File menu, choose Save.
   - Click on the button.
   - Press Ctrl+S on the keyboard.

The first time you save a project, the Save As dialog appears.
The subsequent times you save, the above dialog is bypassed, your existing file name is retained, and your project is updated to include any implemented changes.

2. Select the drive and directory where you want to store the project.

3. Type the project name in the File Name field.

4. Click the Copy all media with project check box if you want to have all the media copied into the same folder as the project.

5. Click the Save button.

Renaming or rendering a project (using Save As...)

After you have been working with your project, you may use the Save As command in the File menu to rename the project. This option also allows you to render the project to a different file format. Typically rendering to a different format means that the project is finished and ready for distribution. For more information, see Creating a copy of a project (using Save As...) on page 216.
Rendering a Vegas project

Rendering refers to the process of converting the Vegas Pro project into one file and formatting it for the desired playback method: media player, Internet streaming media, CD-ROM, etc. The project file is not affected (overwritten, deleted, or altered) during the rendering process. You may return to the original project to make edits or adjustments and render it again. The following table describes the formats available for rendering your Vegas Pro project:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>*.aif</td>
<td>The standard audio file format for audio used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG</td>
<td>*.mpg</td>
<td>Highly compressed audio format.</td>
</tr>
<tr>
<td>RealSystem G2</td>
<td>*.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Vegas Pro EDL</td>
<td>*.txt</td>
<td>This option creates a text version of event placements in the Track View. This text description can then be imported into a database or text application for modification or other purposes.</td>
</tr>
<tr>
<td>Vegas Pro project</td>
<td>*.veg</td>
<td>This option saves the references to media files used in the project. Also saved is project information, track plug-ins, envelopes, bus assignments, and output properties. The *.veg file does not combine events into a single file.</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>*.avi</td>
<td>The standard video file format used on Windows-based computers. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>*.wav</td>
<td>The standard audio file format used for audio used on Windows-based computers.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>*.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Audio Interchange File Format</td>
<td>*.aif</td>
<td>The standard audio file format for audio used on Macintosh computers.</td>
</tr>
</tbody>
</table>

There are more detailed instructions for rendering to a specific format later in this manual. For more information, see Saving and Rendering projects on page 215.
Welcome to the Vegas Pro tutorial. It is designed to familiarize you with the basic features and tools of Vegas Pro while creating a project. The following sections are primarily step oriented and less descriptive, although descriptions are given. If you would like to learn more about a particular topic in the tutorial, access the online help. For more information, see Accessing help on page 17.

This tutorial will teach you how to place media files in the project, edit them, and save them together into a video file. We provide you with the files you need to create this sample project.

We will take a video that has poor audio quality and replace its audio with a voice-over recorded in a studio. The new audio will need to be synchronized with the video. The voice-over will also require some editing and equalization. In addition, the video has theme music that we are going to replace with a new music bed.

The video length is approximately 15 seconds. As you work, you will see how easy it is to master the powerful features that Vegas Pro has to offer.

If you make a mistake during the tutorial, just undo it by pressing Ctrl+Z.

Let’s get started!

Getting the tutorial folder

First, we need to get the sample media files copied to your hard drive. The tutorial folder is located on the Vegas Pro CD-ROM.

1. Insert the CD-ROM into the disc drive.
2. Locate the Tutorial folder on the CD-ROM and copy it to your hard drive.
3. After the folder is copied, start Vegas Pro.
Using the Explorer window

The Explorer window allows you to view and access your media files without leaving the work area. This window works just like the Explorer you use with Microsoft Windows.

1. Locate the Tutorial folder on your hard drive.
2. Select the Tutorial folder so that its contents appear in the media list.

Once a media file is placed into the project, it is referred to as an event.

Placing the video

In the media list you will see several files; we are going to place the Tutorial file (.flv).

1. Press Ctrl+Home to place the cursor at the beginning of the project.
2. Select the Tutorial file in the media list.
3. Place it by double-clicking on it. This will place the video on the Video Ruler and the audio on the first track at the cursor’s position.
Displaying the Video Preview

We need to display the Video Preview window and move it to the Docking Area. This way we can watch the video as it is played back.

1. From the View menu, choose Video Preview. The Video Preview window appears.

2. Place the mouse pointer on the Video Preview’s title bar and drag it to the lower right portion of the work area (over the Mixer window).

3. When the Video Preview’s title bar disappears, release the mouse. The Video Preview window docks into position below the Track View.
Playing back the video

During playback, you will see and hear a number of elements: an opening and closing graphic with a music sound track, and background noise recorded along with our narrator.

1. Press the ▶ button on the Transport bar to start playback. Playback begins at the current cursor position. So, if playback starts in the middle of the project, press the ▶ button to start playback from the beginning.

2. Press the ■ button to stop playback.

3. Press the audio track’s ▌ button to mute the video's audio track.

We are preparing to place and work with the new voice-over. Eventually, we will delete the original audio, but for now let’s use it as a reference point.

Placing the new voice-over

The new voice-over will replace the poor quality audio that is muted on the first track.

1. In the media list, select the file titled Voiceover.

2. Drag the file so that its starting point is approximately when our narrator appears on the timeline. Drop the file, and Vegas Pro creates a new track for it.

3. Press either the ▶ or ▶ button to play the voice-over.

4. Press the ■ button to stop playback.

During playback, you will hear the narrator’s pause to review notes and cough. Below is the “anatomy” of the voice-over.

These errors (B and D) will be removed later. Also, during playback you probably saw that the new voice-over and the video are out of sync. Next, we will align the voice-over with the video.
Aligning new voice-over with video

We will now position the voice-over so that it will be synchronized with the video. We will use the poor quality audio as a reference point. Since we can see the audio waveform, synchronizing is made easier. You can also refer to the video’s frames on the ruler to see when the narrator begins to appear in the video.

To make it easier to see the audio events, we can zoom in on the project. There are several ways to manage the project’s view. For more information, see Changing track height on page 135.

1. Press \texttt{Alt} + \texttt{0} so the Track View takes focus of keyboard commands.

   Or, click in the Track View.

2. Press and hold the \texttt{Ctrl} + \texttt{Shift} keys.

3. Press either the \texttt{↑} or \texttt{↓} keys. You will toggle through different Track heights.

4. Click and drag the new voice-over’s starting point to approximately when the narrator begins to speak. The original audio waveform, although distorted, reveals the narrator’s voice.

5. On the timeline, click and drag the mouse to select a time region.
6. Press the or button to play just the time selection. Press the button, on the Transport bar, to have playback loop continuously within the selection.

7. Watch the Video Preview window to see if the new voice-over is close.

8. Press the button to stop playback.

9. Repeat steps 3-7 until you have the starting points of the voice-over and the video synchronized.

Next we will edit the “ums” from the voice-over and synchronize the remaining voice-over with the video.

Editing the voice-over

When you played back the new voice-over, you noticed the interruption errors that it contained. We will remove those errors and synchronize the remaining voice-over to the video. Vegas Pro allows you to edit both time and events. We will use both methods to edit the voice-over. In addition, we will split an event to “separate” it from the parts we want to keep.

Locking the original audio

Time selection edits affect all tracks in the project unless a specific Track is selected. Before we start editing the voice-over, we will lock the original audio, which is our reference, to prevent it from accidentally being edited too.

1. Click the video’s original audio to select it.

2. From the Edit menu, choose Switches and then Lock.
Editing a time selection

By looking at the waveform, you will see where the “um” and cough occur. You will also see where the narrator is speaking. We will delete the “um” using time selection.

1. On the timeline, click and drag to make a time selection where the “um” occurs.

2. Press the ▶ button to play back the error to ensure that your time selection does not include part of the voice-over that we need.

3. Increase or decrease the time selection by clicking and dragging an edge of the selection.

4. Once the time selection is made, choose Delete from the Edit menu, or press the Delete key to remove the “um.”

Next, we will split the event that contains the narrator’s cough and then delete the error.

Splitting an event using time selection

Splitting creates events from an existing one. We will make a time selection that contains the narrator’s cough and split it from the audio, then delete the cough.

1. On the timeline, click and drag to make a time selection where the cough occurs.

2. Press the ▶ button to play back the error to ensure that your time selection does not include part of the voice-over that we need.

3. Increase or decrease the time selection by clicking and dragging an edge of the selection.

4. Once the time selection is made, choose Split from the Edit menu, or press the S key to split the event.
Editing an event

We have the cough as a new event that can now be deleted.

1. Click the event with the cough.

2. From the Edit menu, choose Delete or press the [Delete] key to remove the cough event.

After the edits have been made, the voice-over should look something like this:

Aligning the remaining voice-over events

With the voice-over edited, we need to align the remaining audio to the video. When you move events, they snap to other event edges. You may extend or shorten an event’s length by clicking and dragging its edges, which is useful for fine-tuning the alignment. Moreover, you may turn off snapping by choosing Enable Snapping from the Options menu.

1. Select the event that begins “This tutorial will introduce you....”

2. Click and drag the event to the approximate point where our narrator is saying this. Use the original audio as a reference.

3. On the timeline, click and drag the mouse to select a time region.

4. Press the ▶ or ▶ button to play just the time selection. Press the ▶ button, on the Transport bar, to have playback loop continuously within the selection.

5. Watch the Video Preview window to see if the new voice-over is close.

6. Press the ■ button to stop playback.

7. Repeat steps 2-6 until you have the voice-over and the video synchronized.

8. Repeat the above steps for the event that begins “found in this new....”

Next, we will group the synchronized events with the video and delete the original audio from the project.
Grouping the voice-over and video

The voice-over and video are synchronized, and we want to make sure that they stay together. The Grouping feature will do that for us. However, first, we will delete the original audio.

1. Select the original audio’s track by clicking it.

2. Right-click and choose Delete from the shortcut menu. The entire track is removed from the project and the new voice-over becomes the first track.

3. Press the Ctrl key and click the video event and the three voice-over events to select them.

4. From the Edit menu, choose Group and then Create New or press the G key to group the events.

Next, we will place a new audio file to serve as a music bed for the video and add a volume envelope.
Working with the music bed

We will place an event that will play for the entire video. We will add a volume envelope to lower the volume while the narrator speaks, and then increase the volume again for the remainder of the video.

Placing the music bed

1. Press the `Ctrl+Home` key to move the cursor to the beginning of the project.
2. In the media list, double-click the Music bed file to place it at the start of the project.
3. Press the ▶ button to play the project.

Adding a volume envelope

The music bed's volume needs to be lowered as the narrator speaks. A volume envelope will automatically lower the volume, and then raise it again when the narrator finishes speaking. We will use the voice-over's starting and ending points as a reference for the envelope.

1. Select the music bed track or event.
2. From the Insert menu, choose Audio Envelopes and then choose Volume. A blue line appears across the track.

3. On the music bed, place the mouse pointer slightly ahead of the voice-over's starting point. The mouse pointer appears as a hand (👇).
4. Right-click and choose Add Point from the shortcut menu. A square point appears on the envelope line.
5. Repeat step 4 to add three more points on the line. You want a total of four points.
Setting the volume envelope

Now we will use the points on the envelope to lower and raise the volume so that the music bed does not interfere with the voice-over. When you click or hover over a point, information about it appears.

1. Click and drag the points so that they are positioned with two near the start of the voice-over, and two at the end.

2. Click and drag the two inner points so that their volume level is at approximately -7.0 dB.

3. Set the outer points so that their volume level is at 0.0 dB.

4. Press either ▶ or ▶ to play the project and check the timing of the volume envelope.

5. Adjust the outer and inner points along the timeline as needed.

Next, we will add some equalization (EQ) to the voice-over.
Adding equalization (EQ) to the voice-over

The voice-over has a strong bass quality to it. We will adjust that quality slightly with EQ on the first band.

1. Click the \texttt{\textdagger} button on the voice-over's track. The Track FX dialog appears.

You can set the EQ settings by typing in the appropriate field, dragging the slider, or clicking the arrow buttons between the slider and the setting field.

2. Set the \texttt{\textdaggerdbl} to 160 Hz.
3. Set the \texttt{\textdaggerdbl} to -inf.
4. Set the \texttt{\textdaggerdbl} to 12 (dB/oct).
5. Close the Track FX dialog by clicking anywhere outside it.
6. Press either $\text{\texttt{\textdagger}}$ or $\text{\texttt{\textdaggerdbl}}$ to play the project with the new EQ settings.

Next, we will save the project as a Vegas project file.
Saving a Vegas project (*.veg)

A Vegas project file contains all of the information about a single project. However, it does not contain any media, but maintains the references to media files used in the project.

1. Select one of the following to save the Vegas Pro project:
   - From the File menu, choose Save.
   - Click on the button.
   - Press Ctrl+S on the keyboard.
   
   The first time you save a project, the Save As dialog appears.

2. Select the drive and directory where you want to store the project.

3. Type the project name “MyTutorial” in the File Name field.

4. Click the Save button.

The subsequent times you save the project, the above Save As dialog is bypassed, your existing file name is retained, and your project is updated to include any implemented changes.
Rendering the project as an *.avi

Rendering refers to the process of converting the Vegas project into one file and formatting it for the desired playback method: media player, Internet streaming media, CD-ROM, etc. The Vegas project is not affected (overwritten, deleted, or altered) during the rendering process.

The following procedure is broken into two sections: setting the format and applying compression.

Setting the format

1. From the **File** menu, choose **Save As**. The **Save As** dialog appears.

2. Select the drive and directory where you want to save the rendered project.

3. Type a new name in the **File name** field, if necessary.

4. In the **Save as type** drop-down list, select **Video for Windows (*.avi)**.
Applying compression

To ensure that the video plays back in sync, we will set compression values.

1. On the Save As dialog, click the Custom button. The Custom Settings dialog appears.

2. Click the Video tab, then click the Compression button. The Video Compression dialog appears.

3. Set the compression to the following settings.
   - From the Compressor drop-down list, choose Cinepak Codec by Radius.
   - Set the key frame rate to 7 frames.
   - Set the data rate to 125 KB/sec.

4. Click the OK button to set the video compression.

5. Click the OK button on the Custom Settings dialog.

6. Click the Save button on the Save As dialog. A status bar appears in the lower-left portion of Vegas Pro. Upon completion of the render, your new media file is ready for distribution and playback.

   **Note:** You may cancel the rendering process by clicking the button on the status bar.

Congratulations! You have just completed your first project using Vegas Pro.
General Editing

Vegas Pro projects are multitrack compilations of events that occur over time. The events in your project are references to source media files on your hard-drive or other storage device. Vegas Pro is a non-destructive editor, so the audio events in your project will always contain their referenced information. As a result, editing events in Vegas Pro is as simple as adjusting the events' edges (in/out points), placing, and moving the events along the timeline.

The following chapter explains general editing techniques and features that apply to a project as a whole.

Using the cursor

When editing and playing back the project, the cursor identifies where you are along the project's timeline. The cursor can also be used when placing events in the project. For more information, see Placing a media file on a track on page 33.

By clicking and dragging you may select a time range in which you can perform edits, record into, and play back. For more information, see Selecting a time range on page 67.

The cursor may be controlled by the mouse or keyboard commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of selection or view (if no selection)</td>
<td>Home or W</td>
</tr>
<tr>
<td>Go to end of selection or view (if no selection)</td>
<td>End or E</td>
</tr>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
</tr>
<tr>
<td>Make time selection</td>
<td>Ctrl+G</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center in View</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Swap on selection</td>
<td>Num. pad 5</td>
</tr>
<tr>
<td>Move left to marker(s)</td>
<td>Ctrl+Left (arrow)</td>
</tr>
<tr>
<td>Move right to marker(s)</td>
<td>Ctrl+Right (arrow)</td>
</tr>
<tr>
<td>Move left to event edit points including fade edges</td>
<td>Ctrl+Alt+Left (arrow)</td>
</tr>
<tr>
<td>Move right to event edit points including fade edges</td>
<td>Ctrl+Alt+Right</td>
</tr>
<tr>
<td>Make time selection</td>
<td>Shift+Left or Right (arrow)</td>
</tr>
</tbody>
</table>
Editing event and time selections

Vegas Pro gives you the flexibility to select one or more events, a time range, or events and time range. All selection options can apply to a single track or multiple tracks.

To select an event, simply point and click on it.

Selecting multiple events

By using the Ctrl key, the Shift key, or the Selection Edit tool ( ), you may select individual or multiple events in your project. Multiple events may be selected within a track or across tracks. Once events are selected, you may apply any of the Edit menu commands or editing shortcut keys to them collectively.

Whichever method you choose, you may include or exclude events from a selection area by holding down the Ctrl key and clicking on an event.

Using the Ctrl key to select an event

The Ctrl key allows you to select events manually.

1. Hold down the Ctrl key.
2. Select the events by clicking on them. To deselect an event, simply click it again (this is called “toggling” the event selection on or off).

Using the Shift key to select events

The Shift key on your keyboard allows you to select project events sequentially.

1. Hold down the Shift key.
2. Click the first event that you want to select.
3. Click the last event that you want to select. All events between the first and last selected events are highlighted.
Using the Selection Edit tool

The Selection Edit tool ( \( \text{button} \) ) allows you to select events as a block.

1. On the Toolbar, click the \( \text{button} \).
2. Point the cursor in a corner of the area that you want to select.
3. Press and hold the left mouse button.
4. Drag the cursor to the opposite corner of the area you want to select.
5. Release the mouse button. The events are highlighted.

\[ \text{Note: While using the } \text{button, you may toggle through 3 selection modes by right-clicking.} \]

Selecting a time range

Vegas Pro has a time selection bar that is located above the ruler. This bar displays, with a shaded box, the time range that you have selected. You may use the time selection bar for playing back a smaller portion of your project or to apply cross-track edits.

Unless an event is locked, a selected time range affects all events, or portions of events, that occur within the range. If you are editing the time range, only events that occur within the time range will be affected.
To select a time range, do the following:

1. Place the mouse pointer above the ruler (on the Marker bar). The mouse pointer includes a left/right arrow ( ).

2. Click and drag to select the region. All events, or portions of events within the region are highlighted.

3. Place the mouse pointer over the time selection’s start or end point to increase or decrease your time range selection.

   **Note:** You may move the entire selection range by dragging the Time selection bar.

If you want to play back the time range, press the Play button ( ) to listen to only the events within the time range. Press the Loop button ( ) to have Vegas Pro continually play back the events within the time selection.

### Selecting events and a time range

Selecting a time range does not automatically select events. It simply selects a time frame of the project. Excluding locked events, all items within the time range will play back and be affected by Edit menu commands such as cutting, pasting, etc. However, you may select specific events to edit or play back, and then select a time range.

1. Use the `Ctrl` key, the `Shift` key, or the Selection Edit tool ( ) to select the events. For more information, see Selecting multiple events on page 66.

2. Place the mouse pointer above the ruler (on the Marker bar). The mouse pointer includes a left/right arrow ( ).

3. Click and drag to select the region. Notice that events that were not selected remain unselected (not highlighted).

4. Place the mouse pointer over the time selection’s start or end point to increase or decrease your time range selection.
Basic event editing

Vegas Pro allows you to perform simple event level editing. This editing includes common copying, pasting, and deleting procedures that you are accustomed to with other programs. However, these editing procedures and how they are implemented depend on what type of selection is made: event only, time only, or event and time selections.

Copying events

Vegas Pro allows you to copy events, or portions of events, to the clipboard and paste them into your project. You may copy a single event or multiple events. Copying preserves the original event information that is being copied.

To copy events, do the following:

1. Click on the event.
   
   To copy multiple events, use the [Ctrl] key, the [Shift] key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 66.

2. Select your time range, if applicable. Otherwise, skip to step 3.

3. Copy the event to the clipboard by doing one of the following:
   
   • Press the [Ctrl]+[C] keys.
   • Click the Copy button on the Toolbar.
   • From the Edit menu, choose Copy.

Copy time selection

Events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Event before copy" /></td>
<td><img src="image2" alt="Clipboard contents" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>
Copy time and event selection

Events and portions of events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Events Before Copy" /></td>
<td><img src="image2.png" alt="Clipboard Contents" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>

Copy event selection

Selected events are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Events Before Copy" /></td>
<td><img src="image4.png" alt="Clipboard Contents" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>

Pasting events

Once information is copied to the clipboard, you may choose a variety of ways to paste the clipboard items into tracks. The following procedures explain pasting basics. Whichever way you paste into a track, Vegas Pro always pastes at the cursor's position along the timeline.

To paste events from the clipboard, do the following:

1. Move the cursor to the desired timeline location.
2. Click either the track number or within the track where you want to paste the event.
If you are pasting multiple events from different tracks, Vegas Pro automatically creates new tracks as needed for events, or simply places events in existing tracks.

3. Paste the event into the track by doing one of the following:
   • Press the **Ctrl+V** keys.
   • Click the Paste button on the Toolbar.
   • From the **Edit** menu, choose Paste.

Clipboard events are pasted at the cursor position on the track. Existing track events are overlapped with newly-pasted information.

---

### Clipboard contents

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste</th>
<th>Events after paste</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Clipboard event" /></td>
<td><img src="image2.png" alt="Event before paste" /></td>
<td><img src="image3.png" alt="Event after paste" /></td>
</tr>
</tbody>
</table>

---

**Paste repeat (Ctrl+B)**

You specify how many times the clipboard events are pasted at the cursor position on the selected track and specify the space between each pasted event.

After you have made your selection and copied it to the clipboard, do one of the following:

• Press the **Ctrl+B** keys.
• From the **Edit** menu, choose Paste Repeat.

---

Vegas Pro displays the Paste Repeat dialog. Specify the number of times to paste the clipboard events and their space from each other.
Press the **OK** button to paste the clipboard events the number of times you specified. Vegas Pro begins pasting from the cursor's position along the timeline. The clipboard contents are pasted one after another unless you have specified a paste spacing. In that case, a space will appear between each pasted event.

**Paste insert (Ctrl+Shift+V)**

Clipboard events are placed at the cursor position on the selected track. Existing events on a track are moved later in the timeline by the total length of pasted information.

After you have made your selection and copied it to the clipboard, do one of the following:

- Press the **Ctrl+Shift+V** keys.
- From the **Edit menu**, choose Paste Insert.
Cutting events

Vegas Pro allows you to cut single events, multiple events, and events with a time selection from your project. Cutting events removes them from their respective tracks, but places the cut information (events and time) on the clipboard. Once on the clipboard, you may paste the information into your project.

To cut events, do the following:

1. Click on the event to be cut.

To cut multiple events, use the Ctrl key, the Shift key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 66.

2. Select your time range, if applicable. Otherwise, skip to step 3.

3. Cut the event to the clipboard by doing one of the following:
   - Press the Ctrl + X keys.
   - Click the Cut button on the Toolbar.
   - From the Edit menu, choose Cut.

Cut time selection

Events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard.

Cut time and event selection

Events and portions of events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard.
Cut event selection

Selected events are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Waveform before cut" /></td>
<td><img src="image2.png" alt="Waveform clipboard" /></td>
<td><img src="image3.png" alt="Waveform after cut" /></td>
</tr>
</tbody>
</table>

Trimming/Cropping events

Vegas Pro allows you to trim/crop events, or portions of events, from your project. Trimming events removes all events outside the time selection from their respective tracks. However, the removed information is not placed on the clipboard. Trimming is different from cutting in that the events within the time selection are preserved.

To crop events, do the following:

1. Click on the event to be trimmed, if applicable. Otherwise, skip to Step 2.
   
   To trim multiple events, use the **Ctrl** key, the **Shift** key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 66.

2. Select your time range.

3. Trim the event(s) by doing one of the following:
   - Press the **Ctrl+T** keys.
   - From the **Edit** menu, choose Trim/Crop.
Trim/Crop time selection
Events *outside* the time selection are removed from the project. However, the time information is not removed.

<table>
<thead>
<tr>
<th>Events before trim</th>
<th>Clipboard contents</th>
<th>Events after trim</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="events_before_trim.png" alt="Image" /></td>
<td>Trimmed information is not placed on the clipboard.</td>
<td><img src="events_after_trim.png" alt="Image" /></td>
</tr>
</tbody>
</table>

Trim/Crop time and event selection
Only selected events *outside* the time selection are removed from the project. Non-selected events remain. The time information is not removed.

<table>
<thead>
<tr>
<th>Events before trim</th>
<th>Clipboard contents</th>
<th>Events after trim</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="events_before_trim.png" alt="Image" /></td>
<td>Trimmed information is not placed on the clipboard.</td>
<td><img src="events_after_trim.png" alt="Image" /></td>
</tr>
</tbody>
</table>

Deleting events
Vegas Pro allows you to delete events, or portions of events, from your project. Deleting events removes all events within the time selection from their respective tracks. However, the removed information is not placed on the clipboard.

To delete events, do the following:
1. Click on the event to be deleted.

To delete multiple events, use the `Ctrl` key, the `Shift` key, or the Selection Edit tool `ESC` to select the events. For more information, see *Selecting multiple events* on page 66.

2. Select your time range, if applicable. Otherwise, skip to step 3.

3. Delete the event(s) by doing one of the following:
   - Press the `Delete` key.
   - From the *Edit* menu, choose Delete.
**Delete time selection**

Events within the time selection are removed from the project. However, the time information within the selection is not removed.

<table>
<thead>
<tr>
<th>Events before delete</th>
<th>Clipboard contents</th>
<th>Events after delete</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Event before delete" /></td>
<td>Deleted information is not placed on the clipboard.</td>
<td><img src="image2" alt="Event after delete" /></td>
</tr>
</tbody>
</table>

**Delete time and event selection**

Only selected events within the time selection are removed from the project. Non-selected events remain. The time information within the selection is not removed.

<table>
<thead>
<tr>
<th>Events before delete</th>
<th>Clipboard contents</th>
<th>Events after delete</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Event before delete" /></td>
<td>Deleted information is not placed on the clipboard.</td>
<td><img src="image4" alt="Event after delete" /></td>
</tr>
</tbody>
</table>

**Delete event selection**

Selected events are removed from the project. The time information between events is not removed.

<table>
<thead>
<tr>
<th>Events before delete</th>
<th>Clipboard contents</th>
<th>Events after delete</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Event before delete" /></td>
<td>Deleted information is not placed on the clipboard.</td>
<td><img src="image6" alt="Event after delete" /></td>
</tr>
</tbody>
</table>
Using the Undo and Redo commands

Vegas Pro gives you unlimited undo and redo functionality while working on your project. While you are working with a project, Vegas Pro creates an undo history of the edits that you performed. Each time you undo something, that edit is placed in the redo history. However, if a redo history exists and you perform another edit, the redo history is cleared.

When you close the project or exit Vegas Pro, both the undo and redo histories are cleared.

Undo command

Pressing the Ctrl+Z keys or Undo ( ) button on the Toolbar will undo the last edit performed. Repeatedly using the keyboard command or Toolbar button will continue undoing edits in reverse order. Moreover, you may undo the last edit by choosing it from the Edit menu (it will be the first item on the menu).

Undoing a series of edits

The undo history may be viewed by clicking the down arrow to the right of the button on the Toolbar. A drop-down list will appear (a scroll bar also appears if numerous undos are listed). The top listed item is the most recent edit. If you want to undo a specific edit that appears farther down the list, all edits “above” it must be undone as well.

To undo a series of edits, do the following:

1. Click on the arrow to the right of the button.

2. From the drop-down list, use the scroll bar to locate the last series item to undo.
3. Place the mouse pointer on the item that you want to undo. Items “above” it will be selected automatically. (Click outside the drop-down list to cancel undo.)

4. Click the last series item to undo it and all selected edits. Vegas Pro will restore your project to the state prior to those edits.

When you undo an edit or a series of edits, they are added to the redo history. This feature allows you to restore your project to a specific state.

**Note:** You may also undo all edits by choosing Undo All from the Edit menu. All edits will be undone and added to the redo history.

---

**Redo command**

Pressing the **Ctrl+Z** keys or the Redo ( Rifle ) button on the Toolbar will redo the last undo performed. Repeatedly using the keyboard command or Toolbar button will continue redoing undos in reverse order. In addition, you may redo the last edit by choosing it from the Edit menu (it will be the second item on the menu).

---

**Redoing a series of edits**

The redo history may be viewed by clicking the down arrow to the right of the **Rifle** button on the Toolbar. A drop-down list will appear (a scroll bar also appears if numerous redos are listed). The top listed item is the most recent undo edit. If you want to redo a specific edit that appears farther down the list, all edits “above” it must be redone as well.

To redo a series of edits, do the following:

1. Click on the arrow to the right of the **Rifle** button.
2. From the drop-down list, use the scroll bar to locate the last series item to redo.

3. Place the mouse pointer on the item that you want to redo. Items “above” it will be selected automatically. (Click outside the drop-down list to cancel redo.)

4. Click the last series item to redo it and all selected edits. Vegas Pro will restore your project to the state to include those edits.

When you redo an edit or a series of edits, they are added to the undo history again. At this point, the redo history is cleared when a new edit is performed.

Clearing the edit history

You may clear both undo and redo histories without closing your project or exiting Vegas Pro. Once the histories have been cleared, Vegas Pro will begin creating new ones as you continue working on the project.

To clear the edit histories, do the following:

1. From the Edit menu, choose Clear Edit History. A confirmation dialog will appear.

2. Click the Yes button to clear the edit histories. Or, click the No button to cancel and keep the edit histories.
Using project markers and regions

Vegas Pro allows you to use three types of project markers that identify parts of your project and provide functionality for rendered projects. The three types of markers are:

• **Markers**—points that you place along the project's timeline. They are typically used to mark interesting parts in the project for later reference.
• **Regions**—sets that subdivide your project. Typically, regions identify ranges of time that you need to get back to later. Regions can function as “permanent” time selections.
• **Command markers**—indicate when an instruction (function) will occur in a streaming media files. These markers can be used to display headlines, captions, link to web sites, or any other function you define. In addition, these markers can be used to embed Scott Studios data information, which is used extensively in broadcasting.

Working with markers

Markers are useful for identifying and navigating to specific points in longer projects. As you place markers in your project, Vegas Pro automatically numbers them in the order that they were placed. You may name them and move them along the project’s timeline.

Placing and moving a marker

Markers are placed at the cursor’s position via the Insert menu, right-clicking on the Marker bar, or pressing the M key. You may place a marker by positioning the cursor or on-the-fly while your project is playing back. Markers appear as red tags above the ruler.

To move a marker, do the following:

1. Place the mouse pointer on the marker you want to move. The pointer will appear as a hand ( mano de sujeción).
2. Click and drag the marker to the new position along the timeline.
3. Release the mouse to set the marker.
4. Repeat steps 1-3 to move the marker again.

**Naming a marker**

You may name each marker in your project by doing the following:

1. Place the mouse pointer on the marker you want to name or rename. The pointer will appear as a hand (허).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose *Rename*. A text box will appear next to the marker.
4. Type the marker name.
5. Press the `Enter` key or click anywhere in the Track View to set the marker’s name.
Navigating to a marker
You may have scrolled to a portion of the project and do not see the cursor any more. You may click in the Track View to move and view the cursor or you may use markers to bring the cursor into view.

To navigate using markers, do the following:
1. Place the mouse pointer on the marker that you want to position the cursor. The pointer will appear as a hand (∇).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Go to. The cursor's yellow tags will appear below the marker tag.

Note: You may also move the cursor to each marker by pressing the Ctrl+← or → keys.

Deleting a marker
You may remove markers from your project by doing the following:
1. Place the mouse pointer on the marker that you want to delete. The pointer will appear as a hand (∇).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Delete. The marker will be removed from your project.

The marker numbers will remain the same, Vegas Pro will not renumber the tags as you remove them. For example, if you have five markers in your project and delete markers 3 and 4, the remaining markers will be listed as 1, 2 and 5. However, as you add markers again, Vegas Pro will begin numbering the missing sequence first.
Working with regions

Regions are sets that subdivide your project. Typically, regions identify ranges of time that you need to get back to later. Regions can function as “permanent” time selections.

Placing and adjusting a region

Region markers may be placed at the cursor position and at the beginning and end points of a time selection via the **Insert** menu or pressing the **R** key.

1. Place the mouse pointer on either the region’s start or end point. The pointer will appear as a hand (UIImageView).
2. Click and drag the marker to the new position along the timeline.
3. Release the mouse to set the region marker.
4. Repeat steps 1-3 to move either the region marker’s start or end point.
Naming a region marker

You may name a region marker's start or end point by doing the following:

1. Place the mouse pointer on the region marker you want to name or rename. The pointer will appear as a hand (ירז).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Rename. A text box appears next to the region marker.

4. Type the region marker's name.

5. Press the Enter key or click anywhere in the Track View to set the name.

Selecting a region

You may select the events, across all tracks, within the region for editing or playing back only the region.

To select the region, do the following:

1. Right-click on one of the region markers to display a shortcut menu.

2. From the shortcut menu, choose Select Region.

**Note:** You may also double-click between the region markers on the Marker bar to select it.
Navigating to a region
You may have scrolled to a portion of the project and do not see the cursor any more. You may click in the Track View to move and view the cursor, press the [ctrl]+[←] or [→] shortcut keys to move the cursor, or use region to bring the cursor into view.

To navigate using region markers, do the following:
1. Place the mouse pointer on any region marker that you want to position the cursor. The pointer will appear as a hand ( ).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Go to or Go to End.

The difference is that Go to places the cursor at the region's starting point and Go to End places it at the region's ending point. The cursor's yellow tags will appear below either the region's starting or ending tag.

Deleting a region
You may remove a region from your project by doing the following:
1. Place the mouse pointer on either the region marker's starting or ending point. The pointer will appear as a hand ( ).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Delete. The marker will be removed from your project.

The region marker numbers will remain the same, Vegas Pro will not renumber the tags as you remove them. For example, if you have five regions in your project and delete region 3 and 4, the remaining regions will be listed at 1, 2 and 5. However, as you add regions again, Vegas Pro will begin numbering the missing sequence first.
Working with command markers

Command markers indicate when an instruction (function) will occur in a streaming media file or *.wav file being used in a radio broadcast environment (Scott Studios data). The following two sections define the markers for both streaming media and Scott Studios files.

Defining streaming media commands

In a streaming media file, command markers can be used to display headlines, captions, link to web sites, or any other function you define. Vegas Pro includes several command types that you may add to a streaming media file. Some command types are exclusive to either the Windows Media or the RealMedia player.

<table>
<thead>
<tr>
<th>Command</th>
<th>Player type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Windows Media</td>
<td>Indicates when an instruction is sent to the user’s internet browser to change the content being displayed. With this command, you enter the URL that will display at a specific time during the rendered project’s playback.</td>
</tr>
<tr>
<td>Text</td>
<td>Windows Media</td>
<td>Displays text in the captioning area of the Windows Media Player located below the video display area. You enter the text that will display during playback.</td>
</tr>
<tr>
<td>WMClosedCaption</td>
<td>Windows Media</td>
<td>Displays the entered text in the captioning window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>WMTextBodyText</td>
<td>Windows Media</td>
<td>Displays the entered text in the text window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>WMTextHeadline</td>
<td>Windows Media</td>
<td>Displays the entered text in the headline window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>Title</td>
<td>RealMedia</td>
<td>Displays the entered text (Author’s name) when a user selects About This Presentation from the RealPlayer’s shortcut menu.</td>
</tr>
<tr>
<td>Author</td>
<td>RealMedia</td>
<td>Displays the entered copyright information when a user selects About This Presentation from the RealPlayer’s shortcut menu.</td>
</tr>
<tr>
<td>Copyright</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to another RealMedia file.</td>
</tr>
<tr>
<td>HotSpotPlay</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to a Web page that you specify.</td>
</tr>
<tr>
<td>HotSpotSeek</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to a point in the current RealMedia file.</td>
</tr>
</tbody>
</table>

Defining Scott Studios data commands

For *.wav files using Scott Studios data, command markers can be used to define information about the *.wav file.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCOTT EOM</td>
<td>Calculates when the next queued clip will start playing in a Scott Studios system. For more information, please refer to your Scott Studios documentation.</td>
</tr>
<tr>
<td>SCOTT Cue In</td>
<td>Set the beginning of a file in a Scott Studios System without performing destructive editing. For more information, please refer to your Scott Studios documentation.</td>
</tr>
</tbody>
</table>
Placing a command marker

Command markers are placed at the cursor's position via the `Insert` menu, right-clicking on the Command Ruler, or pressing the `C` key. You may place a command marker by positioning the cursor or on-the-fly while your project is playing back. Command markers appear as blue tags on the Command Ruler, which is above the Marker bar.

If you do not see the Command Ruler, choose `Command Ruler` from the `View` menu.

When you place command markers, the Command Properties dialog will appear (if the Command Ruler is not displayed, Vegas Pro will automatically make it visible).

Use this dialog to define your own command or select a command from the drop-down list. This dialog is also where you edit the behavior of the selected command markers.

- The `Command` drop-down list allows you to select the type of command to place.
- The `Parameter` field defines the behavior of the command.
- The `Comments` field is generally used to remind you of what the command is while you work on the project. (Its function is similar to naming markers and regions.)
- The `Position` field allows you to specify when in the rendered file the command will occur. Otherwise, command markers are automatically set to the current cursor position.

Once the command properties are set, click the `OK` button to place the command marker on the Command Ruler.
Moving a command marker
To move a command marker, do the following:
1. Place the mouse pointer on the command marker you want to move. The pointer will appear as a hand (hand). 
2. Click and drag the command marker to the new position along the timeline.
3. Release the mouse to set the command marker.
4. Repeat steps 1-3 to move the command marker again.

Editing a command marker
You may change the command markers properties at any time by doing the following:
1. Place the mouse pointer on the command marker you want to edit. The pointer will appear as a hand (hand).
2. Right-click the marker to display a shortcut menu.
3. From the shortcut menu, choose Edit. The Command Properties dialog will appear.
4. Change the command type, retype parameters or comments, or enter a new position along the timeline.
5. Click the OK button to assign the new properties to the command marker.
   Or, click the Cancel button to keep the command marker's original properties.
Naming a command marker

The name you give to a command marker will appear in the Comments field on the Command Properties dialog. You may name each command marker in your project by doing the following:

1. Place the mouse pointer on the command marker you want to name or rename. The pointer will appear as a hand (/select).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Rename. A text box will appear next to the command marker.

4. Type the command marker's name.

5. Press the Enter key or click anywhere in the Track View to set the marker's name.

Navigating to a command marker

You may have scrolled to a portion of the project and do not see the cursor any more. You may click in the Track View to move and view the cursor, press the Ctrl+← or → shortcut keys to move the cursor, or use command markers to bring the cursor into view.

To navigate using command markers, do the following:

1. Place the mouse pointer on the marker that you want to position the cursor. The pointer will appear as a hand (select).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Go to. The cursor's yellow tags will appear below the marker tag.
Deleting a command marker
You may remove a command marker from your project by doing the following:

1. Place the mouse pointer on the command marker that you want to delete. The pointer will appear as a hand ( WebDriver).

2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Delete. The command marker will be removed from your project.

Using a sound editor program
Vegas Pro is a non-destructive editing environment, which means that all the events’ data in your project is maintained and available as necessary. Destructive edits may be done in a separate application such as Sonic Foundry’s Sound Forge® to modify an audio event’s referenced file. By setting up a separate sound editor, you can quickly access the program from Vegas Pro via the Tools menu or [ Ctrl ] + [ E ] shortcut keys.

Setting up the sound editor program
If you already had Sound Forge loaded on your computer when you installed Vegas Pro, the installation should have detected it and made it your sound editor program. However, if you do not have Sound Forge or want to specify a different sound editor, you may do so in the Preferences dialog.

To set up the sound editor program, do the following:

1. From the Options menu, choose Preferences. The Preferences dialog will appear.
2. On the Preferences dialog, choose the Audio tab.

![Preferences dialog with Audio tab selected]

3. Click the Browse button. The Preferred Audio Editor dialog will appear.

![Preferred Audio Editor dialog]

4. From this dialog, navigate to the application to use for editing audio events.

5. Select the application’s executable icon (*.exe) and click the dialog’s Open button to set the application as your sound editor.

   The application’s path will be displayed in the Location of preferred audio editor field.
Opening the sound editor from Vegas Pro

All events in your Vegas Pro project are actually references to media files on a storage device (hard drive). When you edit an event in a sound editor, you are editing the media file to which the event is referenced. Any changes you make and save in the sound editor, will be reflected in the Vegas Pro project event.

To edit an event in the sound editor, do the following:

1. Select the event to be edited. You need to select the entire event.

2. From the Tools menu, choose Open in Sound Editor or press the Ctrl+E shortcut keys.

Your selected sound editor application will open and the event's referenced media file will appear in the application. Make the necessary changes and save the file in the sound editor. If you keep the media file's name and location the same, its event will be updated immediately in your project. However, if you change the media file's name or location, you will need to import the edited event into Vegas Pro.
CHAPTER 5

Advanced Audio Editing

Vegas Pro provides many tools for working with the events in your project. The events may be edited and controlled to create the desired playback interaction you want. The tools described in this chapter are designed to achieve better work flow and playback effects that are intuitive and easy to use.

The following sections describe event-specific editing and techniques.

Snapping events

Vegas Pro is preset to “snap” an event’s edges to grid lines, markers, the cursor position, or time selection. As you move an event along the timeline, its edge will automatically align to designated snap points.

Using the event snap offset

Each event in your project has a snap offset flag that can be moved along the length of the event. The flag is the white triangle that is located in the lower-left corner of each event in your project. This flag allows you to designate where in the event snapping will occur.

The time display reflects time within the event not the project Ruler.
To set the snap offset, do the following:

1. Place the mouse pointer on the snap offset triangle. The pointer turns into a hand (Hand).
2. Click and drag the snap offset flag to the new position in the event. As the flag is moved, you will see a time display appear. This time display indicates where the snap offset flag occurs in time in the event.
3. Release the mouse to set the snap offset flag.

Snapping to grid lines

Vegas Pro allows you to specify what type of grid you want to use in your project. The grid lines that appear can then be used as snapping points for events and markers.

Enabling/disabling snapping to grid

You may enable and disable grid snapping by choosing Snap to grid from the Options menu or by pressing the Ctrl+F8 keys. When the grid is disabled for snapping, it will still be visible for reference. However, unlike a snap-enabled grid, it will disappear when the lines get too close together when zooming the view.

Changing the grid type

Vegas Pro includes many grid types that you may apply to your project. From the Options menu, choose Grid Spacing and then the type of grid you want from the sub-menu.

Note: In some cases, the grid lines and the Ruler will not “match.” This is because they are two independent functions.
Snapping to markers

Vegas Pro allows you to place markers in your project. For more information, see Using project markers and regions on page 80. The marker (or region) lines that appear across all tracks can be used as snapping points for events, cursor, and time selections.

Enabling/disabling snapping to markers

You may enable and disable snapping to markers by choosing Snap to Markers from the Options menu or by pressing the Shift + F8 keys. When you disable snapping to markers, the marker lines will not appear across the tracks. The events, however, will not snap to them.

Disable snapping

Vegas Pro allows you to snap events to project markers that you have placed and the grid lines that appear in the Track View. You may disable snapping to either markers, grid lines, or disable snapping altogether.

To disable/enable all snapping, you may click the Snap (SN) button on the Toolbar.

Or, you may toggle the snap commands located on the Options menu. When a command is enabled, you will see a check mark next to it. To disable a snap command, simply select its check marked command to disable it.

Note: If you disable all snapping, an event will still snap to the cursor or region in/out points.
Splitting events

Vegas Pro allows you to create multiple, independently-functioning events from a single event by splitting them. Splitting creates a new ending point for the original event and creates a starting point for the newly-created event.

Splitting an event does not delete or cut any information from the original event. The original event's information is there, but omitted for playback based on where either the event's starting or ending point occurs on the timeline.

You may split single selected events, multiple selected events, or a time range of events. To split an event, do the following.

1. Select the event to be split.
   - To split multiple events, use the `Ctrl` key, the `Shift` key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 66.

2. Place the cursor at the timeline position where the split will occur.
   - Or, select your time range, if applicable.

3. Split the event(s) by doing one of the following:
   - Press the `S` key.
   - From the **Edit** menu, choose **Split**.
Splitting without a selection
All events will be split at the cursor’s position (unless the event is locked). The split will occur across all tracks.

Splitting event selection
Only the selected events will be split at the cursor’s position.

Splitting time only selection
Unless locked, all events within the time selection will be split at the starting and ending points of the time range. The split will occur across all tracks.
Splitting a time and event selection

Only selected events within the time selection will be split at the starting and ending points of the time range.

Using the Ripple Edits

Vegas Pro includes a Ripple edit feature. This feature is a timeline based procedure that allows you to cut, delete, and paste events or portions of events within a time selection and simultaneously adjust existing events' timeline position on a selected track. The existing events' timeline position is adjusted by the total amount of the time selection that is being cut, deleted or pasted from the clipboard.

You may turn on Ripple Edit mode by clicking its Toolbar button ( ) or pressing the \texttt{Ctrl-L} shortcut keys.

Ripple edits are only available when there is a time selection present.

Cutting events in ripple mode

Cutting events or portions of events removes them and their time information from their respective tracks. This information is placed on the clipboard from which you may paste the information back into your project.

To cut events, do the following:

1. Click the Ripple Edits button ( ) on the Toolbar.
2. Click on the event to be cut, if applicable. Otherwise, skip to step 3.

To cut multiple events, use the \texttt{Ctrl} key, the \texttt{Shift} key, or the Selection Edit tool \texttt{ES} to select the events. For more information, see Selecting multiple events on page 66.
3. Select your time range.

4. Cut the event to the clipboard by doing one of the following:
   • Press the `Ctrl+X` keys.
   • Click the Cut button \( \mathfrak{X} \) on the Toolbar.
   • From the Edit menu, choose Cut.

   The cut events and their time information are removed from the selected track(s) and placed on the clipboard. Existing events in the selected track(s) are adjusted to occupy the space created by the cut.

**Cutting time selection with ripple mode**

Events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard. Existing events occurring after the time selection are moved forward in the project by the length of the time selection.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Events before cut" /></td>
<td><img src="image2.png" alt="Clipboard contents" /></td>
<td><img src="image3.png" alt="Events after cut" /></td>
</tr>
</tbody>
</table>

Existing events are adjusted to occur sooner in the project.

**Cutting time and event selection with ripple mode**

Events and portions of events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard. Existing events occurring later than the time selection are moved forward by the length of the time selection. Only tracks containing selected events are affected by the ripple edit.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4.png" alt="Events before cut" /></td>
<td><img src="image5.png" alt="Clipboard contents" /></td>
<td><img src="image6.png" alt="Events after cut" /></td>
</tr>
</tbody>
</table>

Existing events are adjusted to occur sooner in the project.

This graphic is showing crossfades.
Deleting events in ripple mode

Deleting events or portions of events removes them and their time information from their respective tracks. However, this information is not placed on the clipboard. Existing events are adjusted forward when information is deleted from a selected track.

To delete events, do the following:

1. Click the Ripple Edits button ( ) on the Toolbar.
2. Click on the event to be cut, if applicable. Otherwise, skip to step 3.

To cut multiple events, use the Ctrl key, the Shift key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 66.

3. Select your time range.

4. Delete the event(s) by doing one of the following:
   • Press the Delete key.
   • From the Edit menu, choose Delete.

Deleting time selection with ripple mode

Events within the time selection and their time information are removed from the project. Existing events occurring after the time selection are moved forward in the project by the length of the time selection. When information is deleted, it is not placed on the clipboard.

Deleting a time and event selection with ripple mode

Events within the time selection and their time information are removed from the project. Existing events occurring after the time selection are moved forward in the project by the length of the time selection. When information is deleted, it is not placed on the clipboard.
Once information is copied to the clipboard, you may choose a variety of ways to paste the clipboard items into tracks. For more information, see Pasting events on page 70. The following procedures explain pasting information when Ripple mode is enabled. Vegas Pro always pastes at the cursor's position along the timeline.

To paste events from the clipboard, do the following:

1. Click the Ripple Edits button ( ) on the Toolbar.
2. Move the cursor to the desired timeline location.
3. Click either the track number or within the track where you want to paste the event.

If you are pasting multiple events from different tracks, Vegas Pro automatically creates new tracks as needed for events, or simply places events in existing tracks.

4. Paste the event into the track by doing one of the following:
   - Press the Ctrl+V keys.
   - Click the Paste button ( ) on the Toolbar.
   - From the Edit menu, choose Paste.

Clipboard information is pasted at the cursor's position on the selected track. Existing track events or portions of events after the cursor are adjusted to occur later in the project. The amount of adjustment is based on the total length of the information being pasted.

Pasting single track information with ripple mode

The information on the clipboard determines how many tracks will be affected when you paste. If you have copied or cut information from one track, only the selected track will be affected by the pasted event and time information.
Pasting multitrack information with ripple mode

When you have copied or cut information from multiple tracks, how the information is pasted is determined by the track that you select for the paste. Vegas Pro will add tracks if necessary or simply paste the information into an existing track.

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste</th>
<th>Events after paste</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>Information requires three tracks</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Since the top track was selected and three tracks exist, no new tracks were created. Existing events on the tracks were adjusted later in the project.

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste</th>
<th>Events after paste</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
<tr>
<td>Information requires three tracks</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Since the third track was selected and the clipboard information required three tracks. Vegas Pro added two more tracks.
Accessing event properties

Vegas Pro allows you to adjust individual event properties. When you set an event’s properties different from the original referenced media, the original referenced media is not affected. The event settings are only used in Vegas Pro.

You may view an event’s properties by doing the following:

1. Right-click the event to display a shortcut menu.

2. From the shortcut menu, choose Properties. The Event Properties dialog will appear.

The event properties settings that you may change are the Active take’s name, its pitch shift value, its switch use, and its normalization.
Changing the active take’s name

Because Vegas Pro is a non-destructive audio editor, the new name that you give to an event does not affect the referenced media files name. In fact, you are simply giving the event a new take name. Typically, you would change an event’s name after recording multiple takes into a track or event. For more information, see Working with multiple recorded takes on page 208.

To change an event’s name, do the following:
1. Right-click the event to display a shortcut menu.
2. From the shortcut menu, choose Properties. The Event Properties dialog will appear.
3. Type the new name in the Active take name field. (If the name is not selected, click in the field and select the name and then retype it.)

4. Click the OK button to set the new take name.

Viewing the take name

When you change an event’s name the new name will appear in the event’s Take list that you may access by doing the following:
1. Right-click the event to display a shortcut menu.
2. From the shortcut menu choose Take. A sub-menu list of takes will appear.
Displaying take names on event

You may also see the take names right on the events in the Track View. The events in your project will display their respective active take names in the lower left portion of the waveform. Enable the Show active take names in events check box on the Preferences dialog to use this feature.

To enable this preference, do the following:

1. From the Options menu, choose Preferences. The Preferences dialog will appear.

2. Click the Show active take names in events check box to enable it.

3. Click the OK button to set the preference.

Each event in your project will display their respective take names.

Note: To disable this feature, repeat steps 1-3 and “uncheck” the Show active take names in events check box.
Using the pitch shift

Vegas Pro allows you to apply pitch shift to selected events. A pitch shift is a way to speed up or slow down the audio to modify its timbre or fit the audio into a certain length of time. Generally, when you increase an event's pitch, it "speeds up" and the event's overall length is shortened. Conversely, when you decrease an event's pitch, it "slows down" and lengthens the event.

The semitone range in Vegas Pro is -24 to 24. Twelve semitones equal one octave, so you may increase or decrease an event up to two octaves. Within a semitone is a finer pitch adjustment called cents. One hundred cents equal one semitone, so you have quite a range to finely adjust an event's pitch. Increasing or decreasing cents affect the overall length of the event, but in smaller increments.

To change an event's pitch shift, do the following:

1. Right-click the event to display a shortcut menu.

2. From the shortcut menu, choose Properties. The Event Properties dialog will appear.

3. Adjust the pitch shift in the Semitone, Cents, or both using the arrows or simply typing in the desired value.

4. Click the OK button to set the pitch shift for the event.
Setting event switches

You may apply event switches via the properties dialog. Switches allow you to edit specific track events by muting, locking, looping, or normalizing the waveform. You may apply one or all switches to an event. More information on using switches is in the next section.

To change apply a switch from the Event Properties dialog, do the following:

1. Right-click the event to display a shortcut menu.
2. From the shortcut menu, choose Properties. The Event Properties dialog will appear.
3. Click the check box(es) of the switch that you want to apply to the event.
4. Click the OK button to set the switch(es) for the event.

Using event switches

Event switches are functions that you can apply to events. You may apply switches to a single-selected event or multiple-selected events at the same time. Switches allow you to edit specific track events by muting, locking, looping, or normalizing the waveform. You may apply one or all switches to an event.

You may access switches from the Edit menu and choosing Switches to display its sub-menu. Or, you may right-click a selected event and choose Switches to display its sub-menu. In addition, you may access switches via the Events Properties dialog, which was discussed in the previous section.
Below are brief descriptions of how an event is affected when each switch is used.

- **Mute** prevents the event from playing back, but it may be moved along the timeline.
- **Lock** prevents the event from being moved along the timeline, but it will play back.
- **Loop** allows you to extend the event along the timeline (in a loop) by dragging the right edge of the event. Vegas Pro loops the *entire* event’s waveform not a displayed portion.
- **Normalize** maximizes the event’s volume without clipping it during playback.

### Muting an event

You may mute an event to prevent it from playing back. Mute may be applied to one or more selected events. When you switch an event to mute, the Switch sub-menu displays a check mark indicating that Mute is enabled. The event remains muted until you disable the switch.

To mute an event, to do the following:

1. Click on the event to be muted.

   To mute multiple events, use the `Ctrl` key, the `Shift` key, or the Selection Edit tool to select the events. *For more information, see Selecting multiple events on page 66.*

2. From the **Edit** menu, choose **Switch** and then **Mute** from the sub-menu.

   ![Selected event before mute](image1)
   ![Selected event after mute is applied](image2)

### Unmuting an event

1. Click the muted event(s).

2. From the **Edit** menu, choose **Switch** to display the sub-menu. The Mute switch will have a check mark.

3. From the sub-menu, choose **Mute** to disable it on the selected event(s).

Note: You may also access the event’s properties and deselect the Mute check box.
Locking an event

You may lock an event to prevent it from being moved or edited. Lock may be applied to one or more selected events. When you switch an event to lock, the switch sub-menu displays a check mark indicating that Lock is enabled. The event will remain locked until you disable the switch.

To lock an event, to do the following:

1. Click on the event to be locked.
   
   To lock multiple events, use the Ctrl key, the Ctrl key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 66.

2. From the Edit menu, choose Switch and then Lock from the sub-menu.

![Selected event before lock](image1)

![Selected event after lock is applied](image2)

Unlocking an event

1. Click the locked event(s).

2. From the Edit menu, choose Switch to display the sub-menu. The Lock switch will have a check mark.

3. From the sub-menu, choose Lock to disable it on the selected event(s).

Note: You may also access the event’s properties and deselect the Lock check box.
Looping an event

You may loop an event so that you can extend it along the timeline by dragging the right edge of the event. Loop may be applied to one or more selected events. When you switch an event to loop, the Switch sub-menu displays a check mark indicating that Loop is enabled. The event will remain looped until you disable the switch.

To loop an event, do the following:

1. Click on the event to be looped.

   To loop multiple events, use the [Ctrl] key, the [Shift] key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 66.

2. From the Edit menu, choose Switch and then Loop from the sub-menu.

Unlooping an event

1. Click the looped event(s).

2. From the Edit menu, choose Switch to display the sub-menu. The Loop switch will have a check mark.

3. From the sub-menu, choose Loop to disable it on the selected event(s). The original waveform is restored.

Note: You may also access the event’s properties and deselect the Loop check box.
Normalizing an event

You may normalize an event to maximize its volume, based on the waveform's highest peak, without clipping the event during playback. Normalize may be applied to one or more selected events. When you switch an event to normalize, the Switch sub-menu displays a check mark indicating that Normalize is enabled. The event will remain normalized until you disable the switch.

To normalize an event, do the following:

1. Click on the event to be normalized.
   1. To normalize multiple events, use the Ctrl key, the Shift key, or the Selection Edit tool to select the events. For more information, see Selecting multiple events on page 66.

2. From the Edit menu, choose Switch and then Normalize from the sub-menu.

Recalculating an events normalization

When you normalize an event, Vegas Pro analyzes the event and raises the volume based on the waveform’s highest peak and then adjusts the rest of the event accordingly. However, if while you are editing the event, you may have adjusted its edge to exclude the highest waveform peak. In this case, you may want to recalculate the event’s normalization.

You may have Vegas Pro recalculate the normalization by doing the following:

1. Right-click the event to display a shortcut menu.
2. From the shortcut menu, choose Properties. The Event Properties dialog will appear.
3. Click the **Re-calculate** button to normalize the event again.

4. Click the **OK** button to normalize the event.

**Note:** You may set the maximum decibel level used by Vegas Pro to calculate the event during normalization. For more information, see **Setting the Normalize peak level** on page 274.

**Disabling event normalization**

1. Click the normalized event(s).

2. From the **Edit** menu, choose **Switch** to display the sub-menu. The **Normalize** switch will have a check mark.

**Note:** You may also access the event’s properties and deselect the **Normalize** check box.
Using event envelopes (ASR)

You may apply envelopes to individual events. Envelopes, also known as ASRs (attack, sustain, and release), give you the ability to control each event's volume. The fade-in, fade-out, and over-all level of the event may be controlled. These envelopes are different than track envelopes in that they move with the event. Track envelopes affect the entire track and do not move with the events.

When you place an event into your project, Vegas Pro adds “handles” that are used to set the envelope. As you use these handles, a volume line will appear indicating how the event is being affected. Also, the waveform will graphically display the volume change.

Setting an event’s volume

When you place the mouse pointer at the top of the event the pointer changes to a hand cursor ( ), with which you may use to lower the event’s overall volume.

To set the event’s volume, do the following:
1. Place the mouse pointer at the top of the event.
2. When you see the envelope cursor ( ), click and drag the volume line to the desired level. As you drag the volume line down Vegas Pro displays the event’s decibel level.
3. Release the mouse to set the volume.

Setting an event’s fade in and out

The event handles allow you to affect an event’s fade in and out volume. Also, you can change the type of curve that the event uses to control the volume’s fade in or out.

To set the event’s fade in or out do the following:
1. Place the mouse pointer on a handle and the pointer changes to the envelope cursor ( ).
2. Click and drag the envelope cursor, the volume line appears. As you drag the cursor, Vegas Pro displays both the time, in the event, when the volume will be maximized and its decibel level.

3. Release the mouse to set the fade in or out.

Changing the event's fade curve

You can set the fade curve (fast, linear, or slow) that an event uses to raise or lower the volume over time.

There are two ways to access the fade curve types. You may right-click anywhere in the event's fade-in or -out region to display a shortcut menu. From the shortcut menu, choose Fade type to display the fade types sub-menu. Click the desired fade type to set it.

The second way is to go directly to the fade types sub-menu. When the envelope cursor ( إذ) is displayed, right-click to display the sub-menu. Click the desired fade type to set it.
Crossfading events

Vegas Pro allows you to crossfade between two events on the same track. Crossfading gives you the ability to fade out one event's volume while another event's volume is fading in on the same track. This function allows you to introduce transitions between events on a track.

When you place an event into your project, Vegas Pro adds "handles" that are used to set the crossfade. These handles allow you to adjust the crossfade, even when you are using automatic crossfades. Volume lines also appear indicating how and when the events' volume are being affected. Also, their respective waveforms will graphically display how the crossfade volume is affected.

Automatic crossfades

On the Toolbar, the Automatic Crossfade button ( ) allows you to overlap event edges and Vegas Pro will apply a crossfade for you. Simply, click the button or press the short cut key to enable or disable Automatic Crossfades.

The crossfade "x" will automatically adjust itself as you move one event over another as long as one event's edge is crossing the other event's edge. In the case where edges do not cross (one event is wholly contained in another), the shorter event will be placed "on top" of the longer event. You may still set a crossfade in this situation. For more information, see Manually setting a crossfade on page 116.

Use the event's handles to adjust the desired crossfade between the two events.
Manually setting a crossfade

If you are using automatic crossfades, Vegas Pro will not insert a crossfade if a shorter event is placed on “top” and within the same time of a longer event. In this case, during play back, the longer event will begin playing, then the shorter event will play, and then the longer event will resume playing at the timeline position.

To manually set the a crossfade between the edges of the overlapping events, do the following:

1. Place the mouse pointer on one of the shorter event’s handles. The envelope cursor will appear ( ).
2. When you see the envelope cursor appear ( ), click and drag the handle to the desired position.
3. Repeat Step 1-2 to set the second crossfade, if necessary, or to edit the crossfade.

Changing crossfade curves

You can set the crossfade curve(s) that Vegas Pro uses to fade in and out between two events. The crossfade curve determines how Vegas Pro raises and lowers the events’ volume over time.

You may change the crossfade curve by doing the following:

1. Right-click anywhere in the crossfade region to display a shortcut menu.
2. From the shortcut menu, choose Fade type to display the fade types sub-menu.
3. Click the desired fade type to set it.

Changing the crossfade volume

You may set a cross-faded event’s volume and Vegas Pro will adjust the crossfade “x” to graphically reflect the volume change. When you change the volume in the cross-faded region, the event being faded in is affected. For the event being faded out, simply adjust its volume. For more information, see Setting an event’s volume on page 113.

When you place the mouse pointer at the top of the cross-fade region, the pointer changes to a hand cursor (₉₉) with which you may use to lower the faded-in event’s overall volume.

To set the cross-fade volume, do the following:

1. Place the mouse pointer at the top of the cross-fade region.

2. When you see the envelope cursor (₉₉), click and drag the volume line to the desired level. As you drag the volume line down Vegas Pro displays the event’s decibel level.

3. Release the mouse to set the volume.
Grouping events

Vegas Pro allows you to group events together within tracks or across separate tracks. Once a group is created, all the events within it may be moved together as a unit and have event specific edits applied at the same time. Edits that may be applied are copy, paste, and delete. Or, you may apply an event switch to the entire group at once.

You may still edit properties of individual events within a group without affecting the other group events. For more information, see Accessing event properties on page 103.

Creating a new group

Grouping is useful when you want to preserve timing of events and move them together along the timeline or duplicate the group and distribute it along the timeline.

To create a new group, do the following:

1. Select the events you want to group. Use the \[Ctrl\] key, the \[Shift\] key, or the Selection Edit tool \[Esc\] to select them. For more information, see Selecting multiple events on page 66.

2. After the events are selected, you may group them in one of three ways:
   - From the Edit menu, choose Group to display a sub-menu and then choose Create New.
   - On one of the selected events, right-click to display a shortcut menu. From the shortcut menu choose Group and then Create New.
   - Press the \[Ctrl\]-\[Shift\]-\[G\] shortcut key to create the group.

If you want to add events to an existing group, simply select the events and the group and repeat the above steps.

**Note:** Events can only be in one group at a time. Adding an event to an existing group essentially deletes the old group and creates a new one to include all of the selected events.
Removing an event from a group

You may remove a single event from a group. The other grouped events will not be affected when you remove an event from the group. Also, the event you are removing from the group is not deleted from the project, but remains at its timeline position.

To remove an event from the group, do the following:

1. On the event you want to remove from the group, right-click to display a shortcut menu.
2. From the shortcut menu, choose Group and then choose Remove From on the sub-menu. The event will be removed from the group, but keep the rest of the grouped events intact.
3. Repeat Steps 1-2 to remove more events from the group.

Clearing a group

You may ungroup events by clearing the group. Clearing a group does not delete or remove events from your project. The events will remain at their timeline position.

To clear a group, do the following:

1. Select one of the grouped events. The entire group will be selected.
2. After the group is selected, you may clear it one of three ways:
   - From the Edit menu, choose Group to display a sub-menu and then choose Clear.
   - On one of the selected events, right-click to display a shortcut menu. From the shortcut menu choose Group and then Clear.
   - Press the [U] shortcut key to clear the group.
3. From the Edit menu, choose Group and then Clear from the sub-menu. The events will be released from the group and may be moved or edited independently.
Using the Trimmer window

Events may be placed in the Trimmer window directly from your project, in which case they are referred to as media files. The Trimmer allows you to work with one media file at a time. Many of the shortcut keys and right-click shortcut menus are available in the Trimmer.

You, also, may place a media file directly into the Trimmer from the Vegas Pro Explorer window.

The Trimmer window may be placed in the Docking area of Vegas Pro or “float” over the work area. For more information, see Window Docking Area on page 23.

From the View menu choose Trimmer or press the shortcut keys to display the Trimmer window, if it is not displaying already.

<table>
<thead>
<tr>
<th><strong>History drop-down</strong></th>
<th>This drop-down list displays all the events in your current project. You may open a media file in the Trimmer by selecting its filename from the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Marker bar</strong></td>
<td>This area displays the markers that you place along the media file's timeline. The marker bar is identical to the one in the Track View (pg. 80).</td>
</tr>
<tr>
<td><strong>Save button</strong></td>
<td>If you have added markers or regions to a media file in the Trimmer, you can save that data to the referenced media file for use in the sound editor or in later projects.</td>
</tr>
<tr>
<td><strong>Selection bar</strong></td>
<td>The selection bar is identical to the one found in the Track View. Use it to select portions of audio that you would like to place on a track or for setting regions (pg. 67).</td>
</tr>
<tr>
<td><strong>Selection tab</strong></td>
<td>Click this tab to bring the Trimmer to the front when it is “behind” other docked windows.</td>
</tr>
<tr>
<td><strong>Sound editor button</strong></td>
<td>This button opens the event in your sound editor application (pg. 90).</td>
</tr>
<tr>
<td><strong>Transport bar</strong></td>
<td>The Transport bar is identical to the one found in the Track View (pg. 22).</td>
</tr>
<tr>
<td><strong>Ruler</strong></td>
<td>The ruler is identical in functionality as the one in the Track View (pg. 21).</td>
</tr>
<tr>
<td><strong>Zoom buttons</strong></td>
<td>These buttons are identical to the ones in the Track View (pg. 27).</td>
</tr>
</tbody>
</table>
Showing an event in the Trimmer

Showing an event in the Trimmer is actually displaying the event's referenced media file. You may place a media file directly into the Trimmer from the Vegas Pro Explorer. The main functions of the Trimmer are to select portions of a media file to place in the project or to add regions or markers to the media file for use later in other projects or a sound editor.

Showing an event from the Track View

This procedure is typically used when you want to select a portion of the media file to place on tracks in your project or add regions or markers to the event's referenced media file.

To show an event's media file in the Trimmer, do the following:

1. Select the event.
2. Right-click to display a shortcut menu. From the shortcut menu, choose Show in Trimmer. The event's entire referenced media file will appear in the Trimmer window.

Note: If the event in your project is only using a portion of a larger media file, the Trimmer will “select” the portion being used.
Placing a media file from the Vegas Pro Explorer

This procedure is a useful way to select a portion of a long file and place it in the project. Rather than placing the entire event and cutting the unwanted portions. For example, if you had a long narration and only wanted to use the first five seconds, you could place the file into the Trimmer, select the five seconds, and drag it to the Track View.

1. In the media list, select the media file.
2. Drag and drop the file to the Trimmer window. The media file will appear the Trimmer.

Working in the Trimmer window

The Trimmer window’s main function is to allow you to work with one media file for placing portions of it on a track and adding regions and markers. The Trimmer window also allows you to play back the media file and export it to your sound editor program.

Placing smaller portions of the event on track

After you have placed a media file in the Trimmer, you may select a segment of it and place it in your project. Selecting a portion of the media file will not affect the event already on a track. Vegas Pro treats the smaller portion as a separate event even though it is from the same reference media file.

To place a smaller segment into your project, do the following:

1. Click and drag the cursor or use the Selection bar to make a time selection. The portion of the event you want to place will be “inside” the selection.
2. Place the mouse pointer in the selected region then click and drag the it onto a track.
Adding regions and markers to a media file

The Trimmer allows you to add markers and regions to a media file the same way you add them to your project. However, these markers and regions are different from project markers and regions, which was described earlier in this manual. For more information, see Using project markers and regions on page 80. The difference between the two is simply that project markers and regions affect the project, while media file markers and regions are embedded in the media file.

When you add a marker or regions to a media file, Vegas Pro does not add the markers to the project. Markers and regions that are added from within the Trimmer are only temporary. You must save them if you want to use them again after you close the project. After the markers and regions are added and saved to the media file, they will be available when you open the media file in a sound editor program or in the Vegas Pro Trimmer.

Markers are placed at the cursor's position. You may also place a marker on-the-fly while the media file is playing back. Markers appear as red tags above the ruler.

A region is placed at the cursor's position or at either end of a time selection. You may also place a region on-the-fly while the media file is playing back. A region appears as green tags above the ruler.

To add markers or regions do the following:

1. Position the cursor or make a time selection.
2. Place the marker or region in one of the following ways:
   - From the Insert menu, choose Marker or Region.
   - Right-click on the Trimmer Marker bar and choose Marker or Region from the shortcut menu.
   - Press the M (marker) or R (region) shortcut keys.
3. Click the button to save the markers and regions to the media file.

After a marker or region is placed, you may move, rename, and delete them from the media file. These procedures are identical to project markers and regions. For more information, see Using project markers and regions on page 80.
Opening the sound editor from the Trimmer

The Trimmer allows you to open your selected sound editor application to perform destructive edits to the media file. After you make the necessary changes and save the file in the sound editor, Vegas Pro will automatically update the event using that media file. However, remember to keep the media file's name and location the same. Otherwise, you will need to import the edited media file into Vegas Pro again. For more information, see Using a sound editor program on page 90.

There are different ways to open the sound editor from the Trimmer when it is active:

- Click the button.
- Right-click the media file and choose Open in Sound Editor from the shortcut menu.
- Press the \[Ctrl+E\] shortcut keys.

Using the Edit details window

The Edit Details window provides an alternate means for working with audio events, Command markers, Markers, and Regions after they are placed in your project. The following table displays what edit functions can be performed from the Edit Details window and references to more detailed instructions for each edit.

<table>
<thead>
<tr>
<th>Event editing</th>
<th>Markers</th>
<th>Regions</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moving along timeline</td>
<td>Moving along timeline</td>
<td>Moving along timeline</td>
<td></td>
</tr>
<tr>
<td>(pg. 34)</td>
<td>(pg. 80)</td>
<td>(pg. 83)</td>
<td>Moving along timeline (pg. 87)</td>
</tr>
<tr>
<td>Changing Active take</td>
<td>Adding a name</td>
<td>Adding a name</td>
<td>Selecting a command type (pg. 88)</td>
</tr>
<tr>
<td>name (pg. 104)</td>
<td>(pg. 81)</td>
<td>(pg. 84)</td>
<td>Setting the parameters (pg. 88)</td>
</tr>
<tr>
<td>Using Switches (pg. 107)</td>
<td></td>
<td></td>
<td>Adding reference comments (pg. 88)</td>
</tr>
<tr>
<td>Setting Snap offset</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(pg. 93)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In addition to editing, you may access information about the project, namely seeing media file reference paths.

The Edit Detail window may be docked in the Windows Docking Area or “float” on the work space. For more information, see Docking a window on page 244.
Viewing the Edit Details window

This window looks and acts similar to an electronic spreadsheet. You may sort, add or change information, rearrange columns, and perform edits to items in the project.

To view the Edit Details window, choose Edit Details from the View menu or press the shortcut keys. The Edit Details window will appear. Repeat the step to hide the window. The Edit Details window will remain on or off until you change it again: even after you exit Vegas Pro.

The Show drop-down list allows you to view categorized project information. Following are descriptions of each category.

Events

The Events category displays information about all the events in your project. You may sort any of the information by clicking on a column’s header. The number of columns in the Events category requires that you use the scroll bar to view them all.

You may use the right-click shortcut menu to edit an event.
The following table explains each column and describes their edit function.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Edit function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Displays the track number where the event is located.</td>
<td>Move the event to a different location by entering a different track number (pg. 35).</td>
</tr>
<tr>
<td>Start</td>
<td>Displays when on the time line the event starts playback.</td>
<td>Enter a different value to cause the event to begin playback sooner or later in the project (pg. 34).</td>
</tr>
<tr>
<td>Length</td>
<td>Displays the total length of the event.</td>
<td>Enter a different value to increase or decrease the event's playback time.</td>
</tr>
<tr>
<td>End</td>
<td>Displays when on the time line the event ends playback.</td>
<td>Enter a different value to cause the event to end playback sooner or later in the project (pg. 34).</td>
</tr>
<tr>
<td>Number of Takes</td>
<td>Displays the amount of recorded takes contained in the event.</td>
<td>This column may not be edited it is for informational purposed. However, you may work with recorded takes outside the Edit Details window (pg. 208).</td>
</tr>
<tr>
<td>Active take Name</td>
<td>Displays the event's current name.</td>
<td>Enter a different name (pg. 104).</td>
</tr>
<tr>
<td>Take Start</td>
<td>Displays the offset into the source media file when the placed event begins playback.</td>
<td>Enter a different value to cause the take to playback sooner or later from the source media file.</td>
</tr>
<tr>
<td>File Path</td>
<td>Displays the path of the event's media reference file.</td>
<td>Enter a new media file reference path for the event to use.</td>
</tr>
<tr>
<td>Select</td>
<td>Displays whether or not the event is selected in the project.</td>
<td>Toggle the event's selection by clicking the check box: a check mark in the box indicates that the event is selected (pg. 66).</td>
</tr>
<tr>
<td>Mute</td>
<td>Displays whether or not the event is muted.</td>
<td>Toggle the event's mute switch by clicking the check box: a check mark in the box indicates that the event is muted (pg. 108).</td>
</tr>
<tr>
<td>Loop</td>
<td>Displays whether or not the event is looped for playback.</td>
<td>Toggle the event's loop switch by clicking the check box: a check mark in the box indicates that the event is looped for playback (pg. 110).</td>
</tr>
<tr>
<td>Lock</td>
<td>Displays whether or not the event is locked.</td>
<td>Toggle the event's lock switch by clicking the check box: a check mark in the box indicates that the event is locked (pg. 109).</td>
</tr>
<tr>
<td>Normalize</td>
<td>Displays whether or not the event is normalized.</td>
<td>Toggle the event's normalize switch by clicking the check box: a check mark in the box indicates that the event is normalized (pg. 111).</td>
</tr>
<tr>
<td>Snap Offset</td>
<td>Displays when in the event the snap to offset is positioned.</td>
<td>Enter a different value to change the snap to offset position in the event (pg. 93).</td>
</tr>
</tbody>
</table>

**Selected Events**

The Selected Events category is visually identical to the Events category except the Edit Details window only displays information about selected events in your project. This category is useful when your project has many events and you only want to see and edit the selected event.
Markers

The Markers category displays information about markers that are already placed along the project's timeline. This category displays two columns: the markers position along the timeline and the marker's name. You may enter a different value in the Position column to move a specific marker. Also, you may enter a marker name in the Name column. For more information, see Working with markers on page 80.

You may use the right-click shortcut menu to edit an event.

Regions

The Regions category displays information about regions that are already placed along the project's timeline. This category displays four columns: each region's start, length, and end positions on the timeline. Also, the name of each region, if one was entered. You may enter a different value in the Start, Length, and End column to edit a specific region. Also, you may enter a region name in the Name column. For more information, see Working with regions on page 83.

You may use the right-click shortcut menu to edit an event.
Commands

The Commands category displays information about Commands that are placed along the project’s time line. This category displays four columns: the command’s position along the time line, the command type, its parameters, and any comments that were entered when the command marker was place in your project. For more information, see Working with command markers on page 86.

You may use the right-click shortcut menu to edit an event.

Media

The Media category displays the media file reference paths used by events in your project. This category is for reference purposes. You can not change the reference path here, but you may change it on the Events category page.
Customizing the Edit Details window

The Edit Details window allows you to arrange and delete columns from each category display and save the changes to a personal “template.” Vegas Pro has one “template” from which you may create your own display options. The All fields display is the Vegas Pro preset. Whenever you rearrange or delete a column, you will see (Untitled) appear in the “template” drop-down list. This area is where you will enter a name for your custom display.

Creating your custom display

To create your custom display, do the following:

1. From the Show drop-down list, choose the category that you want to customize.

2. Click and drag a column’s header to the new position. You will see this icon ( ) as you move the column.

   **Note:** If you want to remove the column so that it will not display, drag the icon off the Edit Details window.

3. Release the mouse to drop the column in its new position.

4. Repeat steps 2-3 to move more columns in the selected category.

5. Enter a name in the template drop-down.

6. Click the button on the Edit Details window to save the custom display.

   You may delete a custom display by selecting it from the template drop-down list and clicking the button.

   **Note:** If you want to add a column that you deleted for a custom view, you need to create a new view from the All Fields template.
CHAPTER 6

Working with Tracks

Vegas Pro is a true multitrack mixing environment. Tracks are the containers for audio events, which you place and arrange. A track can contain different events. There is not a limit to the number of tracks you use in Vegas Pro. Because tracks are containers for events, you may use track functions to affect all the events on them.

Vegas Pro provides track functions that allow you organize your project and apply track features that enable you to achieve your project’s goals. This chapter explains track editing, techniques, and features that you can apply to your project’s tracks.

Track basics

Whether you are starting your first project or opening an existing one, you will need to manage the tracks in your project. The following procedures explain basic track management. The terms used to describe the track “parts” are explained in the Quick Start chapter of the manual. For more information, see Track navigation on page 36.

Adding an empty track

Typically, when you add an event to your project by double-clicking it from the Explorer window, Vegas Pro automatically creates a new track and places the event on it.

You can add empty (eventless) tracks to a project. These tracks can be used to directly record into, or serve as placeholders for specific audio that you will add later. For example, your project may contain special audio, but it needs to be recorded and mixed or retrieved from another location.

To add an empty track, do the following:

1. Place the mouse pointer in either the Track View or the Track List.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Insert Audio Track.
Alternatively, you may add an empty track from the **Insert** menu by choosing Audio Track or pressing the **Ctrl+I** shortcut keys. Vegas Pro creates and adds an empty track at the “bottom” of the Track List.

4. Repeat steps 1-3 to add more empty tracks.

**Duplicating a track**

You may duplicate tracks in your project and all the events contained on them. When a track is duplicated, the duplicated track is placed directly below the original track. Other existing tracks are moved “down” on the Track List. You may duplicate one track or choose multiple tracks to duplicate at a time.

To duplicate a track, do the following:

1. Place the mouse pointer over the track that you want to duplicate.

   **Note:** To select multiple tracks, click them while holding down either the **Shift** key to select adjacent tracks, or the **Ctrl** key to select random tracks.

2. Right-click and choose **Duplicate Track** from the shortcut menu.
3. Repeat steps 1-2, if necessary, to duplicate more tracks.

Deleting a track

You may delete tracks from your project and all events contained on them. You may delete one track or choose multiple tracks to delete at a time.

To delete a track, do the following:

1. Place the mouse pointer over the track that you want to delete.

   **Note:** To select multiple tracks, click them while holding down either the **Shift** key to select adjacent tracks, or the **Ctrl** key to select random tracks.

2. Right-click and choose *Delete* from the shortcut menu.

   Or, from the **Edit** menu, choose *Delete*.

3. Repeat steps 1-2, if necessary, to delete more tracks.
Naming or renaming a track

Every track in your project has a Scribble Strip where you can type a name for the track. The track name may be up to 255 characters. (If you do not see the Scribble Strip, expand the track to reveal it. When a track's view is minimized, the Scribble Strip does not display.)

You may name or rename the track at any time by doing the following:

1. Double-click in the Scribble Strip and type the track name.

   Or, right-click the on the track to display a shortcut menu. Choose Rename from the shortcut menu. Any existing name is highlighted on the strip. Type the new track name.

2. Press the **Enter** key to save the track's name.

Organizing tracks

Vegas Pro is flexible when organizing your tracks. You can leave your tracks alone and work with them as they are added. However, if your project contains several tracks, organizing them can save time in editing.

Reordering tracks

When you create tracks, Vegas Pro arranges them in the order that they were added. You may reorder the tracks. Only the order changes in the Track List and Track View; project playback is unaffected. You may reorder one or more tracks at a time.

To move a track, do the following:

1. On the Track List, place the mouse pointer on the track that you want to move.
2. Drag and drop the track to the new position in the Track List.
3. Repeat step 2, if necessary, to continue moving the track up or down.

   **Note:** To select multiple tracks, click them while holding down either the **Shift** key to select adjacent tracks, or the **Ctrl** key to select random tracks.
Changing a track's color

When you add a track to Vegas Pro, a color is assigned to that track. This color may be changed. This feature is useful if you want to organize similar tracks together. For example, you may want all your background vocals to have a different color from your lead vocals.

To change a track's color, do the following:

1. In the Track List, right-click on a track to display a shortcut menu.

2. From the shortcut menu, choose Track Color to display a sub-menu.

3. From the sub-menu, select a color for the track’s number and events.

Changing track height

There are two ways to control track height in your project: toggling the tracks’ height and expanding an individual track.

Toggling the tracks

You may change an individual track's height in the Track View by clicking the view (, , ) buttons on the track. Alternatively, you may use the key or key shortcut keys to toggle through different track-height scenarios. The shortcut keys affect all tracks in your project and make them the same height.
Expanding an individual track

You may resize a track by “pulling” the lower or right portion of it. Place the mouse pointer at the bottom or right side of the track. The pointer turns into an up/down or left/right arrow.

Click and drag while moving the arrow up/down (height) or left/right (width). Release the mouse to set the desired track size.

Working with tracks

Each track in your project has its own controls, faders, and sliders. You can work with these controls to affect the event(s) that are contained on the track. Each track’s controls work independently from the other tracks in your project.

Using the track fader

This fader controls the volume of the events on the particular track. The fader’s range is -inf to 12dB. To adjust the fader, simply click and drag it to the desired volume level. As you drag the fader, you will see the volume level displayed to the left of the fader. Double-clicking the fader will reposition it to 0.0 dB.

Note: You may also move the fader by clicking it and using the right or left arrow keys on the keyboard.
Muting a track

This track button enables you to temporarily disable playback of the track, so you can focus on another track’s event(s). When a track is muted, it appears “grayed out” on the Track View. You may mute more than one track at a time.

To mute the track, simply click the mute ( ) button. Click it again to “unmute” the track.

Soloing a track

This track button isolates a track’s events for playback and mutes the other tracks’ events, so you can focus on a track. When you solo a track, the other tracks will be “grayed out” on the Track View. You may solo more than one track at a time.

To solo the track, simply click the solo ( ) button. Click it again to restore all tracks for playback.
Assigning a track to a bus

A bus is where various track signals are mixed together and output. If your project contains multiple stereo busses, you may assign a track to a specific bus output.

To assign a track to a bus, do the following:

1. Click the Bus ( ) button to display a drop-down list of available busses.
2. From the drop-down list, choose the bus to which you want to output the track.

Note: If you only have one stereo bus in your project, this button will not appear in the tracks controls. For more information, see Using the Audio properties tab on page 265.

Assigning a track to an auxiliary bus

An auxiliary bus allows you to send track signals to a secondary bus independent of the primary bus. Auxiliary busses are usually used to separate signals from the rest of the project. For example, if a musician in a studio only wants to listen to the guitar portion of the project, you can set up an auxiliary bus for that purpose. Then the musician can play his or her part while only listening to the guitar.

An auxiliary bus do not affect the project's overall playback. As shown in the previous section, the primary bus is set using the Bus ( ) button on a track's toolbar. Setting up the auxiliary bus works differently.

To set up an auxiliary bus, do the following:

1. If you do not see the multipurpose slider, expand the track to display it.
2. Click on the multipurpose label to display a drop-down list.

![Multipurpose label](image)

Make sure the auxiliary bus is different from the track bus.

3. From the drop-down list, choose the auxiliary bus output.

**Note:** If you only have one stereo bus in your project, the drop-down list will not appear. For more information, see Using the Audio properties tab on page 265.

**Adjusting the auxiliary bus volume**

When you select an auxiliary bus, you will need to adjust its playback volume with the fader. Auxiliary tracks' volume are preset to -inf. dB (mute) for playback.

![Volume sliders](image)

Double-click the slider to set its volume at 0.0 dB.
Assigning tracks to an Assignable FX

If you want to use DirectX plug-ins to process track signals, you can add an Assignable FX control to the Mixer window. Assignable FX are made up of one or more plug-ins that are used to add sound effects to the track's signal. After the signal is processed by the plug-ins, the signal is sent to the assigned bus output.

Before you can assign a track to an Assignable FX control, the control needs to be added to the Mixer window. For more information, see Adding Assignable FX controls on page 186.

To assign a track to an Assignable FX do the following:
1. If you do not see the multipurpose slider, expand the track to display it.
2. Click on the multipurpose label to display a drop-down list.
3. From the drop-down list, choose the Assignable FX control to which you want the track to use.

Adjusting the Assignable FX control's volume

When a track is assigned to an Assignable FX, you may adjust its volume with the multipurpose fader. The Assignable FX volume is preset to -inf. dB (mute) for playback.

Double-click the slider to set its volume at 0.0 dB.
Setting up to record into tracks

Vegas Pro allows you to record into single or multiple tracks. You may record into tracks that are empty or tracks that contain events.

However, before you record into a track you need to “arm” the track. Setting up a track for recording is simply done by clicking the Arm for Record ( ) button on the track(s). After you click this button, you will see a record meter appear on the track(s) to be recorded into.

More details on recording is discussed later in this manual. For more information, see Recording on page 199.

Choosing a track’s recording device

After you have armed the track for recording, you may select the device from which the track will record its signal. Also you may choose whether the track will record the signal in stereo, to the left channel, or to the right channel. For more information, see Assigning tracks to input devices on page 202.

To select an input device and recording method, do the following:

1. Click the Audio button ( ) left of the Record button ( ) to display a drop-down list.
2. From the drop-down list select the input device and recording method (Stereo, Left, or Right).
Using Track FX

Vegas Pro has a special interface that allows you to use DirectX plug-ins at the track level. Using track-level plug-ins process everything on the selected track. This interface, however, requires plug-ins with special DirectX extensions. Some DirectX plug-ins do not have this extension. Check your with your plug-in manufacturer to confirm whether it supports the Vegas Pro Track FX interface. To use standard DirectX plug-ins, use the Bus FX or Assignable FX, which you can add to the Mixer window. For more information, see Using the Mixer on page 169.

Vegas Pro includes four built-in plug-ins: Equalization (EQ), Compression, Noise Gate, and Dither that can be used at the track level in any order you specify. These plug-ins can be accessed by clicking the Track FX button.

Creating a track plug-in chain

You may create a plug-in chain and control which plug-in to include. A plug-in chain can contain one or more plug-ins. When you add multiple plug-ins, you may set their order that the track will use when playing back. Moreover, the plug-ins you place in the chain may be added to occur more than once. For example, a plug-in chain can look something like the following: EQ, Compression, EQ, and Noise Gate.

After the plug-in chain is created, the entire track will be processed by each plug-in their respective order. The plug-ins are cumulative so, in some cases, you may want to rearrange their order to achieve the desired playback sound.

There are two ways to create plug-ins chains: via the Plug-in Chooser dialog and via the Plug-in Explorer window:

Adding plug-ins via the Plug-in Chooser dialog

The Plug-in Chooser dialog is accessed from the track to which you are adding the plug-in chain.

To add a plug-in chain via the Plug-in Chooser dialog, do the following:

1. Click the Track FX button. The Track FX dialog appears. The Noise Gate plug-in is already placed in the chain. (This plug-in placement may be moved or deleted.)
2. On the Track FX dialog, click the Edit Plug-in chain button ( ). The Plug-in Chooser dialog will appear. This dialog displays the track’s number, plug-ins already in the chain, and the plug-ins that you may add to the chain.

3. Select the plug-ins that you want to add. The plug-ins that you add will appear in the chain area. There are three ways to add a plug-in to the chain:
   • Double-clicking the plug-in.
   • Dragging and dropping the plug-in to the chain area.
   • Selecting the plug-in and clicking the Add button.

4. Click the OK button to save the track’s plug-in chain and close the Plug-in Chooser dialog.
Adding plug-ins via the Plug-in Explorer window

The Plug-in Explorer is a dockable window that allows you to view and choose plug-ins that may be added to a track.

To add plug-ins to tracks via the Plug-in Explorer, do the following:

1. If the Plug-in Explorer is not displayed, press the Alt + S shortcut keys or from the View menu choose Plug-ins.

2. On the Plug-in Explorer window, navigate to the Track folder and select the FX folder.

3. Click and drag a plug-in to the track.

   **Note:** You may add multiple plug-ins at the same time when you click them while pressing the Shift or Ctrl keys and then dragging them to the desired track.

4. Confirm that the plug-ins were added by clicking the Track FX button (->) to view the Track FX dialog. You may begin setting each plug-in's controls or rearranging the plug-in order.
Arranging the plug-in’s chain order

The plug-ins are cumulative during playback. For example, when the track's signal passes through the EQ, it “carries” the EQ’s settings as it passes through the Compression plug-in then the signal “carries” both those plug-in settings to the next plug-in, etc.

Because of this cumulative effect, you may need to arrange plug-ins in a certain order so that one plug-in’s processing does not adversely affect the next plug-in on the chain. There is no right or wrong way to order plug-ins. Although, some plug-ins work better when they follow another. However, the plug-in’s order in the chain is strictly based on your preferences and desired output.

You may arrange plug-ins on either the Track FX dialog or the Plug-in Chooser dialog.

Arranging plug-ins from the Track FX dialog

To arrange the plug-ins’ order from the Track FX dialog, do the following:

1. Click on the Track FX button ( ). The Track FX dialog appears.
2. On the plug-in that you want to move, right-click to display a shortcut menu and choose Move Left or Move Right. Also, you may simply click and drag the plug-in to its new position.
3. Once the chain’s plug-ins are in the order that you want, click anywhere outside the Track FX dialog to close it and save the new chain order.
Arranging plug-ins from the Plug-in Chooser

To arrange the plug-in order from the Plug-in Chooser dialog, do the following:

1. Click on the Track FX button ( ). The Track FX dialog appears.

2. On the Track FX dialog, click the Edit Plug-in Chain button ( ). The Plug-in Chooser dialog will appear with the plug-in chain.

   There are two ways to arrange plug-ins in your chain:
   • Drag and drop the plug-in to a new location in the chain.
   • Select the plug-in and click either the left ( ) or right ( ) move button.

3. Once you arrange the plug-ins in the order that you want, click the OK button to keep your changes and close the Plug-in Chooser dialog.

Bypassing plug-ins on the chain

You may bypass plug-ins on the chain by clicking the check box on a specific plug-in or right-clicking the plug-in to display a shortcut menu and choosing Bypass. The plug-in will remain bypassed until you enable it again. Bypassing a plug-in prevents its processing on the track.

To enable the plug-in again, click its check box or choose Bypass from the shortcut menu.

You may bypass plug-ins either from the Track FX dialog or the Plug-in Chooser dialog.
Removing plug-ins from a chain

You may remove plug-ins from a chain at any time. Chain plug-ins may be removed from either the Track FX dialog or the Plug-in Chooser dialog.

Removing chain plug-ins from the Track FX dialog
To remove a plug-in from the chain in the Track FX dialog, do the following:
1. Click on the Track FX button ( ). The Track FX dialog appears.
2. On the Track FX dialog, select the plug-in that you want to remove.
3. Right-click to display the shortcut menu and choose Remove.
4. Repeat step 2-3 to remove other plug-ins from the chain.

Removing chain plug-ins from the Plug-in Chooser dialog
To remove a plug-in from the chain in the Plug-in Chooser dialog, do the following:
1. Click on the Track FX button ( ). The Track FX dialog appears.
2. On the Track FX dialog, click the Edit Plug-in Chain button ( ). The Plug-in Chooser dialog will appear with the plug-in chain.
3. Select the plug-in that you want to remove and click the Delete button to remove it from the chain.
4. Click the OK button to save the chain and close the Plug-in Chooser dialog.
Saving plug-in chains as presets

Vegas Pro allows you to save plug-in chains as presets, so that you may use them again on other tracks with other projects. If you use a combination of plug-ins often, saving them as a preset chain will save you time when editing a project. The preset chains that you save retain their order and settings that you have applied.

You may save plug-in chains as presets from existing chains on tracks or when you are creating a plug-in chain. The plug-in chains that you save as presets will appear in the Plug-in Chooser dialog in the FX Chains folder.

A preset chain may be applied to a track the same way you assign a plug-in to a track.

To save a plug-in chain as a preset, do the following:

1. Access the Plug-in Chooser dialog, if it is not already displaying.

   If you want to save a an existing chain already assigned to a track, click on the Track FX button ( ) and then on the Edit Plug-in Chain button ( ).

2. Once the Plug-in Chooser dialog is displaying, create a new plug-in chain or simply use the previously created chain that is showing in the chain area.

3. Click the Save As button. The Save plug-in chain as dialog will appear.

4. Enter a name that you want to use for the preset.

5. Click the OK button or press the Enter key to save the plug-in chain as a preset.
Vegas Pro plug-in reference

Vegas Pro includes four built-in plug-ins that you can add to your project: Equalization (EQ), Compression, Noise Gate, and Dither. Each plug-in has its own control settings that determine how a track is processed for final output. The tracks in your project that use the same plug-in may be set independently of each other. For example, if you are applying Compression to Track 1 and Track 2, each track can have different compression settings.

The following sections describe each plug-in and how they affect the track.

Using the Equalization (EQ) plug-in

This plug-in functions as a parametric equalizer (an equalizer with “parameter” controls.) This type of EQ gives you more control over the track’s frequencies range. When this plug-in is added to a track, it allows you to affect the track in a four-frequency range. Each band can be configured to control its bandwidth, rolloff, and whether it operates as a peak, or shelving filter with full gain (volume) control.

Using these controls to boost or attenuate (cut) specific frequencies allows you to adjust the track’s overall tonal characteristics. The EQ plug-in is set on the Track FX dialog, which you can access by clicking the Track FX button ( ).

You may affect one or all frequencies.

Select either the tab or corresponding number in the frequency graph to set a band’s controls.

A selected band’s number will appear red.

If you want to affect only one frequency range, set its controls and exit the Track FX dialog. The other bands will not affect the track’s events.

Following are descriptions of each item and control found on each band’s tab.
Presets

The drop-down list allows you to automatically set the EQ controls by choosing one of the included presets. You may also save your own custom presets for use with other tracks.

To save your own EQ presets, do the following:

1. Enter a preset name in the drop-down list field.
2. Set the EQ controls on each band that you want to customize.
3. Click the button to save the preset.

**Note:** You may delete any presets by selecting it from the list and clicking the button.

Enable control

Enable

Each frequency tab has this control that allows you to bypass the selected band without adversely affecting its settings.
Band mode drop-down control

This drop-down list has three options to choose from: Low shelf, Band, and High shelf.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low shelf</td>
<td>The low-shelf setting attenuates (cuts) or boosts frequencies by the amount you specify below the low-shelf cutoff frequency. This setting may also function as a high-pass filter when you increase the rolloff control.</td>
</tr>
<tr>
<td>Band</td>
<td>The band setting affects the center frequency by attenuating or boosting the frequency range around it. The frequency range that is affected is determined by the Bandwidth control's setting.</td>
</tr>
<tr>
<td>High shelf</td>
<td>The high-shelf setting attenuates or boosts frequencies by the amount you specify above the high-shelf cutoff frequency. This setting may also function as a low-pass filter when you increase the rolloff control.</td>
</tr>
</tbody>
</table>

Frequency (Hz) control

This control determines the high- or low-cutoff frequency depending on whether the band mode is set to either High or Low shelf. If the band mode is set to Band, then the Frequency control sets the center frequency level.

Gain (dB) control

This control determines the overall gain (volume) that is applied to the selected band. Increasing the Gain control causes the frequency range to play back louder. Conversely, decreasing the Gain control causes the frequency range to play back quieter.

Rolloff (dB/oct) control

This control is only available when Low shelf or High shelf band mode is selected. The Rolloff filter determines the number of decibels that are reduced per octave (the filter's steepness).

Bandwidth control

This control is only available when Band is selected as the band mode. Bandwidth determines the range of affected frequencies, around the center frequency, that are attenuated or boosted by the EQ.
Using the Compression plug-in

The Compression plug-in allows you to minimize the dynamic range and control the signal’s volume “fullness” and “punch.” Also, you can prevent volume clipping as you increase the signal’s volume. Therefore, the Compression plug-in is very useful during the mastering process because you can play back the track loudly yet listen to clear undistorted sound.

Controlling clipping

The Compression plug-in has two meters that allow you to monitor both the input and output signals. If either signal clips, these meters will display in red at the end with a clipping value. Adjust the Compression controls and click the red area with the clipping value to reset the meter.

You may also reset the clip from the shortcut menu when you right-click on a meter. In addition, you may set the meter to use a different resolution and set it to hold peaks and valleys of the incoming or outgoing signal.
Presets

The drop-down list allows you to automatically set the Compression plug-in controls by choosing one of the included presets. You may also save your own custom presets for use with other tracks.

To save your own Compression presets, do the following:
1. Enter a preset name in the drop-down list field.
2. Set the Compression controls that you want to customize.
3. Click the button to save the preset.

Note: You may delete any presets by selecting it from the list and clicking the button.

Input Gain (dB) control

This control adjusts the volume level of the incoming signal. The associated meter displays this incoming signal's level before the Compressor plug-in processes the signal.

Output Gain (dB) control

This control adjusts the volume level of the outgoing signal. The associated meter displays outgoing signal after the Compression plug-in processes the signal.
Reduction meter

This meter displays the level at which the Compression plug-in is lowering the signal's volume at any given time during playback. The Reduction meter is a good visual reference to monitor compression values.

Threshold (dB) control

The Threshold control determines the level at which the dynamics processor begins acting on the signal. When the signal's level is above the threshold level, it will be compressed. A lower threshold level means that more of the signal will be compressed. However, if the threshold is set too low, the compressed signal may be distorted.

Amount (x:1) control

This control determines the ratio at which the Compression plug-in uses when processing a signal. The ratio is determined by how many decibels the signal must rise above the threshold value to result in a 1 dB increase in output level after compression.

For example, if the Compressor plug-in is set with a 3:1 ratio and the input's signal rises 6 dB above the threshold value, the Compressor plug-in only allows the level to increase by 2 dB. Therefore, the Compressor plug-in reduced the signal by 4 dB.

Note: A signal's levels which occurs below the threshold value are not affected by the Compression plug-in.

Attack (ms) control

When the input signal rises above the threshold value, the Attack control determines, in milliseconds, how quickly the Compression plug-in reaches its maximum gain reduction value.
Release (ms) control

This control determines, in milliseconds, how quickly the Compression plug-in returns to no compression after the signal falls below the threshold. The release time always follows the attack time during compression.

Auto Gain Compensation control

This toggle control, when enabled, boosts the output's signal by a constant amount. The boost amount is based on the Threshold and Ratio setting. This control is useful for preventing an overall level loss when compressing audio. However, even when using the Auto gain compensation control, you should use the Output Gain control to fine tune the output's level.

Smooth Saturation control

This toggle control, when enabled, modifies the compression level in order to lower "pumping" or "breathing" distortion that can occur when applying a lot of signal compression.
Using Noise Gate plug-in

The Noise Gate plug-in is a good way to eliminate (mask) subtle noises like tape hiss or low-level electric hum from the signal. This plug-in has a threshold control that determines what level of signal may pass through the gate. Signals that exist below the threshold are prevented from passing through (the gate “closes”); whereas signals above the threshold are allowed to pass through (the gate “opens”).

Presets

The drop-down list allows you to automatically set the Noise Gate plug-in controls by choosing one of the included presets. You may save custom presets for use on other tracks.

To save your own Noise Gate presets, do the following:
1. Enter a preset name in the drop-down list field.
2. Set the Noise Gate controls that you want to customize.
3. Click the button to save the preset.

Note: You may delete any presets by selecting it from the list and clicking the button.
Threshold level (0dB to -inf.) control

This control allows you to set the signal's threshold level. Signals below this level will be eliminated (muted) while signals above the threshold will remain in the output sound. If the threshold level is set too high, you may eliminate material intended to be output.

Attack time control

This control determines how quickly the Noise Gate plug-in “opens” when the signal rises above the threshold level. We recommend setting the attack time to a smaller value to achieve the best results. If the attack time is too slow, the beginning of wanted signal may be cutoff because the volume is rising too slowly.

Release time control

This control determines how quickly the Noise Gate plug-in “closes” when the signal falls below the threshold level. We recommend setting the release time to a larger value. Larger values cause the signal to sound more natural while it decays (fades). If the release time is too fast, the end of wanted signals may be cutoff because the volume fades too quickly.
Using the Dither plug-in

The Dither plug-in is best used at the last stage when processing a signal from a higher bit depth to a lower one. We recommend using the Dither plug-in as a Bus FX rather than a Track FX. For more information, see Adding plug-ins chains to buses on page 181. The Dither plug-in adds a low-level, random noise to the signal. This added noise is used to mask more obtrusive noise caused by quantization. Quantization noise is the inherent distortion that is added to a signal due to digital processing.

In addition, the Dither plug-in contains three noise shaping algorithms. These algorithms further hide quantization noise by pushing it to a frequency that is less sensitive to human hearing.

Presets

The Dither plug-in contains one a preset, Default all parameters. However, you may save custom presets for use with other tracks.

To save your own Dither presets, do the following:

1. Enter a preset name in the drop-down list field.
2. Set the Dither controls that you want to customize.
3. Click the button to save the preset.

**Note:** You may delete any presets by selecting it from the list and clicking the button.
Quantization depth (8 to 32 bit) control

This control determines the audio’s final target bit-depth. For example, if the audio is to be rendered to a *.wav file and written to a CD, you would want to select 16-bit. This setting will optimize the signal’s high bit-depth that is processed by the Dither plug-in. As a result, the relatively low bit-depth that is used for signal being stored on CD will have better quality output.

Dither depth (1/2 or 1 bit) control

This control sets the different noise levels that the Dither plug-in will add to the signal based on the Quantization’s depth setting. Lower quantization bit-depths may benefit from a higher Dither depth setting. However, we encourage you to experiment with your particular audio.

Noise shape type (Off, 1, or 2) control

This control lowers the signal’s noise floor by moving noise into frequencies less sensitive to human hearing. This moving of noise is referred to as noise shaping. The frequencies to which the noise is moved are close to the Nyquist frequency (half the sample rate of the audio). Consequently, you want to avoid using the Noise shape control with signals with lower sample rates. For example, a 22 kHz signal has a Nyquist frequency of 11 kHz. If you use Noise shape on this 22 kHz signal, the noise will be moved into the sensitive area of human hearing (11 kHz). We recommend using the Noise shape control for signals that are 44.1 kHz and higher.
Using track envelopes

Track envelopes allow you to control volume and panning aspects of a particular track. Volume envelopes automate the volume used for events on a track, auxiliary bus, Assignable FX send, or all at the same time. A panning envelope automates the panning aspects used for events on a track.

Adding a volume envelope

The type of volume envelope that you add will determine what Vegas Pro component’s volume is automated. You may add volume envelopes to tracks, auxiliary busses, and Assignable FX sends. A volume envelope can be added to just one or all components at the same time. You can distinguish the volume envelopes by their color.

<table>
<thead>
<tr>
<th>Envelope type</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Blue</td>
</tr>
<tr>
<td>Auxiliary bus</td>
<td>Magenta</td>
</tr>
<tr>
<td>Assignable FX send</td>
<td>Green</td>
</tr>
</tbody>
</table>

The following procedure describes adding a track volume envelope; this procedure is identical for auxiliary busses and Assignable FX sends. The only exceptions being which component you select and the volume envelope’s color.

To add a volume envelope, do the following:

1. Select the track that you want to add the volume envelope. (You may select multiple tracks.)

2. From the Insert menu, choose Audio Envelopes and then choose Volume. Or, press the V key. A blue line appears across the track(s).
Adding envelope points

Once a volume envelope is placed, you may add points to it. These points will be used to move the envelope line so that the volume will be automated.

To add envelope points, do the following:

1. Place the mouse pointer on the volume envelope’s line. The mouse pointer appears as a hand (\(\text{hand}\)).
2. Right-click and choose Add Point from the shortcut menu. A square point appears on the envelope line.

Or, simply double-click to add an envelope point.

3. Repeat step 2 to add more points on the envelope.

**Note:** If you add too many points, you may delete a point by right-clicking it and choosing Delete from the shortcut menu. Or, you may start over adding envelope points by selecting Reset All from the shortcut menu.

Setting the volume envelope points

Once the envelope points have been added, you may raise and lower them to different decibel (dB) levels along the timeline to automate the track’s volume. You may move one point at a time, even during play back and listen to the results in real-time. Also, you may set the type of fade curve between each envelope point.

To move an envelope point, do the following:

1. Place the mouse pointer on an envelope point. The mouse pointer appears as a hand (\(\text{hand}\)).
2. Click and drag the points to the desired position. As you move an envelope point, an information box displays both the point's occurrence on the timeline and its decibel level.

3. Click either ▶ or ◷ to play back the project and check the timing of the envelope.

4. Repeat steps 2-3 until the envelope points are at the desired position.

**Note:** You may also set the volume by right-clicking an envelope point and choosing a volume setting from the shortcut menu. Or, choose Select All from the shortcut menu to raise or lower all points on the envelope.

**Changing the volume fade curves**

Between each envelope point, you may set the type of volume fade curve: fast, linear, or slow. From the selected envelope point, fade curves are applied to the volume lines that occur later on the timeline.

To set the volume fade curve, do the following:

1. Right-click on a point to display a shortcut menu.

2. From the shortcut menu, choose the curve type. Curve types are applied to volume lines.
Hiding the volume envelopes

After you have set your volume envelopes on the tracks, you may hide them from the Track View. Hiding volume envelopes will not affect playback. The points that you set will still automate the volume, you simply will not see the volume envelope's line until you display them again.

To hide a volume envelope, do the following:

1. From the View menu, choose Show Audio Envelopes. A sub-menu will appear. There will be a check mark next to Volume, indicating that those envelopes are currently displayed.
2. From the sub-menu, choose Volume. All volume envelopes in your project will no longer appear in the Track View.
3. Repeat steps 1-2 to display the volume envelopes again.

Removing track volume envelopes

You may remove a volume envelope from a track. When you remove the envelope, the events on the track will no longer have automated volume. Also, the volume envelope line will no longer be displayed.

It is important to remember that when you remove a volume envelope from a track and then add it again, you will need to reset the volume points.

To remove a volume envelope, do the following:

1. Select the track or tracks that you want to remove the volume envelope(s).
2. From the Insert menu, choose Audio Envelopes. A sub-menu will appear. There will be a check mark next to Volume, indicating that those envelopes are currently being used.
3. From the sub-menu, choose Volume. All volume envelopes on the selected tracks will be removed.
Adding a panning envelope

A panning envelope allows you to control how a track's events are mixed to either the right or left speaker. You may add panning envelopes to tracks, which can be assigned to an auxiliary bus and Assignable FX send. A panning envelope can be added to one or multiple tracks at the same time. A panning envelope line appears in red.

To add a panning envelope, do the following:

1. Select the track(s) that you want to add the panning envelope.

2. From the Insert menu, choose Audio Envelopes and then choose Pan. Or, press the P key. A red line appears across the track(s).

Adding pan envelope points

Once a pan envelope is placed, you may add points to it. These points will be used to move the envelope line so that the panning effect will be automated.

To add envelope points, do the following:

1. Place the mouse pointer on the envelope line. The mouse pointer appears as a hand ( ).

2. Right-click and choose Add Point from the shortcut menu. A square point appears on the envelope line. Or, simply double-click to add an envelope point.

3. Repeat step 2 as to add more points on the envelope.

Note: If you add too many points, you may delete a point by right-clicking it and choosing Delete from the shortcut menu. Or, you may start over adding envelope points by selecting Reset All from the shortcut menu.
Setting the panning envelope points
Once the envelope points have been added, you may move them to different panning values along the timeline to automate the track's panning effect. You may move one point at a time, even during play back and listen to the results in real-time. Also, you may set the type of fade curve between each envelope point.

To move an envelope point, do the following:
1. Place the mouse pointer on an envelope point. The mouse pointer appears as a hand ( ).
2. Click and drag the points to the desired position. As you move a pan point, an information box displays both the point's occurrence on the timeline and its decibel level.
3. Click either ♫ or ♪ to play the project and check the timing of the panning envelope.
4. Repeat step 2-3 until the envelope points are at the desired position.

Note: You may also set the pan by right-clicking an envelope point and choosing a pan setting from the shortcut menu. Or, choose Select All from the shortcut menu to raise or lower all points on the envelope.

Changing the pan fade curves
Between each envelope point, you may set the type of pan fade curve: fast, linear, and slow. From the selected envelope point, fade curves are applied to the pan lines that occur later on the timeline.

To set the pan fade curve, do the following:
1. Right-click on a point to display a shortcut menu.
2. From the shortcut menu, choose the curve type to be applied to the pan line.
Hiding the panning envelopes

After you have set your panning envelopes on the tracks, you may hide them from the Track View. Hiding panning envelopes will not affect playback. The points that you set will still automate the panning, you simply will not see the panning envelope's line until you display them again.

To hide a panning envelope, do the following:

1. From the View menu, choose Show Audio Envelopes. A sub-menu will appear. There will be a check mark next to Pan, indicating that those envelopes are currently displayed.

2. From the sub-menu, choose Pan. All panning envelopes in your project will no longer appear in the Track View.

3. Repeat steps 1-2 to display the panning envelopes again.

Removing track panning envelopes

You may remove a panning envelope from a track. When you remove the envelope, the events on the track will no longer have automated panning. Also, the panning envelope line will no longer be displayed.

It is important to remember that when you remove a panning envelope from a track and then add it again, you will need to reset the pan points.

To remove a panning envelope, do the following:

1. Select the track or tracks that you want to remove the panning envelope(s).

2. From the Insert menu, choose Audio Envelopes. A sub-menu will appear. There will be a check mark next to Pan, indicating that those envelopes are currently being used.

3. From the sub-menu, choose Pan. All panning envelopes on the selected tracks will be removed.
Mixing multiple tracks to a single track

Vegas Pro allows you to mix down a time selection or an entire project to a single-track stereo event. However, if your project includes any muted tracks, Vegas Pro will not mix those events into the new mixed down track. The original tracks and their events are unaffected when you mix to a single track.

Typically, you would use this feature when you are finished refining a few tracks and want to combine them. Also, when you mix multiple tracks to a single-stereo track, any envelope or track effects that you applied will be rendered into the newly mixed down track.

This option allows you to “destructively” process any plug-ins that you want to commit.

To mix multiple tracks to a single-stereo track, do the following:

1. To mix specific events, make a time selection. Otherwise, skip to step 2.

2. From the Tools menu, choose Mix to New Track or press the Ctrl + M shortcut keys. The Mix to New Track dialog will appear.

The Mix to New Track dialog has settings that you can apply to the newly mixed track.

- From the Save in drop-down list, select the drive or folder to save the new media file.
- Type a new media file in the File name field.
- From the Save as type drop-down list, choose the file format (*.wav is the preset).
- From the Template drop-down list, choose an audio format from the template list.

- Click the Render entire project check box if you did not remove the time selection but want to include all the events in your project in the new mixed down track, except muted tracks.
3. Click the Save button to mix down the time selection or project to a new track.

As the tracks are being mixed down, you will see a status bar appear in the lower left portion of Vegas Pro.

**Note:** You may cancel the rendering process by clicking the button on the status bar.

After Vegas Pro mixes down the new track, it will appear at the bottom of the Track View. If you mixed down the entire project, you may delete the other tracks from the project, since they are all contained on the new track.

Creating a mix to new template

You may create your own templates for mixing down tracks or projects. When you create a template you may choose its name from the Template drop-down list in the Mix to New Track dialog.

To create a custom template, do the following:

1. From the Tools menu, choose Mix to New Track or press the \( \text{Ctrl} + \text{M} \) shortcut keys. The Mix to New Track dialog will appear.

2. Click the Custom button to display the Custom setting dialog.

   The settings that you may change are as follows:

<table>
<thead>
<tr>
<th>Template</th>
<th>Enter the name of your template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter the template's parameters</td>
</tr>
<tr>
<td>Format</td>
<td>Choose an audio format from the drop-down list</td>
</tr>
<tr>
<td>Sample rate</td>
<td>Choose a rate from the drop-down list</td>
</tr>
<tr>
<td>Bit-depth</td>
<td>Choose a bit-depth from the drop-down list</td>
</tr>
<tr>
<td>Channels</td>
<td>Choose a channel option from the drop-down list</td>
</tr>
</tbody>
</table>

3. Click the \( \square \) button to save the template.

   Or, click the \( \times \) button to delete a selected template.
Using the Mixer

The Vegas Pro Mixer window is where you control the project's mix. This window is where all the Bus and Assignable FX controls appear when you add them to your project. From this window, you may adjust the outgoing signal's volume using the Bus faders. More details on the Bus and Assignable FX controls are discussed later in this chapter.

Using the Mixer window

The Mixer is a dockable window that can be used to access different functions within your project. In addition, this window is where you can adjust the outgoing signal's volume setting and routing.

Viewing the Mixer window

The Mixer window is preset to appear in the Windows Docking Area when you first start Vegas. However, you may move the Mixer within the workspace at any time. For more information, see Docking a window on page 244.

To hide/view the Mixer window, choose Mixer from the View menu. Or, use the Mixer window's shortcut keys (Alt + 3) to hide or view the window.
### Using the Mixer tool bar

The Mixer's toolbar allows you to access project properties, switch your project between mono to stereo output, and add Assignable FX controls to the Mixer.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>The properties button accesses the project properties dialog (pg. 263).</td>
</tr>
<tr>
<td>Stereo/Mono</td>
<td>This toggle button allows you to switch your project's output to a stereo or mono signal.</td>
</tr>
<tr>
<td>Assignable FX</td>
<td>The Assignable FX button allows you to quickly access the FX Plug-in Chooser dialog. This dialog allows you to add Assignable FX controls to which project tracks may be routed (pg. 186).</td>
</tr>
</tbody>
</table>

When you change a project from stereo to mono or vice versa, the Bus faders and meters that appear in the Mixer window will reflect the change.

### Using the Mixer Preview fader

The Preview fader allows you to adjust the volume and monitor output levels of media reference files when you preview them from the Explorer window or play them back from the Trimmer window. The Preview fader can save time while you decide which media files will be placed as events on the project's tracks. For more information, see Using the Explorer window Transport bar on page 250.
Adjusting the volume fader

You may adjust the Preview fader while you are previewing a media file from the Explorer window. Simply click on the fader and drag it up or down.

Changing meter resolution

You may select a preferred meter resolution at which the Preview fader will display the media file's volume level. When you change the meter resolution on Preview fader, the other meters (busses and Assignable FX) automatically match the selected setting.

To change the Preview fader's meter resolution, do the following:

1. Right-click on the meter to display a shortcut menu.

2. From the shortcut menu, choose the meter resolution you prefer.

3. Repeat steps 1-2 to change the resolution again.
Adjusting for clipping

When you preview a media file from the Explorer, its volume level may cause clipping. The clip is displayed on the Preview fader’s meter. If signal clips, the meter will display in red at the top with a clipping value. Adjust the fader control and click the red area with the clipping value to reset the meter. Continue to adjust the fader and reset the meter until clipping is eliminated.

You may also reset the clip from the shortcut menu when you right-click on the Preview fader’s meter. Moreover, you may set the meter to hold the peaks and valleys in the media file’s signal.

Hiding/Viewing the Preview fader

You may choose to hide the Preview fader to make more room for other busses and Assignable FX. To hide or view the Preview fader, simply right-click anywhere within the Mixer and choose Show Preview Fader from the shortcut menu. The Preview fader will remain hidden or displayed until you change the setting again.
Using busses

Vegas Pro contains busses that appear in the Mixer window. A bus is a master control for a track’s audio-signal mix. You may assign the track to play back on a specific bus. For more information, see Assigning a track to a bus on page 138. However, to assign a track to a bus, you must have more than one bus in your project. You may add up to 26 busses to the Mixer window, which provides power and flexibility on complex projects. A bus is the last stage in the signal’s flow through Vegas Pro. For more information, see Signal Flow on page 28.

With Vegas Pro busses, you control the audio’s volume level on two discrete stereo channels, unless the project is set to mono. Each bus in your project may be muted, soloed, and assigned to use DirectX plug-ins. In addition, you may configure each bus to use a specific hardware output. For more information, see Using the Routing preferences tab on page 270.

<table>
<thead>
<tr>
<th>Mute</th>
<th>Prevents playback of the bus (pg. 179).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solo</td>
<td>Plays only the output of that bus (pg. 180).</td>
</tr>
<tr>
<td>Stereo Fader</td>
<td>Adjusts the bus’s volume on two stereo channels (pg. 178).</td>
</tr>
<tr>
<td>Playback device</td>
<td>Allows you to select the device that the bus will use for playback.</td>
</tr>
<tr>
<td>Edit FX</td>
<td>Displays the Bus FX dialog and allows you to adjust the DirectX plug-in attributes (pg. 181).</td>
</tr>
<tr>
<td>Meter</td>
<td>Displays the playback level of the bus (pg. 178).</td>
</tr>
<tr>
<td>Scribble Strip</td>
<td>Allows you to name the bus. Double-click on the Scribble Strip to enter a name (pg. 180).</td>
</tr>
</tbody>
</table>

Adding busses to the project

You may add busses to your project at anytime during the development of your project. A bus is most commonly used as a master control for one or more tracks and to route those tracks to a specific hardware output.

However, you may already know how you want to handle a certain project and set up the busses prior to recording or placing media files. The number of busses that you specify are determined by several factors that are based on your preferences. For example, you may want to have a bus for each hardware output that you intend to use or a bus for handling DirectX plug-ins that you plan to use in the project. Remember, you may change the number of busses in your project at any time.
Busses may be added to your project from the Project Properties Audio tab.

To add busses to your project, do the following:

1. Access the Project Properties dialog. There are three ways to access this dialog:
   - From the **File** menu, choose **Properties**.
   - Click the Project Properties ( ) button on the Mixer window on the Toolbar.
   - Press the **Alt** + **Enter** shortcut keys.

2. Click the **Audio** tab if it is not displayed.

3. In the **Number of stereo busses** field, enter the desired number of busses (up to 26) that will appear in the Mixer window. The busses will be labeled with letters in alphabetical order.

4. Click the **OK** button to add the specified number of busses and close the Project Properties dialog.
   - Click the **Apply** button to add the specified number of busses without closing the Project Properties dialog.
   - Click the **Cancel** button to close the Project Properties dialog and keep the original bus settings.
Deleting busses from the project

You may remove busses from your project at any time. When you remove a bus from a project, any tracks assigned to it will be reassigned to the previous bus in the Mixer window. For example, if you have tracks assigned to four busses (Bus A-D) in your project and remove Bus D, the tracks assigned to Bus D will be reassigned to Bus C.

Busses may be deleted from your project from the Project Properties Audio tab.

To delete busses from your project, do the following:

1. Access the Project Properties dialog. There are three ways to access this dialog:
   • From the **File** menu, choose **Properties**.
   • Click the **Project Properties** ( ) button on the Mixer window or on the Toolbar.
   • Press the **Alt+Enter** shortcut keys.

2. Click the **Audio** tab if it is not displayed.

3. In the **Number of stereo busses** field, enter the desired number of busses that will appear in the Mixer window.

4. Click the **OK** button to delete the specified number of busses and close the Project Properties dialog. All tracks assigned to a deleted bus will be reassigned to the preceding bus in the Mixer window.
   • Click the **Apply** button to add the specified number of busses without closing the Project Properties dialog.
   • Click the **Cancel** button to close the Project Properties dialog and keep the original bus settings.
Routing busses to hardware

You may specify busses to use specific hardware for output. When you installed Vegas Pro, it automatically determined the hardware available for output on your computer. Routing busses is done on the Preferences dialog. There are more details about routing specific and other preferences later in this manual. For more information, see Using Vegas Pro preferences on page 268.

To route busses to hardware, do the following:

1. From the Options menu, choose Preferences. The Preferences dialog will appear.

2. On the Preferences dialog, click the Routing tab.

3. Click the Use a Custom Routing radio button.

Note: If you have selected Always Use Sound Mapper, you will not be able to assign the busses to different hardware. You can only assign busses to different hardware if you select Use a Custom Routing.
4. In the table, click the radio button in the output device’s row and in the bus’s column to assign a bus to a specific output device.

Note: Multiple busses may be mapped to a single sound card. Also, the “grayed-out” busses may be assigned at this time so that they are ready when you add them later or use them in future projects.

5. Repeat step 2 to assign more busses to output devices.

6. From the Default recording device drop-down list, select a device used when recording. This option sets the device that you use for recording into tracks. However, tracks may be set to use specific devices other than the default setting. For more information, see Assigning tracks to input devices on page 202.

7. Click the OK button or press the Enter key to save the information and close the Preferences dialog.

Working with busses

Busses in the Mixer window are fully independent and may be adjusted separately from the others. You may adjust each bus’s volume, meter resolution, and clipping controls.
Adjusting the bus fader

You may adjust a bus's fader during project playback. The fader on a stereo bus is split so that you can adjust the levels of the two stereo channels.

To adjust the fader, do the following:

1. Click and drag in the middle of the fader to adjust both channels at the same time. Or, click the left or right fader to adjust either stereo channel.

2. Release the mouse to set the desired level.

   Note: Double-click the fader to reset it to 0.0 dB. If you have set each channel differently, double-click either the left or right fader to have the other fader match its volume setting.

Changing bus’s meter resolution

You may select a meter resolution at which a bus will display the signal levels that are being mixed. When you change the meter resolution on this control, the other meters (Assign FX and preview fader) automatically match the selected setting.

To change the bus's meter resolution, do the following:

1. Right-click on the meter to display a shortcut menu.

2. From the shortcut menu, choose the meter resolution that you prefer.

3. Repeat steps 1-2 to change the resolution again.
Adjusting the bus for clipping

When signals are playing back through the bus, its volume level may cause clipping. The clip is displayed on the bus's meter. If signal clips, the meter will display in red at the top with a clipping value. Adjust the fader control and click the red area with the clipping value to reset the meter. Continue to adjust the fader and reset the meter until clipping is eliminated.

You may also reset the clip from the shortcut menu when you right-click on the bus's meter. Moreover, you may set the meter to hold the signal level's peaks and valleys.

Muting a bus

This bus button enables you to temporarily disable playback of the bus. When a bus is muted, it appears “grayed out” and the word Muted appears at the bottom of the meter. You may mute more than one bus at a time.

To mute the bus, simply click the Mute (ㄨ) button. Click it again to “unmute” the bus.
Soloing a bus

This bus button isolates a bus's playback and mutes the other busses, so you can focus on a specific output. When you solo a bus, the other busses will be “grayed out” and the word Muted appears at the bottom of their respective meters. You may solo more than one bus at a time.

To solo the bus, simply click the Solo ( ) button. Click it again to restore all busses for playback.

Naming or renaming a bus

Every bus that appears in the Mixer window has a Scribble Strip where you can type a name. You may name or rename the bus at any time by doing the following:

1. Double-click in the Scribble Strip and type the a bus name.

2. Press the Enter key to save the bus's name.
Adding plug-in chains to busses

You may add any DirectX compatible plug-ins or a chain of plug-ins to a bus. When you add plug-ins to a bus, the track signals that are assigned to the bus will be processed by the plug-in(s) to create the desired output. However, if plug-ins are assigned at the track level (EQ or Compression, for example), the track's signal will flow through the track's plug-in(s) before the bus plug-ins. For more information, see Signal Flow on page 28.

Bus plug-in chains may be added at any time. Once plug-in chains are added to a bus, you may remove or add specific plug-ins until you achieve the desired output.

**Note:** DirectX plug-ins must be installed on your computer prior to adding them.

There are two ways to create bus plug-in chains: via the Plug-in Chooser dialog and via the Plug-in Explorer window:

Adding plug-in chains via the Plug-in Chooser dialog

To add plug-in chains to a bus, do the following:

1. Click on the Bus FX button ( ). The Plug-in Chooser dialog appears.

2. Select the FX folder to view a list of the available plug-ins on your system. If you have any preset plug-in chains saved, you may select the FX Chains folder and view those presets. For more information, see Working with preset plug-in chains on page 196.
3. Select the plug-in and add it to the chain area. You can add plug-ins in three ways:
   • Click on the desired plug-in then drag and drop it to the chain area.
   • Double-click on a plug-in.
   • Select the plug-in and click on the Add button.

4. When you have finished adding plug-ins, click on the OK button to save the chain.

Adding plug-ins chains via the Plug-in Explorer window
The Plug-in Explorer is a dockable window that allows you to view and choose DirectX
plug-ins that may be added to a bus.

To add plug-ins to a bus via the Plug-in Explorer, do the following:
1. If the Plug-in Explorer is not displayed, press the Alt + Esc shortcut keys or from the View
   menu choose Plug-ins.
2. On the Plug-in Explorer window, navigate to the Audio folder and select the FX folder. If
   you have any presets plug-in chains saved, you may select the FX Chains folder and view
   those presets. For more information, see Working with preset plug-in chains on page 196.

3. Click and drag the plug-ins to the bus to which you want to apply the chain.

   **Note:** You may add multiple plug-ins at the same time by clicking them while pressing the
   Shift or Ctrl keys and then drag them to the desired bus.
4. Confirm that the plug-ins were added by clicking the Bus FX button ( ) to view the Bus FX dialog. You may begin using the plug-in controls or rearranging the chain's order.

```
Arranging bus plug-ins on the chain

The plug-in controls that you set are cumulative during playback. For example, when a signal passes through Noise Reduction, it “carries” the Reduction’s settings as it passes through Reverb then the signal “carries” both those plug-in setting to the next plug-in, etc.

Because of this cumulative effect, you may need to arrange the plug-ins’ chain order so that one plug-in’s processing does not adversely affect the next one in the chain. There is no right or wrong way to order plug-ins. Although, some plug-ins work better when they follow another. For example, the Dither plug-in is best suited as the last one in a chain. However, the chain’s plug-in order is strictly based on your preferences and desired output.

You may arrange the chain’s plug-ins from either the Bus FX or the Plug-in Chooser dialogs.

Arranging plug-ins on the Bus FX dialog

1. Click the Bus FX button ( ). The Bus FX dialog appears.
2. Right-click on the plug-in that you want to move to display a shortcut menu.
3. From the shortcut menu, choose Move Right or Move Left.
4. Repeat steps 1-3 to continue arranging plug-ins.
```
Arranging plug-ins on the Plug-in Chooser dialog
To arrange the chain's plug-in order, do the following:

1. Click the Bus FX button ( ). The Bus FX dialog appears.

2. On the Bus FX dialog, click the Bus FX Edit button ( ) to display the Plug-in Chooser dialog.

   There are two ways to arrange plug-ins in your chain on the Plug-in Chooser dialog:
   • Drag and drop the plug-in to a new location in the chain.
   • Select the plug-in and click either the left ( ) or right ( ) move button.

3. Once you get the desired chain order, click the OK button to save it and close the Plug-in Chooser dialog.

Bypassing plug-ins on the chain
You may bypass a plug-in on the chain by clicking its check box or right-clicking the plug-in to display a shortcut menu and choosing Bypass. The plug-in will remain bypassed until you enable it again. Bypassing a plug-in prevents its processing on the signal.

You may bypass plug-ins either from the Bus FX dialog or the Plug-in Chooser dialog.

To enable the plug-in again, click its check box or choose Bypass from the shortcut menu.
Deleting plug-ins from the bus chain

After you have created bus plug-in chains, you may remove any of the plug-ins from the chain at any time. You may remove bus plug-ins from the Bus FX dialog of the Plug-in Chooser dialog.

Deleting plug-ins from the Bus FX dialog

To delete a plug-in from the chain, do the following:

1. Click on the Bus FX button ( ). The Bus FX dialog appears.

2. Right-click on the plug-in that you want to remove to display a shortcut menu.

3. From the shortcut menu, choose Remove. The plug-in will be removed from the chain.

Deleting plug-ins from the Plug-in Chooser dialog

1. Click the Bus FX button ( ). The Bus FX dialog appears.

2. On the Bus FX dialog, click the Edit Plug-in Chain button ( ). The Plug-in Chooser dialog will appear with the chain.

3. Select the plug-in that you want to delete and click the Delete button to remove it from the chain.

4. Click the OK button or press the Enter key to save the chain and close the Plug-in Chooser dialog.
Using Assignable FX controls

With Vegas Pro, you can take advantage of plug-ins when processing your project's signal. These plug-ins may be added to your project as Assignable FX controls. Assignable FX controls can have a series of plug-ins (chains) assigned to it.

The Assignable FX controls appear in the Mixer window along with busses to which you may route the Assignable FX.

---

**Mute**
Prevents the Assignable FX from processing the track's signal (pg. 194).

**Input Master Fader**
Adjusts the signal's incoming volume to the Assignable FX (pg. 193).

**Output Master Fader**
Adjusts the signal's outgoing volume to the Assignable FX.

**Solo**
Plays only the output of that Assignable FX chain (pg. 195).

**Assignable FX**
Displays the Assignable FX dialog and allows you to adjust their attributes (pg. 188).

**Meter**
Displays the incoming and outgoing signal level to the Assignable FX (pg. 193).

**Scribble Strip**
Allows you to name the Assignable FX (pg. 195).

---

**Note:** To use the Output Master Fader to control the wet/dry mix, make sure you set each plug-in to 100% wet. Use the Output Master (FX return) fader to balance the dry track signal with the wet plug-in signal.

---

Adding Assignable FX controls

You may add up to 32 Assignable FX controls to the Mixer window. Each control can have up to 32 DirectX plug-ins added its chain. In order to have the control appear in the Mixer window, you need to select at least one plug-in for it to control.

There are two ways to add an Assignable FX to your project: via the Plug-in Chooser dialog and via the Plug-in Explorer window.
Adding Assignable FX controls via the Plug-in Chooser dialog

To add and Assignable FX control via the Plug-in Chooser, do the following:

1. From the **Insert** menu, choose Assignable FX or right-click in the Mixer window and choose Insert Assignable FX from the shortcut menu. The Plug-In Chooser dialog will appear.

2. Select the **FX** folder to view a list of the available plug-ins on your system. If you have any presets plug-in chains saved, you may select the **FX Chains** folder and view those presets. For more information, see Working with preset plug-in chains on page 196.

3. Select the plug-in(s) and add it to the chain area.

   You can add plug-ins in three ways:
   - Click on the desired plug-in then drag and drop it to the chain area.
   - Double-click on a plug-in.
   - Select the plug-in and click on the **Add** button.

4. When you have finished adding plug-ins, click on the **OK** button to save the chain.

   The Assignable FX control is added to the Mixer window. These controls are number chronologically (FX 1, FX 2, FX 3, etc.).
Adding plug-in chains via the Plug-in Explorer window

The Plug-in Explorer is a dockable window that allows you to view and choose DirectX plug-ins that may be added as Assignable FX controls.

To add plug-ins as Assignable FX controls via the Plug-in Explorer, do the following:

1. If the Plug-in Explorer is not displayed, press the `Alt + 5` shortcut keys or from the **View** menu choose Plug-ins.

2. On the Plug-in Explorer window, navigate to the **Audio** folder and select the **FX** folder. If you have any presets plug-in chains saved, you may select the **FX Chains** folder and view those presets. For more information, see *Working with preset plug-in chains* on page 196.

3. Click, drag, and drop the plug-in to the Mixer window. Vegas Pro will create one Assignable FX to control the selected plug-in.

**Note:** You may add multiple plug-ins at the same time by clicking them while pressing the **Shift** or **Ctrl** keys and then drag them to the Mixer window. In this case, Vegas Pro will create one Assignable FX control for all the plug-ins (the chain).
4. Confirm that the plug-in(s) where added by clicking the Assignable FX button (·⁻⁻⁻⁻⁻⁻⁻) to view its dialog. You may begin using the plug-in controls or rearranging the chain’s order.

Arranging Assignable FX plug-ins on the chain

The plug-in controls that you set are cumulative during playback. For example, when a signal passes through Noise Reduction, it “carries” the Reduction’s settings as it passes through Reverb then the signal “carries” both those plug-in setting to the next plug-in, etc. Because of this cumulative effect, you may need to arrange the plug-ins’ chain order so that one plug-in’s processing does not adversely affect the next one in the chain. As a result, some plug-ins work better when they follow another. For example, the Dither plug-in is best suited as the last one in a chain. However, the chain’s plug-in order is strictly based on your preferences and desired output.

You may arrange the chain’s plug-ins from either the Assignable FX or Plug-in Chooser dialogs.

Arranging plug-ins on the Assignable FX dialog
1. Click the Assignable FX button (·⁻⁻⁻⁻⁻⁻⁻). The Assignable FX dialog appears.
2. Right-click on the plug-in that you want to move to display a shortcut menu.

   ![Shortcut Menu]

3. From the shortcut menu, choose Move Right or Move Left.
4. Repeat steps 1-3 to continue arranging plug-ins.
Arranging plug-ins on the Plug-in Chooser dialog
To arrange the chain’s plug-in order, do the following:

1. Click on the Assignable FX button (-). The Assignable FX dialog appears.

2. On the Assignable FX dialog, click the Edit Plug-in Chain button (-) to display the Plug-in Chooser dialog.

   There are two ways to arrange plug-ins on your chain:
   • Drag and drop the plug-in to a new location in the chain.
   • Select the plug-in and click either the left (-) or right (-) move button.

3. Once you get the desired chain order, click the OK button to save it and close the Plug-in Chooser dialog.

Bypassing plug-ins on the Assignable FX chain
You may bypass a plug-in on the chain by clicking its check box. The plug-in will remain bypassed until you enable it again. Bypassing a plug-in prevents its processing of the signal.

You may bypass plug-ins either from the Assignable FX dialog or the Plug-in Chooser dialog.

Effect enabled
Effect bypassed

To enable the plug-in again, click its check box or choose Bypass from the shortcut menu.

You may bypass all plug-ins from the Assignable FX control’s shortcut menu.
Deleting plug-in from the Assignable FX chain
To delete a plug-in from the chain, do the following:

1. Click on the Assignable FX button (-). The Assignable FX dialog appears.

2. On the Assignable FX dialog, click the Edit Plug-in Chain button (-). The Plug-in Chooser dialog will appear with the chain.

3. Select the plug-in that you want to delete and click the Delete button to remove it from the chain.

4. Click the OK button to save the chain and close the Plug-in Chooser dialog.

Note: You may also remove plug-ins from the Assignable FX dialog by right-clicking the plug-in and choosing Remove from the shortcut menu.
Routing Assignable FX to busses

When you add Assignable FX to your project, you may assign them to a specific bus for output. The bus will then mix the Assignable FX control's plug-ins along with any tracks that may be routed to the same bus.

To route an Assignable FX to a bus, do the following:

1. Click Bus button on the Assignable FX. A sub-menu will appear and display all the busses that are in your project.

2. Click the bus to which you want the Assignable FX control to be routed. The Assignable FX control will display the bus's letter to which it is routed.

Working with Assignable FX controls

Assignable FX controls that appear in the Mixer window are fully independent and may be adjusted separately from the others. You may adjust each Assignable FX's volume, meter resolution, and clipping controls.
Adjusting the Assignable FX faders

You may adjust a Assignable FX’s faders during project playback. The faders on the incoming and outgoing signal meters are split so that you can adjust the two stereo channels’ levels.

To adjust the faders, do the following:

1. On either set of faders, click and drag in the middle of the fader to adjust both channels at the same time. Or, click the left or right fader to adjust either stereo channel.

2. Release the mouse to set the desired level.

   Note: Double-click the fader to reset it to 0.0 dB. If you have set each channel differently, double-click either the left or right fader to have the other fader match its volume setting.

Changing Assignable FX’s meter resolution

You may select a preferred meter resolution at which the Assignable FX displays the signal levels that are being processed. When you change the meter resolution on this control, the other meters (busses and preview fader) automatically match the selected setting.

To change the meter resolution, do the following:

1. Right-click on the meter to display a shortcut menu.

2. From the shortcut menu, choose the meter resolution that you prefer.

3. Repeat steps 1-2 to change the resolution again.
Adjusting the Assignable FX for clipping

When signals are playing back through the Assignable FX, its volume level may cause clipping. The clip is displayed on both the incoming and outgoing meters, depending on its fader level. If signal clips, the meter will display in red at the top with a clipping value. Adjust the fader controls and click the red area with the clipping value to reset the meter. Continue to adjust the faders and reset the meter until clipping is eliminated.

You may also reset the clip from the shortcut menu when you right-click on either Assignable FX’s meter. Moreover, you may set the meter to hold the signal level’s peaks and valleys.

Muting an Assignable FX

The Mute button (x) appears on both the Assignable FX control and its dialog. This button enables you to temporarily disable playback of the Assignable FX. When an Assignable FX is muted, it appears “grayed out” and the word Muted appears at the bottom of the meter. You may mute more than one Assignable FX at a time.

To mute the Assignable FX, simply click the Mute (x) button on either the control or dialog. Click it again to “unmute” the Assignable FX.
Soloing an Assignable FX

The Solo button ( ) appears on both the Assignable FX control and its dialog. This Assignable FX button isolates the control’s playback and mutes the other Assignable FX and tracks that are assigned to them, so you can focus on a specific output. When you solo an Assignable FX control, the other controls will be “grayed out” and the word Muted appears at the bottom of their respective meters. You may solo more than one Assignable FX control at a time.

To solo an Assignable FX control, simply click the Solo ( ) button on either the control or the dialog. Click it again to restore all Assignable FX for playback.

Naming or renaming an Assignable FX

Every Assignable FX control that appears in the Mixer window has a Scribble Strip where you can type a name.

You may name or rename the Assignable FX at any time by doing the following:

1. Double-click in the Scribble Strip and type the Assignable FX name.

   ![Double-click and type the name]

   If the control already has been named, you will see the previously entered name.

2. Press the Enter key to save the Assignable FX’s name.
Working with preset plug-in chains

You may save and edit the plug-in chains that you added to busses or created as Assignable FX controls. These chains will be stored by Vegas Pro for use in future projects. If you use the same plug-in chains, saving them as presets is a faster way to apply them to busses or creating Assignable FX controls. The plug-in chains may be saved as presets from existing chains that are being used in a project or as you are creating them for busses or Assignable FX.

Creating new preset plug-in chains

You may save preset plug-in chains from existing chains or as you create them in the Plug-in Chooser. The first time you create a plug-in chain, you are adding it as a bus or Assignable FX chain in the Plug-in Chooser dialog.

Once the preset chains are saved as presets, they may be used as either bus or Assignable FX plug-in chains. The preset FX chains that you save appear in the Plug-in Chooser dialog.

Note: If you are adding plug-ins by dragging them from the Plug-in Chooser dialog, you can still save those chains as presets. For more information, see Creating presets from existing plug-in chains on page 197.

Saving preset during chain creation

To save a plug-in chain while you are creating it in the Plug-in Chooser dialog, do the following:

1. From the Plug-in Chooser dialog, select the plug-ins that you want to use and add them to the chain area.
2. Arrange them in the order that you prefer.
3. Click the Save As button. The Save plug-in chain as dialog will appear.

4. Enter a name that you want to use for the preset.

5. Click the OK button or press the Enter key to save the plug-in chain as a preset.

The preset will be saved to the FX Chain folder in the Plug-in Explorer window. In addition, the chain will be added to either the bus or Assignable FX for which you created it.

Creating presets from existing plug-in chains

You may save plug-in chains that are being used in a project as presets. If you use a combination of plug-ins often, saving them in a preset will save you time when editing a project. The preset chains that you save retains the order of plug-ins and the settings that you have applied.

After the preset chain is saved, it may be applied to a bus or an Assignable FX.

To save an existing plug-in chain as a preset, do the following:

1. Click an existing Bus or Assignable FX button and then on the respective Edit Plug-in Chain button to display the Plug-in Chooser dialog.

2. Once the Plug-in Chooser dialog is displaying with the plug-ins on the chain area, click the Save As button. The Save plug-in chain dialog will appear.

3. Enter a name that you want to use for the preset.

4. Click the OK button or press the Enter key to save the preset.
Editing preset plug-in chains

You may add, delete, and rearrange plug-in on preset chains at any time. Editing is preformed on the Plug-in Chooser dialog.

To edit a preset plug-in chain, do the following:

1. From the bus or Assignable FX control, click either the control's FX button ( ) to display their FX dialog.
2. From the FX dialog, click the Edit Plug-in Chain button ( ). The Plug-in Chooser dialog will appear with the preset in the chain area.
3. Add, delete, or rearrange plug-ins associated to the preset chain.
4. Click the OK button or press the Enter key to save the preset.

Note: Click the Save As button to save the edited chain as a preset.

Organizing your plug-ins

Within the Plug-in Chooser dialog, you may create folders and move selected plug-ins into them. For example, if you have different company's DirectX plug-ins installed on your computer, you can move their respective plug-ins to newly created folders.

The Plug-in Chooser dialog works similarly to the Windows Explorer that is included with your operating system. However, you may only work with the plug-ins that are loaded on your system from the Plug-in Chooser dialog.
Vegas Pro will record into multiple mono or stereo audio tracks while simultaneously playing back existing audio tracks. You are limited only by the performance of your computer system and audio hardware. You may record into an empty track, a time selection, an event, or a combination of time and selection. Audio playback during recording is not recorded with the new audio.

Recording in Vegas Pro is a non-destructive operation. Even when recording into an existing event, you are not overwriting the data that is already displayed in that event. Instead, the data is recorded into a new take for that event.

Setting up your equipment

Following are general setup scenarios. There are numerous ways to connect your equipment to your system. Refer to your equipment's documentation for specific setup instructions.

Basic setup

This setup includes a simple microphone and speaker that are connected to the computer's sound card. With a more sophisticated microphone, you would typically want to use a preamplifier for input to the sound card.
Setup with mixer

This setup includes a mixer where the speaker and microphone connect. The mixer is then connected to the computer's sound card. Mixers usually have pre-amps built into them. This diagram does not show you an instrument or a physical preamplifier, such as a rack-mounted component. The reason for this omission is because these types of setup vary widely based on your mixer, instrument, and pre-amp type. Refer to your components' documentation for specific setup configurations.

Setup with digital multitrack

This setup includes a digital multitrack recorder with an optional MIDI synchronization component. Usually you would have a mixer, microphone, etc. connected to these components. For simplicity, this diagram demonstrates that Vegas Pro can be used in this type of environment. As mentioned earlier, your particular setup may vary depending on your equipment. Refer to your components' documentation for specific setup configurations.
Arming the track for recording

Whether you are recording into an empty track, a selected event, or a time selection, you need to prepare the track for recording. Click the Arm for Record ( ) button. You must arm a track before any new data is created. You may arm multiple tracks prior to recording. Once a track is armed, you will see a record meter appear on the track(s) to be recorded into. You will also see one of two recording device button appear: or . The button that appears is based on the preferences routing tab. For more information, see Using the Routing preferences tab on page 270.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>This button appears when you have selected Use Microsoft Sound Mapper for all busses on the Preferences routing tab. The Sound Mapper allows you to choose how the signal will be recorded: stereo or mono. Click on this button to view a menu with Stereo, Left, or Right. To record in mono choose either the left or right channel prior to recording. When you select either the left or right channel, the button will change to reflect your choice for mono recording.</td>
</tr>
<tr>
<td>Mono left</td>
<td></td>
</tr>
<tr>
<td>Mono right</td>
<td></td>
</tr>
</tbody>
</table>

Using the Sound Mapper for stereo or mono recording

After you have armed the track for recording, you may choose whether the track will record the signal in stereo, in mono from the left channel, or in mono from the right channel. Stereo is the default setting.

To select a recording method, do the following:

1. Click the Audio button ( ) left of the Record button ( ) to display a drop-down list.
2. From the drop-down list select the recording method (Stereo, Left, or Right).
Assigning tracks to input devices

After you have armed the track for recording, you may select the device from which the track will record its signal. Also you may choose whether the track will record the signal in stereo, in mono from the left channel, or in mono from the right channel.

Whichever device and recording option you select, Vegas Pro will display the selection on the track's toolbar.

To select an input device and recording method, do the following:

1. Click the Audio button ( JButton) left of the Record button ( JButton) to display a drop-down list.
2. From the drop-down list select the input device and recording method (Stereo, Left, or Right).
Starting and stopping recording

To start recording, click the Record button (○) on the Transport bar, which is located just below the Track View.

Depending on the recording selection, you will see Vegas Pro create a waveform along the timeline as you record into the armed track(s).

To stop recording, click the Record button (○) again or the Stop button (■) on the Transport bar. A dialog will appear allowing you to rename, delete, or keep the *.wav file.

When a check mark appears in this box, Vegas Pro will display this dialog after each recording session.
Recording into an empty track

Whether your project is new or already contains tracks, you may record into an empty track. As you record, Vegas Pro will create the event’s waveform that will display on the track. The event, like all events in your project, will have a source media file. By default, Vegas Pro stores recorded media files in the Vegas Pro program folders. However, you may specify where recorded media files are stored. For more information, see Specifying where recordings are stored on page 213.

On the Track View, the cursor position is where recording will begin. You may want to place the cursor along the timeline before you record. Positioning the cursor is not always necessary since you may move the event after recording.

To record into an empty track, do the following:

1. Press the `Ctrl+Q` keys to insert an empty track. Or, from the Insert menu, choose Audio Track.
2. Place the cursor on the timeline where you want to begin recording.
3. Select the track that you want to record into.

   **Note:** To select multiple tracks, click them while holding down either the `Shift` key to select adjacent tracks, or the `Ctrl` key to select random tracks.

4. Arm the selected track(s) by clicking the Arm for Record button (●) on the track(s).
5. Choose the input device from which the track will record (pg. 202).
6. Choose the recording method that the track will use (pg. 202).
7. Start recording by clicking the Record button (●) on the Transport bar.

Recording will begin at the cursor’s position and continue along the timeline until you stop recording.
Recording into a time selection

By making a time selection, you specify where along the timeline to record. Also, the time selection determines how long Vegas Pro will record. Any selected events that occur within the time selection will be split, and the recorded data will be placed into the time selection. For more information, see Recording into an event with a time selection on page 207.

The recorded event, like all events in your project, will have a source media file. By default, Vegas Pro stores recorded media files in the Vegas Pro program folder. However, you may specify where recorded media files are stored. For more information, see Specifying where recordings are stored on page 213.

To record into a time selection, do the following:

1. Click the Arm for Record button (●) on the desired track.

   **Note:** To select multiple tracks, click them while pressing either the Shift or Ctrl keys.

2. Choose the input device from which the track will record (pg. 202).

3. Choose the recording method that the track will use (pg. 202).

4. On the Marker bar, click and drag to make the time selection. You may adjust the time selection by dragging the selection bar’s starting and ending points.

5. Click the Record button (○) on the Transport bar to begin recording.

   Vegas Pro will display the event’s waveform as it is recorded and automatically stop recording when the cursor reaches the end of the time selection.

   To record multiple takes, click the Loop play (○) button on the Transport bar. For more information, see Working with multiple recorded takes on page 208.
Recording into an event

You may record directly into an event. By recording into an event, you specify where along the timeline to record and for how long. The edges of the selected event serve as the punch-in and -out points that Vegas Pro uses for recording. Recording into an event allows you to establish pre-roll before recording, which gives you time to prepare before recording starts.

The existing event that you record into is not affected or deleted. It will be listed as a take “under” the recorded event. For more information, see Working with multiple recorded takes on page 208. After you record into an event, the recorded waveform appears on the track.

The recorded event, like all events in your project, will have a source media file. By default, Vegas Pro stores recorded media files in the Vegas Pro program folder. However, you may specify where recorded media files are stored. For more information, see Specifying where recordings are stored on page 213.

To record into a selected event, do the following:

1. Place the cursor before the event to allow for pre-roll.
2. Press the Ctrl key and click the event to select it.

   ![Selected event](image1) ![Non-selected event](image2)

   **Note:** You may record into multiple events by pressing the Ctrl key and make your selections.

3. Click the Arm for Record button (●) on the event’s track. If you are recording into multiple selected events, arm their respective tracks.
4. Choose the input device from which the track, with the selected event, will record (pg. 202).
5. Choose the recording method that the track, with the selected event, will use (pg. 202).
6. Click the Record button (○) on the Transport bar to begin recording.

   ![Start/Stop recording](image3) ![Stop recording](image4)

   Vegas Pro will display the event’s waveform as you record.
7. Click the Record button (○) or the Stop button (■) on the Transport bar to stop recording.
Recording into an event with a time selection

You may record into a selected event within a time selection. This option allows you to add for pre- and post-roll during recording. The time selection is adjustable to increase or decrease the pre- and post-roll. During recording, the selected event’s edges serve as the punch-in and -out points. You may create multiple punch-in and -out points by selecting more events within the time selection.

You may need to split an existing event into three pieces so that you can select a smaller portion of the event to record into. For more information, see Splitting events on page 96.

To record into an event with a time selection, do the following:
1. Click the Arm for Record button ( ) on the desired track(s).
2. Choose the input device from which the track, with the selected event, will record (pg. 202).
3. Choose the recording method that the track, with the selected event, will use (pg. 202).
4. Select the event to record into.

   **Note:** You may record into multiple events by pressing the Ctrl key and make your selections.

5. On the Marker bar, click and drag to make the time selection. You may adjust the time selection by dragging the selection bar’s starting and ending points.

   To record multiple takes, click the Loop play ( ) button on the Transport bar. For more information, see Working with multiple recorded takes on page 208.

6. Click the Record button ( ) on the Transport bar to begin recording.
Working with multiple recorded takes

If you made a time selection during recording, clicking the Loop Play ( ) button on the Transport bar will enable you to continually create takes during recording. Takes are different versions of a recorded event that you may play back and edit.

During recording, Vegas Pro continually “loops” back to the beginning of the time selection and starts recording a new take until you stop recording. After you are done recording takes, you can preview, choose a new active, rename, and delete them.

Previewing takes

Vegas Pro allows you to view a list of takes and preview them before placing them in your project. The takes are listed from the selected event in which the takes were recorded.

To preview takes, do the following:
1. Select the event in which multiple takes were recorded.
2. Right-click to display a shortcut menu.
   Or, from the Edit menu, choose Takes to display a sub-menu.
3. Select Choose Active... from the sub-menu. The Take Chooser dialog appear.
4. Select the take that you want to preview and use the Play ( ) and Stop (■) buttons within the dialog.
5. To use a take, select it and click the OK button or double-click the take that you want to use. The selected take is now the active take.
   The event take will be displayed as the active take on the track in your project.
Choosing an active take after loop recording

As an alternative to the previous section, you may select an active take using the shortcut menu. After you have recorded multiple takes, the take that appears on the Track View is called the active take. The active take is the last one which you recorded. You may make a previous recorded take the active one so that it will play back.

To select new active take, do the following:

1. Select the event into which multiple takes were recorded.
2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Take. A sub-menu will appear with the event's original file name (in this example, GuitarIntro) followed by the recorded takes, which are numbered sequentially. The active take will have a bullet next to it.

   Note: This listing of the original event and takes "rotate" as you make different takes active. Also, you may give takes more meaningful names. For more information, see Renaming an event take on page 210.

4. Select the take that you want to make active by clicking it.
Renaming an event take

Vegas Pro names recorded takes by specifying the track number and the take number, for example, Track 2 Recording 24 Take 2. These take names are specific to your project, but are not descriptive of what sound(s) were recorded. You may rename each take and give them more meaningful descriptions for easier reference while working on your project.

You may only rename the active take name. For more information, see Choosing an active take after loop recording on page 209.

To rename an event take, do the following:
1. Click the recorded event to select it. The event being displayed is the active take.
2. Right-click on the selected event to display a shortcut menu.

3. From the shortcut menu, choose Rename Active. The take’s name will appear in a text box in the lower-left portion of the event. The event’s take name will be selected.

4. Type a new name in the text box.
5. Press the Enter key to save the new take name or click outside the text box.
6. Repeat steps 1-5 to rename the other takes in the event. Remember to make a take active before renaming it.

Note: You may change event names via the event’s properties. For more information, see Changing the active take’s name on page 104.
Deleting an event take

Vegas Pro allows you delete unwanted recorded takes from your project. Deleting a take does not remove the event takes source file. You need to manually remove unwanted media source files that were recorded. By removing unwanted media source files that were recorded, you will save on disk space. For more information, see Using the Explorer window on page 245.

There are two ways to delete event takes: deleting the active take and takes from a list.

Deleting the active take

The active take is the event that appears on the Track View. If the event take you want to remove is not displayed, make it the active take before deleting it. For more information, see Choosing an active take after loop recording on page 209.

To delete the active take, do the following:
1. Click on the event take to select it.
2. Right-click on the event take to display a shortcut menu.
3. From the shortcut menu, choose Takes and then Delete Active from the sub-menu.

Or, from the Edit menu, choose Takes and then Delete Active from the sub-menu.

The event take will be removed, and if there are multiple takes, the next take will appear on the Track View.
Deleting event takes from a list
You may delete takes from a list when you have chosen the one that you want to use in your project. You may delete multiple event takes at a time.

To delete event takes from a list, do the following:
1. Click on the event take to select it.
2. Right-click on the event to display a shortcut menu.
3. From the shortcut menu, choose Takes and then Delete from the sub-menu. The Delete Takes dialog will appear.
   Or, from the Edit menu, choose Takes and then Delete from the sub-menu. The Delete Takes dialog will appear.
4. Select the event take that you want to remove. Click the play button to confirm that the selected event is the one you want to remove.

**Note:** To select multiple event takes, hold down either the Shift or Ctrl keys.
5. Click the OK button to remove the selected event take(s) from your project.
Specifying where recordings are stored

Vegas Pro is a non-destructive audio editing environment. Events within your project are actually references to media source files located on a storage device such as a hard drive or CD-ROM. When you record into Vegas Pro, the event appears on the Track View while its media source file is written to your hard drive. By default, Vegas Pro stores recorded media source files in the Vegas Pro program folder. However, you may specify where Vegas Pro writes and stores recorded media source files.

To change where recorded media source files are stored, do the following:

1. From the File menu, choose Properties or press the Alt+Enter shortcut keys. The Project Properties dialog will display.

2. Click the Audio tab to display the project's audio properties.

Path where recorded media source files are written and stored. Also, available disk space.
3. Click the **Browse** button. The Recorded Files Folder dialog will appear.

![Recorded Files Folder dialog](image)

4. Navigate to the hard drive or folder where you want Vegas Pro to write and store recorded media source files.

5. Click the **Save** button to set the destination drive or folder.
   
   Click the **Cancel** button to leave the current destination the same.

6. Repeat steps 1-4 to change the destination again.

**Note:** Check **Start all new projects with these settings** if you want new projects to store recorded media source files to the same location. Otherwise, Vegas Pro will use its default settings.
Saving and Rendering projects

Vegas Pro allows you to save and render projects into many different formats. The chosen format is determined by how you want to deliver the media. When you render a Vegas Pro project to a different format, your project is not affected. It may be opened again in Vegas Pro for editing.

This chapter explains saving a project and using the Save As function. In addition, you will find reference information for the rendering options available in Vegas Pro. Many of the codecs used for specific rendering formats are updated periodically by their creators. For the latest information about specific codecs, contact their respective manufacturer.

Saving your project

The first time a project is saved you will have two options. Either option saves all the project's information: track and bus plug-ins, volume and panning envelopes, bus assignments, Assignable FX settings, etc.

The first option allows you to save all of the information about a project. It saves the references to media files used in the project.

The second option allows you to save the project so that its media content is copied to that same folder as the project itself. This option makes transporting the project easy and convenient.

To save the project, do the following:

1. Select one of the save methods:
   • From the File menu, choose Save.
   • Click on the button.
   • Press Ctrl+S on the keyboard.

   The first time you save a project, the Save As dialog appears.
The subsequent times you save, the above dialog is bypassed, your existing file name is retained, and your project is updated to include any implemented changes.

2. Select the drive and directory where you want to store the project.

3. Type the project name in the **File name** field.

4. Click the **Copy all media with project** check box if you want all the media copied into the same folder as the project.

5. Click the **Save** button on the Save As dialog.

**Creating a copy of a project (using Save As...)**

After you have been working with your project, you may use the **Save As** command in the **File** menu to create a copy of the project. This option also allows you to rename the project or render it to a different file format. Typically rendering to a different format means that the project is finished and ready for distribution.

**Note:** You may use **Save As** from the **File** menu to save the project the first time. The only difference from the previous procedure is that the **Save As** dialog includes other file formats.
To create a copy of the Vegas Pro project, do the following:

1. From the **File** menu, choose **Save As**. The **Save As** dialog appears.

2. Select the drive and directory where you want to store the project.

3. Type a new name in the **File name** field.

4. Click the **Copy all media with project** check box if you want all the media copied into the same folder as the project.

5. Click the **Save** button on the **Save As** dialog.

**Save As dialogs check boxes**

The **Save As** dialog has three check boxes, which you can use when saving your file or rendering it to a different format. These check boxes appear in the lower-left corner of the dialog.

- **Copy all media with project**: Vegas Pro (*.veg) projects only. This option copies the media that is referenced in the project to the same folder to which you are saving the project (for portability).
- **Render entire project**: If you have a time selection in your project, this option ensures that the entire project is rendered. If you do not select this option, only the time selection is rendered.
- **Save project markers in media file**: If your project contains markers or regions, you may save that information in the rendered file. Saving markers into a media file can enhance the end user’s interaction with the media file.
Rendering projects

Rendering refers to the process of converting the Vegas Pro project into one file and formatting it for the desired playback method: media player, Internet streaming media, CD-ROM, etc. The project file is not overwritten, deleted, or altered during the rendering process. You may return to the original project to make edits or adjustments and render it again. The following table describes the formats available for rendering your Vegas Pro project:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>*.aif</td>
<td>The standard audio file format used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG Layer 3</td>
<td>*.mp3</td>
<td>Highly compressed audio format. You may render up to 20 *.mp3 files without registering the optional plug-in (see note below this table).</td>
</tr>
<tr>
<td>RealMedia G2</td>
<td>*.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Vegas Pro EDL</td>
<td>*.txt</td>
<td>This option creates a text version of event placements in the Track View. This text description can then be imported into a database or text application for modification or other purposes.</td>
</tr>
<tr>
<td>Vegas Pro project</td>
<td>*.veg</td>
<td>This option saves the references to media files used in the project. Also saved is project information, track plug-ins, envelopes, bus assignments, and output properties. The *.veg file does not combine events into a single file.</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>*.avi</td>
<td>The standard video file format used on Windows-based computers. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>*.wav</td>
<td>The standard audio file format used on Windows-based computers.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>*.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Windows Media Format</td>
<td>*.asf</td>
<td>The Microsoft standard used for streaming audio and video media via the Web.</td>
</tr>
</tbody>
</table>

**Note:** Vegas Pro allows you to render up to 20 *.mp3 files without registering the optional plug-in. This feature gives you the opportunity to try the plug-in. After the 20th *.mp3 is created, you need to register the plug-in to create *.mp3 files.
Rendering to an audio format

The audio only formats that you can choose from are *.aif, *.mp3, *.wav and *.wma. The file formats of *.aif and *.wav allow you to set the frequency, bit-depth, channel, and sample rate to which the Vegas Pro project will be rendered. The *.wma format allows you to set the streaming qualities. The MPEG file format allows you to set its exclusive controls for the best audio quality based on your delivery method. For more information, see Using *.mp3 controls and templates on page 227.

Rendering to a *.aif, *.mp3, *.wma or *.wav file

This procedure is identical for each audio format to which you want the project rendered. The only difference is the selection from the drop-down list on the Save As dialog.

To render a Vegas Pro project to one of these formats, do the following:

1. From the File menu, choose Save As. The Save As dialog appears.
2. Select the drive and directory where you want to save the rendered file.
3. Type a new name in the File name field, if necessary.
4. In the Save as type drop-down list, choose AIFF (*.aif), MP3 Audio (*.mp3), Wave (Microsoft) (*.wav), or Windows Media Audio (*.wma).
5. If necessary, select any applicable check boxes (pg. 217).
6. Click the Save button. A status bar appears in the lower left portion of Vegas Pro. Upon completion of the render, your Vegas Pro project is ready for distribution and playback.

**Note:** You may cancel the rendering process by clicking the button on the status bar.
Rending to a video format

You may render a project with audio and video to an *.avi file. With this format, you may set the audio portion’s frequency, bit-depth, channel, and sample rate. In addition, you can set the frame rate, frame size and compression to which the Vegas Pro project will be rendered. For more information, see Using *.avi controls and templates on page 232.

To render a Vegas Pro project to an *.avi file, do the following:

1. From the File menu, choose Save As. The Save As dialog appears.
2. Select the drive and directory where you want to save the rendered *.avi file.
3. Type a new name in the File name field, if necessary.
4. In the Save as type drop-down list, choose Video for Windows (*.avi).

5. If necessary, select any applicable check boxes (pg. 217).
6. Click the Save button. A status bar appears in the lower left portion of Vegas Pro. Upon completion of the render, your Vegas Pro project is ready for distribution and playback.

Note: You may cancel the rendering process by clicking the button on the status bar.
Rending to a streaming media format

You may render a project with audio and video to a streaming media format. Streaming media can be used for presenting information via the Web. Vegas Pro can render a project to either Windows Media (pg. 236) or RealMedia (pg. 239) players. With these formats, you may set the audio portion's frequency, bit-depth, channel, and sample rate. In addition, you can set the frame rate, frame size and compression for the video portion.

Rendering to a *.asf, or *.rm file

This procedure is identical for each streaming format to which you want the project rendered. The only difference is the selection from the drop-down list.

To render a Vegas Pro project to one of these formats, do the following:

1. From the File menu, choose Save As. The Save As dialog appears.
2. Select the drive and directory where you want to save the rendered file.
3. Type a new name in the File name field, if necessary.
4. In the Save as type drop-down list, choose Windows Media Format (*.asf), or RealMedia G2 (*.rm).
5. If necessary, select any applicable check boxes (pg. 217).
6. Click the Save button. A status bar appears in the lower left portion of Vegas Pro. Upon completion of the render, your Vegas Pro project is ready for distribution and playback.

**Note:** You may cancel the rendering process by clicking the [x] button on the status bar.
Using rendering format controls and templates

For each file format to which you may render your project, Vegas Pro allows you to choose from the templates that appear on the Save As dialog’s Template drop-down list. You may also save your own templates by clicking the Custom button. However, in most cases, the templates provide the best results for rendering your projects.

Each rendering format has its own controls and in some cases codecs that you can use prior to rendering your project. The control settings and codecs that you select depend largely upon how you want to deliver the media.

The following sections present an overview of each format’s controls and template creation. Many of the codecs used for specific rendering formats are updated periodically by their creators. For information about specific codecs, contact their respective manufacturer.
Using *.aif controls and templates

The *.aif file format is the audio standard for Macintosh operating systems. To access this format's controls, click the Custom button on the Save As dialog. The Custom Setting dialog appears. The Format drop-down list is set to PCM (Pulse Code Modulation). The Attributes drop-down list is dependent on the chosen sample rate, bit-depth, and number of channels.

Templates

You may use an included template by choosing one from the Template drop-down list. (These templates may also be accessed from the Save As dialog.)

The template's properties or parameters will be displayed in the other fields listed on the dialog. For example, the description, sample rate, bit-depth, etc. may change depending on the template that you select.

Description

This text box displays any information that was entered when the template was created.

Sample rate

The sample rate you choose directly affects the audio's quality. The higher the setting you choose the better the quality, but the larger the file size.

Bit-depth

The bit-depth affects the audio's quality like the sample rate. The higher the setting you choose the better the quality, but the larger the file size.
Channels
You may render your project to channel types: Stereo, Mono, Multiple Mono, and Multiple Stereo.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Renders all the project’s busses to a stereo file. The signal is saved to the respective right and left channels that you specified in the project. This may cause clipping in the rendered stereo file. You can compensate for the clipping by reducing each channel’s volume fader prior to rendering.</td>
</tr>
<tr>
<td>Mono</td>
<td>Renders the project so that both the right and left channels are summed to one mono signal. This may cause clipping in the mono file. You can compensate for clipping by reducing each channel’s volume fader prior to rendering.</td>
</tr>
<tr>
<td>Multiple Mono</td>
<td>Renders each of the project’s busses into two mono files: one left and one right. For example, if your project has two busses, Vegas Pro will render 4 mono files (two right and two left). This feature is useful if you are using applications that do not work with stereo files. Therefore, if you wanted to export tracks from Vegas Pro into one of these applications, you would need to export each channel as a mono file.</td>
</tr>
<tr>
<td>Multiple Stereo</td>
<td>Renders each of the project’s bus into a stereo file. For example, if your project has two busses, Vegas Pro will render 2 stereo files. Therefore, each bus in your project (and the tracks assigned to the bus) are rendered into a single stereo file.</td>
</tr>
</tbody>
</table>

Saving an *.aif rendering template
You may create your own *.aif templates, by doing the following:

1. In the Template field, enter a name.

2. From the drop-down lists on the Audio tab, choose the settings that you want the template to use.

3. Click the button to save the template.
   
   You may edit a previously saved template by choosing it from the drop-down list, making your setting changes, and clicking the button.

   **Note:** To delete a template, choose it from the drop-down list and click the button.
Using *.wav controls and templates

The *.wav file format is the audio standard for Windows operating systems. To access this format's controls, click the Custom button on the Save As dialog. The Custom Setting dialog appears. The Attributes drop-down list displays available choices dependent on the Format option that you choose.

Templates

You may use an included template by choosing one from the Template drop-down list. (These templates may also be accessed from the Save As dialog.)

The template's properties or parameters will be displayed in the other fields listed on the dialog. For example, the description, sample rate, bit-depth, etc. may change depending on the template that you select.

Description

This text box displays any information that was entered when the template was created.

Format

You may choose one of the rendering codecs available from this drop-down list.
Sample rate

The sample rate you choose directly affects the audio's quality. The higher the setting you choose the better the quality, but the larger the file size.

<table>
<thead>
<tr>
<th>Sample rate</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>44.100</td>
<td></td>
</tr>
<tr>
<td>48.000</td>
<td></td>
</tr>
<tr>
<td>88.200</td>
<td></td>
</tr>
<tr>
<td>96.000</td>
<td></td>
</tr>
</tbody>
</table>

Bit-depth

The bit-depth affects the audio's quality like the sample rate. The higher the setting you choose the better the quality, but the larger the file size.

<table>
<thead>
<tr>
<th>Bit-depth</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td></td>
</tr>
</tbody>
</table>

Channels

You may render your project to channel types: Stereo, Mono, Multiple Mono, and Multiple Stereo.

<table>
<thead>
<tr>
<th>Channels</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Renders all the project's busses to a stereo file. The signal is saved to the respective right and left channels that you specified in the project. This may cause clipping in the rendered stereo file. You can compensate for the clipping by reducing each channel's volume fader prior to rendering.</td>
</tr>
<tr>
<td>Mono</td>
<td>Renders the project so that both the right and left channels are summed to one mono signal. This may cause clipping in the mono file. You can compensate for clipping by reducing each channel's volume fader prior to rendering.</td>
</tr>
<tr>
<td>Multiple Mono</td>
<td>Renders each of the project's busses into two mono files: one left and one right. For example, if your project has two busses, Vegas Pro will render 4 mono files (two right and two left). This feature is useful if you are using applications that do not work with stereo files. Therefore, if you wanted to export tracks from Vegas Pro into one of these applications, you would need to export each channel as a mono file.</td>
</tr>
<tr>
<td>Multiple Stereo</td>
<td>Renders each of the project's bus into a stereo file. For example, if your project has two busses, Vegas Pro will render 2 stereo files. Therefore, each bus in your project (and the tracks assigned to the bus) are rendered into a single stereo file.</td>
</tr>
</tbody>
</table>
Saving a *.wav rendering template

You may create your own *.wav templates, by doing the following:

1. In the Template field, enter a name.

2. From the drop-down lists on the Audio tab, choose the settings that you want the template to use.

3. Click the button to save the template.

   You may edit a previously saved template by choosing it from the drop-down list, making your setting changes, and clicking the button.

   **Note:** To delete a template, choose it from the drop-down list and click the button.

Using *.mp3 controls and templates

Vegas Pro allows you to render up to 20 *.mp3 files without registering the optional plug-in. This feature gives you the opportunity to try the plug-in. After the 20th *.mp3 file is created, you need to purchase the plug-in to create more *.mp3 files. To access this format's controls, click the Custom button on the Save As dialog. The MPEG 1 Layer 3 Templates dialog appears.
Templates
You may use an included template by choosing one from the drop-down list. (These templates may also be accessed from the Save As dialog.)

<table>
<thead>
<tr>
<th>Template</th>
<th>Project Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>128 kHz</td>
<td>Mono</td>
</tr>
<tr>
<td>192 kHz</td>
<td>Mono</td>
</tr>
<tr>
<td>192 kHz</td>
<td>Stereo</td>
</tr>
<tr>
<td>128 kHz</td>
<td>Stereo</td>
</tr>
<tr>
<td>64 kHz</td>
<td>Mono</td>
</tr>
<tr>
<td>64 kHz</td>
<td>Stereo</td>
</tr>
<tr>
<td>16 kHz</td>
<td>Mono</td>
</tr>
<tr>
<td>16 kHz</td>
<td>Mono</td>
</tr>
</tbody>
</table>

Description
This text box displays any information that was entered when the template was created.

Saving an *.mp3 rendering template
You may create your own *.mp3 templates, by doing the following:
1. In Template field, enter a name.

2. Click the Settings button. The Sonic Foundry MP3 plug-in dialog will appear.

Note: If you have not registered the Sonic Foundry MP3 plug-in, Vegas Pro will launch a Registration wizard. You may follow the dialog’s instructions to purchase the plug-in from Sonic Foundry, or click the I would like to continue using the trial version radio button. The trial version is good for up to 20 *.mp3 file renderings.

3. On the Encode tab, choose a bit-rate from the drop-down list.
4. Click and drag the Quality slider and click the control check boxes that you want to use for the rendered *.mp3 file.

5. Click the ID3 Summary tab, to enter information about the file.

6. Click the OK button to return to the MPEG 1 Layer 3 Templates dialog.

7. Click the button to save the template.

   You may edit a previously saved template by choosing it from the drop-down list, making your setting changes, and clicking the button.

---

**Note:** To delete a template, choose it from the drop-down list and click the button.
Using *.wma controls and templates

Vegas Pro allows you to render your project to Microsoft *.wma files, which can be used for streaming or downloading via the Web. When you render to this format, Vegas Pro displays Microsoft's encoding wizard that carries you through the rendering (encoding) process.

Also, the *.wma format allows you to set up Redirector settings, which will appear on the Windows Media player. Click the Redirector button to display the ASF Redirector Setting File dialog.

Templates

You may use an included template by choosing one from the drop-down list. (These templates may also be accessed from the Save As dialog.)
Saving a *.wma rendering template

You may create your own *.wma templates, by doing the following:

1. On the Save As dialog, click the Custom button. The Edit Template dialog will appear.

2. Click the Custom button to start the Microsoft Encoding wizard.

3. In Template Name field, enter a name and then type a description (optional).

4. Click the Next button to set the bandwidth settings.

5. Click the Next button to set the Resample rate from the drop-down list.
6. Click the **Next** button to choose an audio format form the Format drop-down list (There is only one Audio codes available from the Audio drop-down list.)

7. Click the **Finish** button to save the template and return to the Edit Template dialog.

   You may edit a previously saved template by choosing it from the drop-down list, clicking the **Edit** button (starting the wizard again), and making your setting changes.

   **Note:** To delete a template, choose it from the drop-down list and click the **Delete** button.

---

**Using *.avi** controls and templates

The *.avi file format is the standard for video files on the Windows operating systems in which the Vegas Pro project's audio and video is rendered to one file. To access this format's controls, click the **Custom** button on the Save As dialog. The Custom Setting dialog appears and has two tabs: Audio and Video. The Attributes drop-down list displays available choices dependent on the Format option that you choose.

The following sections describe and display each tabs controls.

**Templates**

Vegas Pro does not include pre-saved templates. However, you may create and save your own. For more information, see Saving an *.avi rendering template on page 236.

After a template is save, you may select it from the drop-down list. The template's properties or parameters will be displayed in the other fields listed on both the Audio and Video tabs.

**Description**

This text box displays any information that was entered when the template was created.
**Format (Audio tab)**

You may choose one of the rendering codecs available from this drop-down list.

<table>
<thead>
<tr>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDV</td>
</tr>
<tr>
<td>DSD</td>
</tr>
<tr>
<td>SSM</td>
</tr>
<tr>
<td>SSM-0</td>
</tr>
<tr>
<td>044</td>
</tr>
<tr>
<td>042</td>
</tr>
<tr>
<td>DTS</td>
</tr>
<tr>
<td>DOL</td>
</tr>
<tr>
<td>M2I</td>
</tr>
<tr>
<td>LPCM</td>
</tr>
<tr>
<td>Vorbis</td>
</tr>
<tr>
<td>Vorbis:Native</td>
</tr>
<tr>
<td>Vorbis:Native: Fixed Mode Decodes</td>
</tr>
<tr>
<td>Vorbis:Native: Fixed Mode Decodes</td>
</tr>
<tr>
<td>Vorbis:Native: Fixed Mode Decodes</td>
</tr>
<tr>
<td>Vorbis:Native: Fixed Mode Decodes</td>
</tr>
<tr>
<td>Vorbis:Native: Fixed Mode Decodes</td>
</tr>
<tr>
<td>Vorbis:Native: Fixed Mode Decodes</td>
</tr>
<tr>
<td>Windows Media Audio V2</td>
</tr>
<tr>
<td>Windows Media Audio V2</td>
</tr>
</tbody>
</table>

**Sample rate (Audio tab)**

The sample rate you choose directly affects the audio's quality. The higher the setting you choose the better the quality, but the larger the file size.

<table>
<thead>
<tr>
<th>Sample rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>44.100</td>
</tr>
<tr>
<td>11.025</td>
</tr>
<tr>
<td>22.050</td>
</tr>
<tr>
<td>44.100</td>
</tr>
<tr>
<td>48.000</td>
</tr>
<tr>
<td>88.200</td>
</tr>
<tr>
<td>96.000</td>
</tr>
</tbody>
</table>

**Bit-depth (Audio tab)**

The bit-depth affects the audio's quality like the sample rate. The higher the setting you choose the better the quality, but the larger the file size.

<table>
<thead>
<tr>
<th>Bit-depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>255</td>
</tr>
<tr>
<td>255</td>
</tr>
</tbody>
</table>
Channels (Audio tab)

You may render your project to channel types: Stereo, Mono, Multiple Mono, and Multiple Stereo.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Renders all the project's busses to a stereo file. The signal is saved to the respective right and left channels that you specified in the project. This may cause clipping in the rendered stereo file. You can compensate for the clipping by reducing each channel's volume fader prior to rendering.</td>
</tr>
<tr>
<td>Mono</td>
<td>Renders the project so that both the right and left channels are summed to one mono signal. This may cause clipping in the mono file. You can compensate for clipping by reducing each channel's volume fader prior to rendering.</td>
</tr>
<tr>
<td>Multiple Mono</td>
<td>Renders each of the project's busses into two mono files: one left and one right. For example, if your project has two busses, Vegas Pro will render 4 mono files (two right and two left). This feature is useful if you are using applications that do not work with stereo files. Therefore, if you wanted to export tracks from Vegas Pro into one of these applications, you would need to export each channel as a mono file.</td>
</tr>
<tr>
<td>Multiple Stereo</td>
<td>Renders each of the project's busses into a stereo file. For example, if your project has two busses, Vegas Pro will render 2 stereo files. Therefore, each bus in your project (and the tracks assigned to the bus) are rendered into a single stereo file.</td>
</tr>
</tbody>
</table>

Change frame rate to: (Video tab)

This control allows you to have the video frame rate changed during the rendering process. You can select from a variety output methods to reduce the frame rate. By selecting one, you help to reduce the total data rate of the file, which can make playback easier on slower computers.
Re-size frames to: (Video tab)

This control allows you to have the video frames resized during the rendering process. The included choices on the drop-down list enable you to reduce the total data rate of the file, which can make playback easier on slower computers.

Compression (Video tab)

The Video tab has a Compression button that you may click to apply video compression codecs. When you click this button, the Video Compression dialog appears.

When you select one of the codecs, the dialog’s controls are enabled. For details about each codec’s controls and configuration, contact the manufacturer.

Interleave audio control (Video tab)

When enabled, this control allows you to specify how often the audio and video stream data is interleaved. Interleaving relates directly to how the data is saved in the file. For example, during the rendering process, the audio data is written in between the video data based on the frame setting that you specified.

Interleaving allows for optimal playback of the *.avi file.
Saving an *.avi rendering template

You may create your own *.avi templates, by doing the following:

1. In Template field, enter a name.

2. From the drop-down lists on the Audio tab, choose the settings that you want the template to use.

3. On the Video tab, choose the setting and compression values that you want the template to use.

4. Click the button to save the template.

   You may edit a previously saved template by choosing it from the drop-down list, making your setting changes, and clicking the button.

   Note: To delete a template, choose it from the drop-down list and click the button.

Using *.asf controls and templates

Vegas Pro allows you to render your project to Microsoft *.asf files, which can be used for streaming via the Web. When you render to this format, Vegas Pro displays Microsoft’s encoding wizard that carries you through the rendering (encoding) process.

Also, the *.asf format allows you to set up Redirector settings, which will appear on the Windows Media player. Click the Redirector button to display the ASF Redirector Setting File dialog.
Templates
You may use an included template by choosing one from the drop-down list. (These templates may also be accessed from the Save As dialog.)

Saving an *.asf rendering template
You may create your own *.asf templates, by doing the following:

1. On the Save As dialog, click the Custom button. The Edit Template dialog will appear.

2. Click the Custom button to start the Microsoft Encoding wizard.

3. In Template Name field, enter a name and then type a description (optional).
4. Click the **Next** button to choose a video Bit-rate setting.

5. Click the **Next** button to set the bandwidth settings.

6. Click the **Next** button to set Resample rate from the drop-down list.

7. Click the **Next** button to choose an audio codec, format and video codec from their respective drop-down lists.

8. Click the **Finish** button to save the template and return to the Edit Template dialog.

You may edit a previously saved template by choosing it from the drop-down list, clicking the **Edit** button (starting the wizard again), and making your setting changes.

**Note:** To delete a template, choose it from the drop-down list and click the **Delete** button.
Using *.rm controls and templates

Vegas Pro allows you to render your project to RealMedia *.rm files, which can be used for streaming via the Web. When you render to this format, Vegas Pro displays the Encoding Template Wizard that carries you through the rendering (encoding) process.

Also, the *.rm format allows you to set up Redirector settings, which will appear on the RealPlayer. Click the Redirector button to display the RealMedia Redirector File Setting dialog.

Templates

You may use an included template by choosing one from the drop-down list. (These templates may also be accessed from the Save As dialog.)
Saving an *.rm rendering template

You may create your own *.rm templates by clicking the Custom button on the Save As dialog. The Edit Template dialog will appear.

On the Edit Template dialog, click the Custom button to start the Encoding Template Wizard.

1. In Template Name field, enter a name and then type a description (optional).

2. Click the Next button to choose the RealMedia file type and target rate.

3. Click the Next button to set the bandwidth settings.
4. Click the **Next** button to choose the audio's type for encoding.

5. Click the **Next** button to choose a Resample rate from the drop-down list.

6. Click the **Next** button to choose a video type for encoding.

7. Click the **Next** button to select a video frame size.

8. Click the **Finish** button to save the template and return to the Edit Template dialog.

You may edit a previously saved template by choosing it from the drop-down list, clicking the **Edit** button (starting the wizard again), and making your setting changes.

**Note:** To delete a template, choose it from the drop-down list and click the **Delete** button.
Customizing Vegas Pro

Vegas Pro may be customized to your project needs and working preferences. You may change these settings at any time. You have complete control over your project. If you use the same settings for all of your projects, you may set Vegas Pro to use them as your default settings. Many of the settings depend on your equipment or studio setup. Vegas Pro can be set to work with the components that you prefer.

In this chapter, you will find information about functions that allow you to customize the appearance of Vegas Pro, set a project’s properties, and set the application’s preferences.

Dockable Vegas Pro windows

Vegas Pro has six dockable tool windows that you may use while working on a project. These windows may be accessed via the View menu or their shortcut keys.

<table>
<thead>
<tr>
<th>Window</th>
<th>Shortcut keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explorer</td>
<td>Alt+1</td>
<td>The Explorer window is similar to the Windows 9x and NT file management Explorer included with your operating system. Use the Vegas Pro Explorer window for selecting media files to place in your project (pg. 245).</td>
</tr>
<tr>
<td>Trimmer</td>
<td>Alt+2</td>
<td>The Trimmer window is a good place to edit an audio event. When an event is placed in the Trimmer window, you may take portions of the event and place them on separate tracks by dragging and dropping (pg. 120).</td>
</tr>
<tr>
<td>Mixer</td>
<td>Alt+3</td>
<td>The Mixer window gives you access to your project’s properties, bus assignments, output levels, and FX chains (pg. 24).</td>
</tr>
<tr>
<td>Edit Details</td>
<td>Alt+4</td>
<td>The Edit Details window provides an alternate and more precise means of working with your audio events (pg. 124).</td>
</tr>
<tr>
<td>Plug-ins</td>
<td>Alt+5</td>
<td>The Plug-in Explorer window allows you to create, organize, and rename the plug-ins compatible with Vegas Pro (pg. 196).</td>
</tr>
<tr>
<td>Video</td>
<td>Alt+6</td>
<td>This window displays a project’s video event during project editing and playback. If a video event is not a placed in the project, you will see ‘--No Video--’ in the center of this window (pg. 24).</td>
</tr>
</tbody>
</table>

When you display these windows, they will “float” on the Track View. You may let them “float,” move them around on the Track View, or place them in the Windows Docking Area.
Docking a window

The Window Docking Area allows you to keep frequently used windows available, but out of the way, while you are working with a project. The Window Docking Area can display all windows at the same time. As a result, each window will be relatively narrow depending on your monitor size. So, we recommend “dividing” this area into three regions: right, middle, and left. You “divide” the docking area by how you place these windows. However, you may “divide” the docking area any way that you prefer. It is strictly based on your work preferences.

To dock a window, do the following:

1. If the window is not already displayed, choose it from the View menu or press its shortcut keys (pg. 243). Otherwise, skip to step 2.

2. Click the window’s title bar and drag the window below the Track View. You control where the window will be placed by moving the window to the left or right.

3. When the window’s title bar disappears, release the mouse. The window is now docked.

Note: If you dock a window on top of another one, the newly docked window will appear on the top layer. The window “beneath” it displays a title tab, which you can click to bring it to the top layer or press the window’s shortcut keys to display it.
Using the Explorer window

The Explorer window works similarly to the Windows 9x and NT file management Explorer included with your operating system. Primarily, you will use the Explorer window to place media files into your projects. However, the Explorer window allows you to locate, preview, rename, and delete media files.

The Explorer window is a dockable window and can be customized to fit your needs and preferences.

![Diagram of Explorer window]

Select drive/folder name

Toolbar

Drive/folder Tree View pane

Window tabs

Selected drive/folder Contents List pane

Summary view:
This area displays information about the selected file.

Toolbar

- Selects and opens the folder or drive one level above the active folder.
- Displays any content changes in the active folder or drive if a file was added, renamed, or deleted.
- Creates a new folder within an active folder or drive.
- Removes a selected folder or media file.
- Adds the selected folder to your Favorites folder. The Favorites folder contains media files that you use most often.
- Plays the selected media file.
- Stops play back of the selected media file.
- When enabled, automatically plays a media file when it is selected.
- Displays Explorer viewing options.

245
Managing your media files

The Explorer window allows you to organize your media files by moving them to new folders, renaming, deleting, and playing back media files prior to placing them in your project. The Explorer window works similarly to the Windows 9x or NT Explorer that is included with your operating system. If you are familiar with this operating system utility, you will find the Vegas Pro Explorer window easy to use. If the Explorer window concept is new to you, following are instructions that help you discover how easy managing your media files can be.

Finding your media files

The Explorer window’s Tree View pane allows you to select the drive or folder and view its contents in the Contents List pane.

To select a drive or folder, do the following:

1. From the drop-down list, select the drive that you want to view.
   Or, select any drive or folder from the list that is already displaying in the Tree View pane.

2. Click the plus sign next to the drive or folder to display its contents. (The plus sign becomes a minus sign. Click the minus sign to hide the drive or folders contents.)

3. Click a folder from Tree View pane and the files in it will display in the Contents List pane.
Moving folders to different drives or other folders
You may move folders and their contents to different drives or place them in existing folders by doing the following:

1. Using the drop-down list, navigate to the drive and folder location of the folders that you want to move.
2. In the Tree View or Contents List pane, select the folder that you want to move by clicking it.

To select multiple folders, hold down either the Shift or Ctrl keys.
3. Drag the selected folder(s) to the desired folder within the Tree View or Contents List pane. If you want to move the folder(s) to a different drive, drag it to the desired drive in the Tree View pane.
4. Release the mouse and the folder(s) and its contents will be placed in the new location.

**Note:** If the folder contains media files that are being used in projects, Vegas Pro will prompt you to locate the media files when that project is opened again.

Moving media files to different folders
Within the Explorer window, you may move media files to different folders by doing the following:

1. Using the drop-down list, navigate to the drive and folder location of the media file that you want to move.
2. In the Contents List pane, select the file you want to move by clicking it.

To select multiple files or folders, hold down either the Shift or Ctrl keys.
3. Drag the selected file(s) to the desired folder in the Tree View pane.
4. Release the mouse and the media file(s) will be placed in the folder.

**Note:** If the media file you moved is being used in a project, Vegas Pro will prompt you to locate the media files when that project is opened again.
Creating a new media folder
You may create folders within the Explorer window to store media files or other folders by doing the following:

1. Navigate to the drive and folder location where you want to create the new folder.
2. Click the New ( ) button. A folder will appear in the Contents List pane.
3. Select the newly created folder and right-click to display a shortcut menu.
4. From the shortcut menu, choose Rename.
5. Type the name of the new folder and press the Enter key to save the name.

Once the new folder is created, you may begin moving media files to it or move it to a new location.

Renaming media files and folders
You may rename media files and folders that are not currently being used in an open project within the Explorer window. If you try to rename a media file or folder that is used in an open project, Vegas Pro will notify you of a sharing violation. Save and close the open project before renaming these project items.

To rename a media file or folder, do the following:
1. Select a media file or folder in the Tree View or Contents List pane.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Rename.
4. Type the new name for the media file or folder and press the Enter key to save the name.

**Note:** If the media file or folder that you renamed is being used in a project, Vegas Pro will prompt you to set the new path where the project's media file(s) reside.
Deleting media files and folders

You may delete media files and folders that are not currently being used in an open project within the Explorer window. If you try to delete a media file or folder that is used in an open project, Vegas Pro will notify you of a sharing violation. Save and close the open project before deleting these project items.

To delete a media file or folder, do the following:

1. Select a media file or folder in the Tree View or Contents List pane.
   
   To select multiple files, hold down either the Shift or Ctrl keys.

2. Click the Delete ( ) button. The Confirm Delete dialog will appear.
   
   Or, you may right-click on the selected media file or folder to display a shortcut menu. From the shortcut menu, choose Delete. The Confirm File Delete dialog will appear.

3. Click the Yes button to delete the media file or folder
   
   Click the No button to keep the media file or folder on your storage device.

4. Type the new name for the media file or folder and press the Enter key to save the name.

Note: If the media file or folder that you deleted is being used in a project, Vegas Pro will prompt you to set the new path where the project’s media file(s) reside.
Adding folders to Vegas Pro Favorites

Vegas Pro includes a Favorites folder found in the Tree View pane. You may add folders that contain media files to this folder. The Favorites folder allows you to quickly access frequently used media files and place them in your project.

To add folders to Vegas Pro Favorites, do the following:

1. Select a folder in the Tree View or Contents List pane.
   
   To select multiple folders, hold down either the Shift or Ctrl keys

2. Click the Add to Favorites ( ) button.
   
   Or, you may right-click on the selected folder to display a shortcut menu. From the shortcut menu, choose Add to Favorites.

   ![Image of Add to Favorites]

   The folder will appear “under” the Favorites folder in the Tree View pane.

Using the Explorer window Transport bar

The Explorer window contains a transport bar that allows you to listen to media audio files before you place them into your project. When you play back a media file, you may monitor its volume level on the preview bus that is located in the Mixer window. For more information, see Using the Mixer on page 169.

![Image of Transport Bar]

Previewing a media file

You may preview one file at a time from the Contents List pane of the Explorer window by doing the following:

1. Select the media file that you want to preview.

2. Click Play () button. The media file’s levels may be monitored on the preview bus.

3. Press the Stop () button to quit play back before the media file finishes playing.

4. Repeat steps 1-3 to preview other media files.
Using Auto Preview

The Auto Preview button allows you to set Vegas Pro to automatically preview media files when you select them in the Contents List pane. When the selected media file begins playback, you may monitor its volume level on the preview bus that is located in the Mixer window.

The Auto Preview button is a toggle feature, so it is either on or off all the time. Simply, click the button to turn it on or off.

Changing the Explorer window views

The Explorer window allows you to change the way the files and folders are displayed. You may toggle through the display options by clicking the View button or selecting a display option from the buttons sub-menu. Following are descriptions of each display option.

Tree View

Displays all the available drives and folders that you may select to locate media files.

Region View

This information appears below the Contents List pane. It displays the embedded regions, if any, that are contained in the selected media (*.wav) file. You may place a *.wav file's region directly on a track in your project. This option can save editing time because you do not need to place the entire media file, just the region(s) that you want.
Summary View
This information appears below the Contents List pane. It displays information about the selected media file.

Details
In the Contents List pane, the files display their size, date, and when it was last created or modified.

All Files
In the Contents List pane, all file types, including non-media files, in the selected folder are displayed.
Changing the Ruler settings

You may specify a time format that the Vegas Pro ruler displays. The ruler, located above the Track View, displays real-time in several different formats. The real-time format that you select affects how the ruler and Time window will display time units.

To change the ruler’s format, right-click on the ruler and select the desired time format from the shortcut menu. Or, from the Options menu, choose Ruler Format and select the desired time unit. You may also change ruler settings on the Project Properties dialog’s Ruler tab. For more information, see Using the Ruler properties tab on page 267.

Following are description for the different time units available in Vegas Pro.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>This option displays the Time Ruler at the project sample rate.</td>
</tr>
<tr>
<td>Time</td>
<td>This option displays the Time Ruler in hours:minutes:seconds:milliseconds.</td>
</tr>
<tr>
<td>Seconds</td>
<td>This option displays the Time Ruler in seconds.</td>
</tr>
<tr>
<td>Time &amp; Frames</td>
<td>This option displays the Time Ruler in hours:minutes:seconds:frames. The frame rate is 15 frames per second.</td>
</tr>
<tr>
<td>Absolute Frames</td>
<td>This option displays the Time Ruler in total frames from the beginning of the project. The frame rate is 15 frames per second.</td>
</tr>
<tr>
<td>Measures &amp; Beats</td>
<td>This option displays the Time Ruler in musical Measures &amp; Beats based on the ruler properties.</td>
</tr>
<tr>
<td>SMPTE Drop (29.97 fps)</td>
<td>This option displays the Time Ruler in hours:minutes:seconds:frames. The frame rate is 29.97 frames per second with dropped frames.</td>
</tr>
<tr>
<td>SMPTE Non-Drop (29.97 fps)</td>
<td>This option displays the Time Ruler in hours:minutes:seconds:frames. The frame rate is 29.97 frames per second.</td>
</tr>
<tr>
<td>SMPTE Non-Drop (30 fps)</td>
<td>This option displays the Time Ruler in hours:minutes:seconds:frames. The frame rate is 30 frames per second.</td>
</tr>
<tr>
<td>SMPTE EBU (25 fps)</td>
<td>This option displays the Time Ruler in hours:minutes:seconds:frames. The frame rate is 25 frames per second.</td>
</tr>
<tr>
<td>SMPTE Film Sync (24 fps)</td>
<td>This option displays the Time Ruler in hours:minutes:seconds:frames. The frame rate is 24 frames per second.</td>
</tr>
<tr>
<td>Feet and Frames 16mm (40 fps)</td>
<td>This option displays the Time Ruler in 16mm feet with 40 frames per foot.</td>
</tr>
<tr>
<td>Feet and Frames 35mm (16 fps)</td>
<td>This option displays the Time Ruler in 35mm feet with 16 frames per foot.</td>
</tr>
</tbody>
</table>
Using Edit Ruler Offset

You may set the ruler’s time offset at the cursor’s timeline position by doing the following:

1. Position the cursor to the desired location along the timeline.

2. On the ruler, right-click to display a shortcut menu.

3. From the shortcut menu, choose Edit Ruler Offset.

4. Entering a time value using the number keys.

5. Press the Enter key to set the ruler’s time. The value that you enter at the cursor’s position will affect the entire ruler.

Grid spacing

Vegas Pro allows you to specify how your project’s Track View is equally divided. You may set the grid spacing in time, frame, measure, or note units. You may also set the grid to divide the Track View based on the ruler’s time format. The grid appears across all track in your project and the grid’s lines can be used as snap points. For more information, see Snapping to grid lines on page 94.

To change the grid spacing, do the following:

1. From the Options menu, choose to Grid Spacing. A sub-menu will appear.

2. From the sub-menu, choose the desired time unit. The grid spacing changes to reflect your selection.

Note: In some cases, the grid lines and the Ruler will not “match.” This is because they are two independent functions.
Working with the Toolbar

Vegas Pro is preset to display the Toolbar below the Menu bar. However, you may move, resize, hide, and customize the Toolbar to suit your preferences. The setting that you apply to the Toolbar will remain set until you change them again.

Moving the Toolbar

You may move the Toolbar and have it “float” anywhere on the Vegas Pro workspace. The Toolbar may then be returned to its preset position, below the Menu bar, where it will “dock” into place.

To move the Toolbar from its preset location, do the following:

1. Place the mouse pointer on the move handle located on the left side of the Toolbar.

2. Click and drag the Toolbar to the desired location. Notice that the Toolbar now has a title bar.

3. Release the mouse to drop the Toolbar on the Vegas Pro workspace.

**Note:** To return the Toolbar to its preset position, simply drag it up to the Menu bar and release the mouse. The Toolbar will automatically dock in position.
Resizing the Toolbar

Vegas Pro allows you to resize the Toolbar after it has been moved away from the original docked position and is “floating” on the interface.

To resize the Toolbar, do the following:
1. Click and drag the Toolbar’s frame in a horizontal or vertical direction.
2. Release the mouse when the Toolbar is at the preferred size.

Hiding and displaying the Toolbar

You may hide the Toolbar to create more workspace or if you prefer to use the Vegas Pro shortcut keys for editing and arranging. For more information, see Keyboard command reference on page 25. After the Toolbar is hidden, you may display it again where it will appear in its preset position, below the Menu bar.

Hiding the Toolbar

There are two ways to hide the Toolbar depending on whether it is “floating” or not.

• If the Toolbar is docked or “floating,” choose Toolbar from the View menu. The check mark, next to the command, is removed and the Toolbar disappears. The Toolbar will remain hidden until you display it again.

• If the Toolbar is “floating,” you may simply click on the close button in the upper right hand corner of the Toolbar.

Displaying the Toolbar

From the View menu, choose Toolbar. A check mark will appear next to the command and the Toolbar will appear in its preset position. The Toolbar will remain visible until you hide it again.
Reordering the Toolbar buttons

Vegas Pro allows you to easily change the Toolbar's button order on-the-fly or via the Customize Toolbar dialog to suit your work preferences.

Reordering buttons on-the-fly
1. Press and hold the Shift key.
2. Click and drag the button that you want to move to the new location on the Toolbar. You will see a hand icon (اختبار) within an outline of the button that you are moving.
3. Release the mouse to drop the button in its new location.

Note: If you drag and drop the button “off” the Toolbar, the button will be removed.
4. Repeat steps 1-3 to reorder more Toolbar buttons.

Reordering buttons via the Customize Toolbar dialog
The Customize Toolbar dialog allows you to control the order and functionality available from the Toolbar. You may return the Toolbar to its default settings by pressing the Reset button on the Customize Toolbar dialog.

To reorder the Toolbar’s buttons from this dialog, do the following:
1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog will appear.
2. On the Current toolbar buttons pane, select the button you want to move and click on the Move Up and Move Down buttons.
3. Repeat step 2 to reorder more buttons.
4. Close the Close button to save the changes and close the Customize Toolbar dialog.
Adding buttons to the Toolbar

Vegas Pro includes a series of function buttons that you may add to the Toolbar. These buttons are listed in the Customize Toolbar dialog. You may also add separators on the Toolbar to organize the buttons to your preferences.

You may return the Toolbar to its default settings by pressing the Reset button on the Customize Toolbar dialog.

To add a button to the Toolbar, do the following:

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog will appear.

   ![Customize Toolbar dialog](image)

   **Available toolbar buttons**

   Select the button you want to add and select it. The buttons' icons are what will be displayed on the Toolbar.

2. On the Available toolbar buttons pane, use the scroll bars to locate the button that you want to add and select it.

   **Current toolbar buttons**

   Select the button that you want the newly added button to proceed in order.

   For example, if you want to add the Trim/Crop button and want it to precede the Cut button, select the Trim/Crop button on the Current toolbar buttons pane.

   ![Customize Toolbar dialog](image)

   The Trim/Crop button, in this example, will be added “above” and precede the Cut button on the Toolbar.
4. Click the **Add** button. The new button will be added “above” the selected button on the Current toolbar buttons pane.

**Note:** You may also double-click a button to add it to the Toolbar.

5. Repeat steps 2-4 to add more buttons to the Toolbar.

6. Click the **Close** button to save the Toolbar settings and close the Customize Toolbar dialog.

**Removing buttons from the Toolbar**

You may remove buttons and separators from the Toolbar. If you have added buttons to the Toolbar, removing unused or unwanted buttons allows you to maximize the Toolbar’s space for buttons that you may want. You may remove Toolbar buttons in one of two ways either on-the-fly or via the Customize Toolbar dialog.

**Removing buttons on-the-fly**

1. Press and hold the **Shift** key.

2. Click and drag the button that you want to remove “off” the Toolbar. You will see a hand icon (\(\text{\textbullet}\)) within an outline of the button that you are removing.

3. Release the mouse to remove the button.

4. Repeat steps 1-3 to move remove more Toolbar buttons.
Removing buttons via the Customize Toolbar dialog
You may return the Toolbar to its default settings by pressing the Reset button on the Customize Toolbar dialog.

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog will appear.

2. On the Current toolbar buttons pane, select the button that you want to remove.

3. Click the Remove button. The button will be removed from the Current toolbar buttons pane and not appear on the Toolbar.

   **Note:** You may also double click on the button to remove it.

4. Repeat steps 2-3 to remove more buttons from the Toolbar.

5. Click the Close button to save the Toolbar settings and exit the Customize Toolbar dialog.
Using the Time Display window

The Time Display window reflects the cursor's position on the timeline and the end point of a time selection. You may change the Time Display window's time settings, including what time the window displays, and color usage.

The Time Display window may be moved from its docked position, above the Track List, to "float" on the Vegas Pro workspace. In addition, the Time Display window may be docked in the Windows Docking Area. For more information, see Docking a window on page 244.

Changing the Time Display window’s settings

The Time Display window always reflects the ruler settings that are selected. You may change the ruler settings via the Time Display window or vice versa. For more information, see Changing the Ruler settings on page 253.

To change the time settings, do the following:

1. Place the mouse pointer on the Time Display window.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Time Format to display a sub-menu.
4. From the sub-menu, choose the desired time format.

Both the Time window and ruler will display the chosen time format.
Changing the Time Displays colors

You may change the background and text color used by the Time Display.

To change the color usage, do the following:

1. Right-click on the Time Display to display the shortcut menu.
2. From the shortcut menu, choose either Custom Text color or Custom Background color. The Color dialog will appear.
3. On the Color dialog, choose the color setting that you want.
4. Click the OK button to set the text or background color and close the Color dialog.

   Or, click the Cancel button to keep the existing color settings and close the Color dialog.

**Note:** To return the Time Display’s text or background color to its default settings, select either Default Text color or Default Background color from the shortcut menu.
Setting the Time Display to monitor MIDI time code

The Time Display window can be setup to monitor the status of incoming or out-going MIDI time code. Vegas Pro can monitor MIDI time code being generated from an external device and monitor MIDI time code and MIDI clock information that is being generated. From within Vegas Pro, the Time Display settings work in conjunction with your project's properties and MIDI setup options. For more information, see Using the Sync preferences tab on page 275.

To change the Time Display to monitor MIDI input or output, do the following:

1. Place the mouse pointer on the Time Display window.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose the type of MIDI monitoring that Vegas Pro will display.

Once you have made your selection, the Time Display window displays both the MIDI code being input or output and a status message.

Working with project properties

Vegas Pro has many settings that you can use with a project. Some settings are simply informational details about the project, while others control how Vegas Pro will work and handle your project and its output. If you have multiple projects, Vegas Pro stores the settings used for each project, so you do not need to alter settings when you open a different project: saving you time.

The Project Properties dialog may be accessed three ways:

- From the File menu, choose Properties
- Click the Project Properties toolbar button
- Press the `Alt + Enter` shortcut keys.

The Project Properties dialog has four tabs: Summary, Audio, Video, and Ruler. To display a properties page, click the desired tab. Following is an overview of each tab and its setting options.
Using the Summary properties tab

This tab allows you to enter information about the project. These tab fields may be left blank or if information exists you may change it at any time.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter the name or title of the open project.</td>
</tr>
<tr>
<td>Artist</td>
<td>Enter the name of the narrator, band, or artist(s) being recorded into the project.</td>
</tr>
<tr>
<td>Engineer</td>
<td>Enter the name(s) of the people who mixed and edited the project.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Enter the date and ownership rights of the project.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter information that identifies and describes the project.</td>
</tr>
<tr>
<td>Check box</td>
<td>Click the \texttt{Start all new projects with these settings} check box if your projects' requirements do not change or you want consistent settings for future projects.</td>
</tr>
</tbody>
</table>

The following list describes how to work with the Summary tab:

- To enter information, click inside a field and type.
- Press the \texttt{Tab} key to move to a different field.
- Click the \texttt{Apply} button to save information, but keep the Project Properties dialog open.
- Click the \texttt{OK} button or press the \texttt{Enter} key to save the information and close the Project Properties dialog.
- Click the \texttt{Cancel} button to keep original information, if any existed, and close the Project Properties dialog.
Using the Audio properties tab

This tab allows you to set different characteristics the project will use to handle the audio. Since audio requires a lot of disk space, this page displays the available drive space where Vegas Pro stores recorded audio.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of stereo busses</td>
<td>Enter the number of stereo busses that you want in your project. You may add up to 26 busses. The busses appear in the Mixer.</td>
</tr>
<tr>
<td>Sample rate</td>
<td>Choose a sample rate from the drop-down list or enter your own rate. The sample rate range is 2,000 Hz to 96,000 Hz. Higher sample rates result in better quality sound, but also means larger audio files.</td>
</tr>
<tr>
<td>Bit-depth</td>
<td>Choose a bit-depth from the drop-down list. A higher bit-depth results in better quality sound, but also means larger audio files.</td>
</tr>
<tr>
<td>Recorded files folder</td>
<td>Displays the path where recorded audio is stored. The Browse button allows you to select a new location to store recordings.</td>
</tr>
<tr>
<td>Free storage space in selected folder</td>
<td>Displays the available disk space where recorded audio is stored.</td>
</tr>
<tr>
<td>Check box</td>
<td>Click the Start all new projects with these settings check box if your projects’ requirements do not change or you want consistent settings for future projects.</td>
</tr>
</tbody>
</table>

The following list describes how to work with the Audio tab:

- To enter information, click inside a field and type.
- Press the Tab key to move to a different field.
- Click the Apply button to save information, but keep the Project Properties dialog open.
- Click the OK button or press the Enter key to save the information and close the Project Properties dialog.
- Click the Cancel button to keep original settings and close the Project Properties dialog.
Using the Video properties tab

This tab allows you to set different characteristics the project will use to handle the video. Also, this tab displays information about the video contained in your project.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override active video file</td>
<td>Select this option to use a different frame rate than what is saved with the video in your project.</td>
</tr>
<tr>
<td>Reference frame rate (fps)</td>
<td>Enter or select the frame rate Vegas Pro will use for the video during playback.</td>
</tr>
<tr>
<td>Active video file</td>
<td>Displays the reference path of the video contained in your project.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Displays the properties of the video event in your project. Each property is defined below.</td>
</tr>
<tr>
<td>Frame size</td>
<td>The video's frame dimensions and color depth.</td>
</tr>
<tr>
<td>Length</td>
<td>The video's total number of frames.</td>
</tr>
<tr>
<td>Frame rate</td>
<td>The video's number of frames displayed per second.</td>
</tr>
<tr>
<td>Data rate</td>
<td>The video's transmission rate in bits per second.</td>
</tr>
<tr>
<td>Compression</td>
<td>The codec that has been applied to the video.</td>
</tr>
</tbody>
</table>

The following list describes how to work with the Video tab:

- Click the **Override active video frame rate** check box and enter a different frame rate.
- Click the **Apply** button to save information, but keep the Project Properties dialog open.
- Click the **OK** button or press the **Enter** key to save the information and close the Project Properties dialog.
- Click the **Cancel** button to keep original settings and close the Project Properties dialog.
Using the Ruler properties tab

This tab allows you to set ruler settings used in your project. You may also change ruler settings on the Tack View. For more information, see Changing the Ruler settings on page 253.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler time format</td>
<td>Choose a ruler time format from the drop-down list.</td>
</tr>
<tr>
<td>Ruler start time</td>
<td>Enter a value that the ruler will use at the beginning of your project. This feature is useful for synchronization purposes.</td>
</tr>
<tr>
<td>Beats per minute (tempo)</td>
<td>Enter the desired number of beats per minute for the project.</td>
</tr>
<tr>
<td>Beats per measure</td>
<td>Enter the desired number of beats to occur per measure for the project.</td>
</tr>
<tr>
<td>Note that gets one beat</td>
<td>The value entered will determine the time signature used by the ruler when its format is set to Measures and Beats. For example, if the entered value is 4, then a quarter note gets one beat.</td>
</tr>
<tr>
<td>Check box</td>
<td>Click the Start all new projects with these settings checkbox if your projects' requirements do not change or you want consistent settings for future projects.</td>
</tr>
</tbody>
</table>

The following list describes how to work with the Ruler page:

- To enter information, click inside a field and type.
- Click the Apply button to save information, but keep the Project Properties dialog open.
- Click the OK button or press the Enter key to save the information and close the Project Properties dialog.
- Click the Cancel button to keep original settings and close the Project Properties dialog.
Using Vegas Pro preferences

The preference options are different from project properties. The distinction to remember is that Project properties are unique to each project, while preferences affect and control how Vegas Pro works as an application. Adjusting preferences allow you to set Vegas Pro to optimally function with your equipment and process audio in a variety of ways. Some of these options you will probably set up one time, while others may be adjusted on a project basis.

Any changes that you make to the preferences, will remain set until you change them again or reset Vegas Pro to use its default presets.

Viewing the Preferences dialog

You may access the Preferences dialog by choosing Preferences from the Options menu. This dialog contains four tabbed pages: General, Routing, Audio, and Sync.

The following sections explain the preference settings on each tab.
Using the General preferences tab

The General tab contains toggle check boxes. These check boxes control whether specific feature are used with Vegas Pro. A feature is enabled when a check mark appears in the check box. Simply click in a feature's check box to turn it on or off. The feature will remain on or off until you change its toggle setting. The following table describes each toggle and how it affects Vegas Pro.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically open last project on startup</td>
<td>When enabled, Vegas Pro will open the most recently used project if Vegas Pro was exited with the project still open.</td>
</tr>
<tr>
<td>Show logo splash screen on startup</td>
<td>When enabled, the Vegas Pro logo will appear when you start the program.</td>
</tr>
<tr>
<td>Show a Tip of the Day on startup</td>
<td>When enabled, a tip for using Vegas Pro will appear on each startup.</td>
</tr>
<tr>
<td>Show active take name in events</td>
<td>When enabled, each event that you place in your project will have its active take name displayed on it.</td>
</tr>
<tr>
<td>Draw waveforms in events</td>
<td>When enabled, each event in your project will graphically display the audio's waveform.</td>
</tr>
<tr>
<td>Animate video ruler</td>
<td>When enabled, video on the video ruler will change as the cursor travels along the timeline.</td>
</tr>
<tr>
<td>Number video frames</td>
<td>When enabled, video on the video ruler will display each frame's number.</td>
</tr>
<tr>
<td>Prompt to keep files after recording</td>
<td>When enabled, Vegas Pro will prompt you to delete or keep audio after it has been recorded.</td>
</tr>
<tr>
<td>Create Undos for FX parameter changes</td>
<td>When enabled, allows you to undo any changes made to Assignable FX in your project.</td>
</tr>
<tr>
<td>Recently used project list</td>
<td>When enabled, the Vegas Pro File menu will display this setting's number of last used project files.</td>
</tr>
<tr>
<td>Always prompt to save new files with Scott chunk</td>
<td>When enabled, Vegas Pro will display the Scott Studios Information dialog when you save a new file or click the Save As button. This options allows you to embed and Scott Studio command markers that you placed in your project (pg. 86)</td>
</tr>
<tr>
<td>Always launch Send after saving Scott files</td>
<td>When enabled, Vegas Pro will start the Scott Studios Send application after you have saved a file that contains Scott Studios data. The Send application allows you to send the newly created file to several different network locations.</td>
</tr>
<tr>
<td>Choose Language</td>
<td>Allows you to set Vegas Pro to your language preference.</td>
</tr>
</tbody>
</table>

The following list describes how to work with the General tab:

- To enable or disable a feature, click in its check box.
- Click the Default All button to return the General tab to its default settings.
- Click the Apply button to save information, but keep the Preferences dialog open.
- Click the OK button or press the Enter key to save the information and close the Preferences dialog.
- Click the Cancel button to keep original settings and close the Preferences dialog.
Using the Routing preferences tab

The Routing tab allows you to configure Vegas Pro to the equipment that is connected to your computer. When you installed Vegas Pro, it automatically determined the hardware available for output on your computer. These options are available on the Routing tab.

In the table on this tab, you will see virtual bus designations that you may add to a project. For more information, see Using the Audio properties tab on page 265. Each bus may be routed to a specific output device of your choosing. You may notice that some of the busses are grayed out because they have not been added to your project yet. However, you may still configure the busses not currently in use, so they will be ready when you add them later. You can add busses to your project using the Project Properties Audio tab. For more information, see Using the Audio properties tab on page 265.

To route busses to hardware, do the following:

1. Click the **Use a Custom Routing** radio button.

   ![Routing Preferences](image)

   **Note:** When the **Always Use Sound Mapper** radio button is selected, you cannot assign the busses to different hardware devices. All busses will use the hardware that is assigned to the Microsoft Sound Mapper. To view this information, access the Multimedia control panel on your computer.
2. In the table, click the radio button in the output device's row and in the bus's column to assign a bus to a specific output device.

3. Repeat step 2 to assign more busses to output devices.

4. From the Default recording device drop-down list, select a device used when recording.

The following list describes how to work with the Routing tab:

- Click the Default All button to return the Routing tab to its default settings.
- Click the Apply button to save information, but keep the Preferences dialog open.
- Click the OK button or press the Enter key to save the information and close the Preferences dialog.
- Click the Cancel button to keep original settings and close the Preferences dialog.
Using the Audio preferences tab

The Audio tab allows you to set preferences to optimize how Vegas Pro uses your computer's components efficiently to handle the resource-intensive audio that you are using in your projects. The following table briefly describes each preference. More details of each preference is discussed later in this section.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playback Buffering (seconds)</td>
<td>Sets the amount of memory Vegas Pro uses during project playback.</td>
</tr>
<tr>
<td>Automatically Fade Edit Edges (ms)</td>
<td>Sets the fade length of a split or resized event.</td>
</tr>
<tr>
<td>Normalize Peak Level (dB)</td>
<td>Sets the maximum level that Vegas Pro will use when normalizing an event.</td>
</tr>
<tr>
<td>Location of Preferred Audio Editor</td>
<td>Displays the path of the audio editor that you can start directly from Vegas Pro to perform destructive edits to audio.</td>
</tr>
</tbody>
</table>

The following list describes how to work with the Routing tab:

- Click the **Browse** button to change the sound editor program. *For more information, see [Setting up the sound editor program](#) on page 90.*
- Click the **Advanced** button to set other Audio preferences. *For more information, see [Setting advanced audio preferences](#) on page 274.*
- Click the **Default All** button to return the Audio tab to its default settings.
- Click the **Apply** button to save information, but keep the Preferences dialog open.
- Click the **OK** button or press the **Enter** key to save the information and close the Preferences dialog.
- Click the **Cancel** button to keep original settings and close the Preferences dialog.

Adjusting the Playback Buffering slider

You can specify how much memory is used by Vegas Pro when playing back your project. This preference is useful but must be carefully adjusted. If you set the buffer size too high, you may experience gapping during playback.

Conversely, if you set the buffer size too low, you may experience gapping as well because Vegas Pro has too little memory to work with during playback.

The Playback Buffer slider needs to be set in such away to balance RAM usage and playback buffering. The rule is to set this slider as low as possible without introducing gapping. Following is a procedure to help you achieve the proper balance between RAM usage and playback buffering.
To adjust the slider to avoid gapping during play back, do the following:

1. Open a project that has multiple events.
2. On the Audio preferences tab, click the Playback Buffer (seconds) slider and move it to .25.

![Playback buffer slider](image)

3. Start playing back the project.
4. If the playback still gapping, increase the Playback Buffer (seconds) slider slightly.

As you increase the buffer size, the RAM meter at the bottom of Vegas Pro will indicate more RAM is being used.

5. Repeat steps 3-4 until gapping ceases.

If you continue to experience gapping and the RAM meter begins to display in yellow or red, you are experiencing gapping due to lack of RAM. You can try the following to control the gapping within Vegas Pro:

- Decrease the number of events you are trying to play back. This may mean muting tracks or soloing a couple of tracks. RAM is mostly affected by the number of unique events that are playing back simultaneously.
- Use the Mix to New Track feature to combine all the events into one event. For more information, see Mixing multiple tracks to a single track on page 167.

If you are still experiencing gapping, you may need to add RAM to your computer. Vegas Pro only requires a minimum of 32 MB. However, we recommend 128 MB of RAM to get optimum performance.

Adjusting the fade length for editing events

When you place an event in your project, you may resize the event by moving its edges. For example, you may place an event that is 10 second in length but resized or split it to play back only 5 seconds. However, the 5 seconds that you “omitted” for playback are still available.

![Fade settings](image)

This control allows you to set Vegas Pro to automatically fade events at their edges where you have “omitted” audio information. You can specify, in milliseconds, the length of the fade. The fade affects transitions between event edges so that “popping” is not introduced during playback.
Setting the Normalize peak level

When you want to normalize an event in your project, you can control the maximum peak Vegas Pro will use when recalculating the event’s waveform.

This control allows you to specify the maximum decibel level used when normalizing an event. For more information, see Normalizing an event on page 111.

Setting advanced audio preferences

From the Audio preferences tab, you may access advanced settings by clicking the Advanced button. The Advanced Audio Preferences dialog will appear and display all the audio devices that are installed on your computer.

If you select one of these devices from the list, you may set the controls that Vegas Pro will use with the device. Each device may be set up independently of the other devices. Following are descriptions of each control.

Interpolate position

During project playback, you may notice the cursor position is different than what you are hearing. This problem stems from inaccuracies in some audio devices.

Click this control’s check box and Vegas Pro will attempt to compensate for the inaccuracies by interpolating the cursor’s correct position during playback or recording.
Position bias
The position bias control gives you additional cursor control when it is inaccurately displayed during project playback and recording.

![Position bias control](image)

If you have enabled the Interpolate position control and are still experiencing cursor position inaccuracies, move the Position bias control forward or backward to compensate for the inaccuracies of the audio device.

Do not pre-roll buffers before starting playback
When this option is not checked (disabled), Vegas Pro will begin storing (buffering) project audio information prior to playback. This storing is very fast and unnoticeable in most cases. However, some audio devices "stutter" when you begin playback as a result of the buffering process. If your audio stutters when you start playback, click this check box to prevent Vegas Pro from buffering audio information prior to playback.

![Buffering audio](image)

Using the Sync. preferences tab
The Sync. tab allows you to specify how Vegas Pro will synchronize MIDI Time Code (MTC) to other software applications and hardware devices. Vegas Pro can also chase to MTC from an input device, which you may select on this tab. The following table briefly describes each preference. More details of each preference is discussed later in this section.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate MIDI Time Code</td>
<td>Select the output device and frame rate that Vegas Pro will use when generating MIDI time code.</td>
</tr>
<tr>
<td>Generate MIDI Clock settings</td>
<td>Select the output device that Vegas Pro will use when generating MIDI Clock information. This device may be set to the same one that you selected for Generate MTC.</td>
</tr>
<tr>
<td>Chase to MIDI Time Code</td>
<td>Select the input software or device and frame rate that Vegas Pro will use when chasing MTC.</td>
</tr>
</tbody>
</table>
The following list describes how to work with the Sync. tab:

- Click the Advanced button to set other Sync. preferences.
- Click the Default All button to return the Sync. tab to its default settings.
- Click the Apply button to save information, but keep the Preferences dialog open.
- Click the OK button or press the [Enter] key to save the information and close the Preferences dialog.
- Click the Cancel button to keep original settings and close the Preferences dialog.

Setting advanced Sync. preferences

From the Sync. preferences tab, you may access advanced settings by clicking the Advanced button. The Advanced Sync. Preferences dialog will appear and display three tabs for MTC input, MTC output, and MIDI Clock Output. The following sections display the selected tab followed by definitions of its controls.

MTC input

This tab contains controls for MTC input. It is displayed only if a device is selected for MTC input on the Sync. tab.

The following list describes how to work with the MTC Input tab:

- Click the Apply button to save information, but keep the Advanced Preferences dialog open.
- Click the OK button or press the [Enter] key to save the information and close the Advanced Preferences dialog and return to the Sync. tab.
- Click the Cancel button to keep original settings and return to the Sync. tab.
When this option is selected, Vegas Pro will not chase its playback speed to the incoming MTC data. Instead, Vegas Pro will trigger at the appropriate time. There are two situations when you will want to use this option.

- If your computer does not have the speed required to accurately chase time code. This method is best used for shorter periods of time. We recommend not using this feature for long periods of time because Vegas Pro may fall out of sync.
- If your sound card has an external “Word Clock” input, this clock source will keep your digital signals locked together and eliminate the need for Vegas Pro to chase.

When Free-wheel for time code loss is selected, Vegas Pro will continue to play for a specified period of time without chasing if time code is lost for some reason. Enabling this option can compensate for infrequent losses in time code monitoring. If losses in time code are frequent, troubleshooting should be done on your hardware to find the cause of the problem.

The Free-wheel slack time field specifies the amount of time that time code can be lost before the Free-wheel playback time starts. A longer time is more tolerant of loses in the incoming time code.

The Free-wheel playback time field specifies the amount of time that Vegas Pro will play back after the Free-wheel slack time has been exceeded.

The Synchronization delay time field specifies the amount of time required for Vegas Pro to synchronize itself to incoming time code. On slower computers this time should be set to around two seconds. On faster computers, it may be set lower. However, setting this value too low can sometimes result in audible pitch shifting at the start of playback.
MTC Output
This tab contains controls for MTC output. It is displayed only if a device is selected for MTC input on the Sync. tab.

The following list describes how to work with the MTC Output tab:

- Click the **Apply** button to save information, but keep the Advanced Preferences dialog open.
- Click the **OK** button or press the **Enter** key to save the information and close the Advanced Preferences dialog and return to the Sync. tab.
- Click the **Cancel** button to keep original settings and return to the Sync. tab.

When the **Use internal timer for MTC generation** check box is enabled, the MIDI Time Code that Vegas Pro generates will be based off of your computer’s Central Processing Unit (CPU) clock. Otherwise, Vegas Pro will generate MTC based on the sound card’s clock.

The **Internal timer resolution** field allows you to control MTC resolution: higher values indicate lower resolution and vice versa.
When the Sync. tab’s Generate MIDI Time Code is used, the Full-frame message generation radio button list specifies when Vegas Pro will send full-frame time code messages.

Full-frame messages are used by some external audio synchronizers to seek a proper location prior to synchronization. For example, tape-based recorders benefit from seeking to full-frame messages because of the time required to move the transport to the proper location. However, full-frame messages are ignored by some devices and may actually cause unexpected behavior in other devices. Check your hardware documentation to find out if it supports full-frame messages.

**MIDI Clock Output**

This tab contains controls for MIDI Clock output. It is only displayed if a device is selected for MIDI Clock output on the Sync. tab.

The following list describes how to work with the MIDI Clock Output tab:

- Click the **Apply** button to save information, but keep the Advanced Preferences dialog open.
- Click the **OK** button or press the Enter key to save the information and close the Advanced Preferences dialog and return to the Sync. tab.
- Click the **Cancel** button to keep original settings and return to the Sync. tab.

When Sent Start instead of Continue when beginning playback option is checked, Vegas Pro will send a **Start** command rather than a **Continue** command when Generate MIDI Clock is enabled on the Sync. tab. Normally, Vegas Pro will send a **Continue** command to allow the chasing device to start at a specific time. However, some older MIDI sequencers do not support the **Continue** command and must start from the beginning every time.
When the **Use internal timer for MIDI Code generation** option is checked, the MIDI Clock that Vegas Pro generates will be based on your computer's Central Processing Unit (CPU) clock. Otherwise, Vegas Pro generate MIDI Code based on the sound card’s clock.

When the **Always send MIDI Clock** option is checked, Vegas Pro will send MIDI Clock information when **Generate MIDI Clock** is enabled on the Sync. tab. Some applications and devices “listen” for MIDI Clock information, even when the master application is not playing. This “listening” allows the applications and devices to synchronize faster. However, some applications and devices may not support this Vegas Pro feature. If your MIDI Clock slave device does not support this feature, we recommend that you disable this feature’s control.

**Song Position Pointer generation**

The **Song Position Pointer generation** radio button list specifies when Vegas Pro will send **Song Position Pointer** messages when **Generate MIDI Clock** is enabled on the Sync. tab. **Song Position Pointer** messages are used by MIDI applications and devices to seek to a proper location prior to starting the synchronization process.
Troubleshooting

Why are some of my DirectX plug-ins not working correctly?

Vegas Pro is a non-destructive time-based editor. As a result, there are certain types of DirectX Plug-ins that perform poorly in Vegas Pro as Assignable FX or Bus FX. These types of plug-ins are roughly classified as any plug-in that outputs a different amount of time than what goes in. This includes all plug-ins like time compress/expand, gapper/snipper and pitch shift without preserving duration. However, these types of FX plug-ins may perform suitably as Bus FX, but only if one bus is used in the project.

In addition, plug-ins that require a lot of pre-buffering will also perform poorly such as Sonic Foundry Acoustic Mirror when using long impulse files.

Why do I hear gaps in my audio playback?

There are many reasons that your audio playback can gap.

- Playing back more simultaneous tracks than your hard drives can handle
- Running out of physical RAM can cause Windows to start using virtual memory
- Running too many DirectX plug-ins can use up all your computer’s power
- Having sound card driver problems can cause playback gapping

Below are a few things you can check and do to make sure your system is optimized to prevent gapping.
RAM usage meter

If the RAM usage meter at the bottom of the Vegas Pro Track View indicates that most of your physical RAM is in use, you could be gapping because Windows virtual memory is being used. Virtual memory is a method used by Windows to write information to your hard drive to make room in physical RAM. This process uses a lot of your computer’s resources.

To minimize the amount of RAM that you are using, try the following:
1. Exit all background applications not in use.
2. Adjust the playback buffering slider on the Preferences’ Audio tab. Adjust this slider as low as possible, but setting it too low will cause gaps as well.
3. Run fewer events simultaneously by muting or soloing them.
4. Add more RAM to your computer. However, after 128 MB, the performance increase that you get will start to decline.

Disk meter

If the Disk meter at the bottom of the Track View ever bounces near or above 50%, you will probably experience gapping. This issue is due to the data not being read off the hard drive fast enough.

To optimize the reading of data off the hard drive, try the following:
1. Fully defragment your audio hard drives regularly.
2. Split audio usage between different physical hard drives, not just different partitions of the same drive.
3. Run fewer events simultaneously. It is not how many tracks you have in the project, but how many different events are playing simultaneously that matters.

4. Make sure that you trim out any silent sections of events to minimize the wasted disk access.

5. Use hard drives with fast seek times and spindle speeds of 7200 RPM or greater. SCSI drives have better prolonged data transfer performance than IDE drives.

**CPU usage**

If neither the RAM or Disk meter looks out of the ordinary, you can try to adjust how Vegas Pro utilizes the central processing unit (CPU).

To optimize CPU usage, try the following:

1. If you are using video, turn off the Animate video strip option on the Preferences’ General tab.

2. Zoom out (Ctrl + [ ] ) fully on the Track View while playing so that the screen does not have to scroll to keep the cursor on it.

3. Run fewer DirectX plug-ins.

4. Make sure that the peak files are built for all of the audio data in the project before playing. Peaks are only built for those files on screen so you can get into the situation where the screen scrolls and it ends up building a peaks on-the-fly. You can play while peaks are being built, but on a CPU bound machine, it will gap for sure.

**Why can’t I get my other DirectX plug-ins to work as Track effects?**

This version of Vegas Pro has a special DirectX interface at the track level. It means that only DirectX plug-ins with a special wrapper will work in that position. The Track EQ, Compressor and Dither plug-ins will work there.
MPEG and Quicktime Video Audio/Video Synchronization Issues

Vegas Pro is able to open MPEG and Quicktime audio/video files that were encoded using Microsoft DirectShow codecs. However, there is an implementation issue that causes the audio and video to fall out of sync with each other. This happens frequently and it is not consistent in its offset. Therefore, this issue makes working with these types of files troublesome.

We are working to correct this issue for future versions of Vegas Pro. In the meantime, a workaround is to separately save out the video and audio portions of the files into AVI and Wave files, respectively. After that, you can reload them into Vegas Pro, re-synchronize them and the synchronization will stay constant.

Some AVI’s that open in Windows Media Player don’t open in Vegas Pro

Some newer AVI files use codecs that are unreadable by applications that do not support Microsoft DirectShow codecs. These files are usually either compressed with a DV or MPEG 4 codec. They might also be larger than the standard AVI file limit of 4 Gigabytes. Vegas Pro does not currently support these files.

Why does a mono event increase 6 dB when panning a track hard to either side?

In Vegas Pro, all audio events on tracks is stereo. So, a mono-audio event is interpreted as a stereo event with the same data in both channels. The Vegas Pro track-pan control preserves some amount of stereo separation when panning a stereo signal and gradually mixes the level from channel to channel. Therefore, with a mono-audio event, Vegas Pro is adding a duplicate of the event on top of itself. This duplication doubles the amplitude and results in a 6 dB increase in volume when you pan a track hard left or right. To compensate for this increase, adjust the tracks volume with the fader. Or, lower the event’s sustain portion using an event envelope (ASR). For more information, see Using event envelopes (ASR) on page 113.
A-Law

A companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines A-Law as a method of encoding 16-bit PCM signals into a non-linear 8-bit format. The algorithm is commonly used in United States' telecommunications. A-Law is very similar to μ-Law, however, each uses a slightly different coder and decoder.

Adaptive Delta Pulse Code Modulation (ADPCM)

A method of compressing audio data. Although the theory for compression using ADPCM is standard, there are many different algorithms employed. For example, Microsoft's ADPCM algorithm is not compatible with the International Multimedia Association's (IMA) approved ADPCM.

Aliasing

A type of distortion that occurs when digitally recording high frequencies with a low sample rate. For example, in a motion picture, when a car's wheels appear to slowly spin backward while the car is quickly moving forward, you are seeing the effects of aliasing. Similarly, when you try to record a frequency greater than one-half of the sampling rate (the Nyquist Frequency), instead of hearing a high pitch, you may hear a low-frequency rumble.

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the sound has been recorded, aliasing distortion is impossible to remove without also removing other frequencies from the sound. This same anti-aliasing filter must be applied when resampling to a lower sample rate.

Amplitude Modulation (AM)

A process whereby the amplitude (loudness) of a sound is varied over time. When varied slowly, a tremolo effect occurs. If the frequency of modulation is high, many side frequencies are created which can strongly alter the timbre of a sound.
Analog
When discussing audio, this term refers to a method of reproducing a sound wave with voltage fluctuations that are analogous to the pressure fluctuations of the sound wave. This is different from digital recording in that these fluctuations are infinitely varying rather than discrete changes at sample time (see Quantization).

Attack
The attack of a sound is the initial portion of the sound. Percussive sounds (drums, piano, guitar plucks) are said to have a fast attack. This means that the sound reaches its maximum amplitude in a very short time. Sounds that slowly swell up in volume (soft strings and wind sounds) are said to have a slow attack.

Audio Compression Manager (ACM)
The Audio Compression Manager, from Microsoft, is a standard interface for audio compression and signal processing for Windows. The ACM can be used by Windows programs to compress and decompress *.wav files.

Bandwidth
Refers to the EQ plug-in that is built in. Each frequency band has a width associated with it that determines the range of frequencies that are affected by the EQ. A narrow band with a wide bandwidth will affect a wider range of frequencies than one with a narrow bandwidth.

Beats Per Measure (BPM)
In music theory, the time signature of a piece of music contains two pieces of information: the number of beats in each measure of music, and which note value gets one beat. Vegas Pro uses this notion to determine the number of ticks to put on the Time ruler above the Track View, and to determine the spacing when the ruler is displaying Measures & Beats.

Beats Per Minute
In music theory, the tempo of a piece of music can be written as a number of beats in one minute. If the tempo is 60 BPM, a single beat occurs once every second. Lower BPM's equal slower tempo, and vice versa.

Bit
A bit is the most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a voltage in an electronic circuit. Bits are used to represent values in the binary numbering system. As an example, the 8-bit binary number 10011010 represents the unsigned value of 154 in the decimal system. In digital sampling, a binary number is used to store individual sound levels, called samples.
Bit Depth
The number of bits used to represent a single sample. Vegas Pro uses either 8, 16, or 24-bit samples. Higher values will increase the quality of the playback and any recordings that you make. While 8-bit samples take up less memory (and hard disk space), they are inherently noisier than 16 or 24-bit samples.

Byte
Refers to a set of 8 bits. A 8-bit sample requires one byte of memory to store, while a 16-bit sample takes two bytes of memory to store.

Clipboard
The clipboard is where data that you have cut or copied in Vegas Pro is stored. You can then paste the data back into Vegas Pro at a different location, or paste it into other applications, such as Microsoft Word, or another instance of Vegas Pro. Some data, such as audio, cannot be pasted into applications such as Microsoft Word or Notepad, but the text data from the Edit Details window can be pasted. This allows you to then print or format the data.

Clipping
Clipping is what occurs when the amplitude of a sound is above the maximum allowed recording level. In digital systems, clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16-bit data. Clipping causes sound to distort.

CODEC
An acronym for Coder/Decoder that is commonly used when working with data compression.

Crossfade
Mixing two pieces of audio by fading one out as the other fades in.

Cutoff frequency
The cutoff-frequency of a filter is the frequency at which the filter changes its response. For example, in a low-pass filter, frequencies greater than the cutoff frequency are attenuated while frequencies less than the cutoff frequency are not affected.

DC Offset
DC Offset occurs when hardware, such as a sound card, adds DC current to a recorded audio signal. This current causes the audio signal to alternate around a point above or below the normal -infinity dB (center) line in the sound file. To visually see if you have a DC offset present, you can zoom all the way into a sound file and see if it appears to be floating over the center line.
Decibel (dB)
A unit used to represent a ratio between two numbers using a logarithmic scale. For example, when comparing the numbers 14 and 7, you could say 14 is two times greater than the number 7; or you could say 14 is 6 dB greater than the number 7. Where did we pull that 6 dB from? Engineers use the equation \( \text{dB} = 20 \times \log \left( \frac{V1}{V2} \right) \) when comparing two instantaneous values. Decibels are commonly used when dealing with sound because the ear perceives loudness in a logarithmic scale.

In Vegas Pro, most measurements are given in decibels. For example, if you want to double the amplitude of a sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive sample value for 16-bit sound) can be referred to as having a value of 0 dB. Likewise, a sample value of 16,384 can be referred to having a value of -6 dB.

Device Driver
A program that enables Windows to connect different hardware and software. For example, a sound card device driver is used by Windows software to control sound card recording and playback.

Digital Signal Processing (DSP)
A general term describing anything that alters digital data. Signal processors have existed for a very long time (tone controls, distortion boxes, wah-wah pedals) in the analog (electrical) domain. Digital Signal Processors alter the data after it has been digitized by using a combination of programming and mathematical techniques. DSP techniques are used to perform many effects such as equalization and reverb simulation.

Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your computer’s processor and specialized DSP chips can be used to perform any DSP operation. The difference is that DSP chips are optimized specifically for mathematical functions while your computer’s microprocessor is not. This results in a difference in processing speed.

Dithering
The practice of adding noise to a signal to mask quantization noise.

Drag and Drop
A quick way to perform certain operations using the mouse in Vegas Pro. To drag and drop, you click and hold a highlighted selection, drag it (hold the left-mouse button down and move the mouse) and drop it (let go of the mouse button) at another position on the screen.
Dynamic Range
The difference between the maximum and minimum signal levels. It can refer to a musical performance (high volume vs. low volume signals) or to electrical equipment (peak level before distortion vs. noise floor). For example, orchestral music has a wide dynamic range, while thrash metal has a very small (always loud) range.

Endian (Little and Big)
Little and Big Endian describe the ordering of multi-byte data that is used by a computer's microprocessor. Little Endian specifies that data is stored in a low to high-byte format; this ordering is used by the Intel microprocessors. Big Endian specifies that data is stored in a high to low-byte format; this ordering is used by the Motorola microprocessors.

Envelopes (Audio and Video)
Envelopes, as used by Vegas Pro, are a way of automating the change of a certain parameter over time. In the case of Volume, you can create a fade out (which requires a change over time) by adding an envelope and creating an extra point to the line that indicates where the fade starts. Next, you pull the end point of the envelope down to infinity.

Equalization (EQ)
The process by which certain frequency bands are raised or lowered in level. EQ has various uses. The most common use for Vegas Pro users is to simply adjust the subjective timbral qualities of a sound.

Event
A media file that has been placed into a Vegas Pro project. The media file is placed on a track or the video ruler and plays back as an audio or video “event” along the project’s timeline.

File Format
A file format specifies the way in which data is stored on your floppy disks or hard drive. In Windows, the most common file format is the Microsoft *.wav format. However, Vegas Pro can read and write to many other file formats so you can maintain compatibility with other software and hardware configurations.

Frame Rate (Audio)
Audio uses frame rates only for the purposes of synching to video or other audio. In the latter case, the rate of 30 non-drop is typically used. In the former case, 30 drop is usually used.
Frame Rate (Video)
The speed at which individual images in the video are displayed on the screen. A faster frame rate results in smoother motion in the video. However, more times than not, frame rate is associated with SMPTE standard frame rates for video: 29.97, 25 or 24 for film.

Frequency Spectrum
The Frequency Spectrum of a signal refers to its range of frequencies. In audio, the frequency range is basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers to the distribution of these frequencies. For example, bass-heavy sounds have a large frequency content in the low end (20 Hz - 200 Hz) of the spectrum.

Hertz (Hz)
The unit of measurement for frequency or cycles per second (CPS).

Insertion Point
The Insertion Point (also referred to as the Cursor Position) is analogous to the cursor in a word processor. It is where pasted data is placed or other data is inserted, depending on the operation. The Insertion Point appears as a vertical flashing black line and can be moved by clicking the left mouse button anywhere in the waveform display of a data window.

Markers
Saved locations in the sound file. Markers are stored in the Regions List and can be used for quick navigation.

Markers can be displayed in the Trimmer window for sound files that contain them, but more often, markers and regions are used at the project level to mark interesting places in the project.

Media Control Interface (MCI)
A standard way for Windows programs to communicate with multimedia devices like sound cards and CD players. If a device has a MCI device driver, it can easily be controlled by most multimedia Windows software.

Media Player
A Microsoft Windows program that can play digital sounds or videos using MCI devices. Media Player is useful for testing your sound card setup. For example, if you can't hear sound when using Vegas Pro, try using Media Player. If you can't play sound using Media Player, check the sound card's manual. Please contact your sound card manufacturer before calling Technical Support at Sonic Foundry.
MIDI Clock
A MIDI device specific timing reference. It is not absolute time like MIDI Time Code (MTC); instead, it is a tempo-dependent number of “ticks” per quarter note. MIDI Clock is convenient for syncing devices that need to do tempo changes mid-song. Vegas Pro supports MIDI Clock out, but does not support MIDI Clock in.

MIDI Port
A MIDI Port is the physical MIDI connection on a piece of MIDI gear. This port can be a MIDI in, out or through. Your computer must have a MIDI to output MIDI Time Code to an external device or to receive MIDI Time code from an external device.

MIDI Time Code (MTC)
MTC is an addendum to the MIDI 1.0 Specification and provides a way to specify absolute time for synchronizing MIDI capable applications. Basically, it is a MIDI representation of SMPTE time code.

Mix
A function Vegas Pro performs inherently by adding events to multiple audio tracks.

Multiple Stereo
A mixer configuration that allows you to assign individual tracks to any number of stereo output busses. In single stereo mode, all tracks go out the same stereo bus. Multiple stereo configuration allows you to keep your signals from the Tracks discrete if you want them to be.

Musical Instrument Device Interface (MIDI)
A standard language of control messages that provides for communication between any MIDI compliant devices. Anything from synthesizers to lights to factory equipment can be controlled via MIDI. Vegas Pro utilizes MIDI for synchronization purposes.

Noise-shaping
Noise-shaping is a technique which can minimize the audibility of quantization noise by shifting its frequency spectrum. For example, in 44,100 Hz audio, quantization noise is shifted towards the Nyquist Frequency of 22,050 Hz.

Non-Destructive Editing
This type of editing involves a pointer-based system of keeping track of edits. When you delete a section of audio in a non-destructive system, the audio on disk is not actually deleted. Instead, a set of pointers is established to tell the program to skip the deleted section during playback.
Normalize
Refers to raising the volume so that the highest level sample in the file reaches a user-defined level. Use this function to make sure you are fully utilizing the dynamic range available to you.

Nyquist Frequency
The Nyquist Frequency (or Nyquist Rate) is one-half of the sample rate and represents the highest frequency that can be recorded using the sample rate without aliasing. For example, the Nyquist Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 22,050 Hz will produce aliasing distortion in the sample if no anti-aliasing filter is used while recording.

Pan
To place a mono or stereo sound source perceptually between 2 or more speakers.

Peak Data File
The file created by Vegas Pro when a file is opened for the first time. This file stores the information regarding the graphic display of the waveform, so that opening a file is almost instantaneous. The peak data file is stored in the directory in which the file resides and has a .sfk extension. If the peak data file is not in the same directory as the file, or is deleted, it will be recalculated the next time you open the file.

Plug-In
An effect that can be added to the product to enhance the feature set. Vegas Pro supports all DirectX plug-ins. The built-in EQ, Compression and Dithering effects are also considered plug-ins because they work in other DirectX-compatible applications.

Plug-In Chain
Plug-ins can be strung together into a chain so that the output of one effect feeds into the input of another. This allows for complex effects that couldn’t otherwise be created.

Pre-roll/Post-roll
Pre-roll is the amount of time elapsed before an event occurs. Post-roll is the amount of time after the event. The time selection defines the pre- and post-roll when recording into a selected event.
Preset
A snapshot of the current settings in a plug-in. Presets are created and named so that you can easily get back to a sound that you have previously created.

A preset calls up a bulk setting of a function in Vegas Pro. If you like the way you tweaked that EQ, but do not want to have to spend the time getting it back for later use, save it as a preset. All presets show up in the combo box on the top of most function dialogs in Vegas Pro.

Pulse Code Modulation (PCM)
PCM is the most common representation of uncompressed audio signals. This method of coding yields the highest fidelity possible when using digital storage.

Punch-In
Punching-in during recording means automatically starting and stopping recording at user-specified times.

Quadraphonic
A mixing implementation that allows for four (4) discrete audio channels. These are usually routed to two (2) front speakers and two back speakers to create immersive audio mixes.

Quantization
The process by which measurements are rounded to discrete values. Specifically with respect to audio, quantization is a function of the analog-to-digital conversion process. The continuous variation of the voltages of an analog audio signal are quantized to discrete amplitude values represented by digital, binary numbers. The number of bits available to describe these values determines the resolution or accuracy of quantization. For example, if you have 8-bit analog-to-digital converters, the varying analog voltage must be quantized to 1 of 256 discrete values; a 16-bit converter has 65,536 values.

Quantization Noise
A result of describing an analog signal in discrete digital terms (see Quantization). This noise is most easily heard in low resolution digital sounds that have low bit depths and is similar to a “shhhhh” type sound while the audio is playing. It becomes more apparent when the signal is at low levels, such as when doing a fade out.

Region
A subsection of a sound file denoted by a start and end point. You can define any number of regions in a sound file.
Resample
The act of recalculating samples in a sound file at a different rate than the file was originally recorded. If an audio file is resampled at a lower rate, Vegas Pro decreases sample points. As a result, the file size and the frequency range are reduced. Resampling to a higher sample rate, Vegas Pro will interpolate extra sample points in the sound file. This increases the size of the sound file but does not increase the quality. When down-sampling, one must be aware of aliasing (see Aliasing). Vegas Pro automatically resamples all audio that is added to the project’s sample rate.

Ruler Tags
Small tab-shaped controls above the Time Ruler that represent the location of markers, regions, and loop points in the waveform display.

Ruler, Time
The Time Ruler is the area on a data window above the tracks display window that shows the horizontal axis units.

Sample
The word “sample” is used in many different (and often confusing) ways when talking about digital sound. Here are some of the different meanings:

- A discrete point in time which a sound signal is divided into when digitizing. For example, an audio CD-ROM contains 44,100 samples per second. Each sample is really only a number which contains the amplitude value of a waveform measured over time.
- A sound which has been recorded in a digital format; used by musicians who make short recordings of musical instruments to be used for composition and performance of music or sound effects. These recordings are called samples. In this manual, we try to use sound file instead of sample whenever referring to a digital recording.

The act of recording sound digitally, i.e. to sample an instrument, means to digitize and store it.

Sample Rate
The sample rate (also referred to as the sampling rate or sampling frequency) is the number of samples per second used to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity than lower sample rates, such as 11,025 Hz. However, more storage space is required when using higher sample rates.

Sample Size
See Bit Depth.
Sample Value

The sample value (also referred to as sample amplitude) is the number stored by a single sample. In 16-bit audio, these values range from -32768 to 32767. In 8-bit audio, they range from -128 to 127. The maximum allowed sample value is often referred to as 100% or 0 dB.

Shortcut Menu

A context-sensitive menu which appears when you click on certain areas of the screen. The functions available in the shortcut menu depend on the object being clicked on as well as the state of the program. As with any menu, you can select an item from the shortcut menu to perform an operation. Shortcut menus are used frequently in Vegas Pro for quick access to many commands. An example of a shortcut menu can be found by right-clicking on any waveform display in a data window.

Sign-Bit

Data that has positive and negative values and uses zero to represent silence. Unlike the Signed format, two's complement is not used. Instead, negative values are represented by setting the highest bit of the binary number to one without complementing all other bits. This is a format option when opening and saving RAW sound files.

Signal-to-Noise Ratio

The signal-to-noise ratio (SNR) is a measurement of the difference between a recorded signal and noise levels. A high SNR is always the goal.

The maximum signal-to-noise ratio of digital audio is determined by the number of bits per sample. In 16-bit audio, the signal to noise ratio is 96 dB while in 8-bit audio it's 48 dB. However, in practice this SNR is never achieved, especially when using low-end electronics.

Signed

Data that has positive and negative two's complement values and uses zero to represent silence. This is a format option when opening and saving RAW sound files.

Small Computer Systems Interface (SCSI)

A standard interface protocol for connecting devices to your computer. The SCSI bus can accept up to seven devices at a time including CD ROM drives, hard drives and samplers.

Society of Motion Picture and Television Engineers (SMPTE)

SMPTE time code is used to synchronize time between devices. The time code is calculated in Hours:Minutes:Second:Frames, where Frames are fractions of a second based on the frame rate. Frame rates for SMPTE time code are 24, 25, 29.97 and 30 frames per second.
Sound Card
The sound card is the audio interface between your computer and the outside world. It is responsible for converting analog signals to digital and vice versa. There are many sound cards available on the market today covering the spectrum of quality and price. Vegas Pro will work with any Windows-compatible sound card.

Stereo
Mixer implementation that includes 2 discrete channels.

Surround
Mixer implementation that includes 6 discrete channels.

Tempo
Tempo is the rhythmic rate of a musical composition, usually specified in Beats Per Minute (BPM).

Time Format
The format by which Vegas Pro displays the Time Ruler and selection times. These include: Time, Seconds, Frames and all Standard SMPTE frame rates. The status format is set for each sound file individually.

Time Signature
See Beats per Measure.

Track
A discrete timeline for audio data. Audio events sit on audio tracks and determine when a sound starts and stops. Multiple audio tracks are mixed together to give you a composite sound that you hear through your speakers.

Trim/Crop
A function that will delete all data in a sound file outside of the current selection.

µ-Law
µ-Law (mu-Law) is a companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines µ-Law as a method of encoding 16-bit PCM signals into a non-linear 8-bit format. The algorithm is commonly used in European and Asian telecommunications. µ-Law is very similar to A-Law, however, each uses a slightly different coder and decoder.
Undo Buffer
This is the temporary file created before you do any processing to a project. This undo buffer allows the ability to rewrite previous versions of the project if you decide you don't like changes you've made to the project. This undo buffer is erased when the file is closed or the Clear Undo History command is invoked.

Undo/Redo
These commands allow you to change a project back to a previous state, when you don't like the changes you have made, or reapply the changes after you have undone them. The ability to Undo/Redo is only limited by the size of your hard drive. See Undo Buffer.

Undo/Redo History
A list of all of the functions that have been performed to a file that are available to be undone or redone. Undo/Redo History gives you the ability to undo or redo multiple functions as well as preview the functions for quick A/B-ing of the processed and unprocessed material. To display the history list, click the down-arrow button next to the Undo and Redo buttons.

unsigned
Data that has only positive values and uses half the maximum value to represent silence. This is a format option when opening and saving RAW sound files.

Video for Windows (AVI)
A file format of digital video for Windows. Vegas Pro allows you to open .AVI files and edit the audio embedded within them.

Virtual MIDI Router (VMR)
A software-only router for MIDI data between programs. Vegas Pro uses the VMR to receive MIDI Time Code and send MIDI Clock. No MIDI hardware or cables are required for a VMR, so routing can only be performed between programs running on the same PC. Sonic Foundry supplies a VMR with Vegas Pro called the Sonic Foundry Virtual MIDI Router.

Waveform
A waveform is the visual representation of wave-like phenomena, such as sound or light. For example, when the amplitude of sound pressure is graphed over time, pressure variations usually form a smooth waveform.
Waveform Display
A section inside of the Trimmer window that shows a graph of the sound data waveform. The vertical axis corresponds to the amplitude of the wave. For 16-bit sounds, the amplitude range is -32,768 to +32,767. For 8-bit sounds, the range is -128 to +127. The horizontal axis corresponds to time, with the left-most point being the start of the waveform. In memory, the horizontal axis corresponds to the number of samples from the start of the sound file.

Zero-crossing
A zero-crossing is the point where a fluctuating signal crosses the zero amplitude axis. By making edits at zero-crossings with the same slope, the chance of creating glitches is minimized.

Zipper noise
Zipper noise occurs when you apply a changing gain to a signal, such as when fading out. If the gain does not change in small enough increments, zipper noise can become very noticeable. Vegas Pro fades are accomplished using 64-bit arithmetic, thereby creating no audible zipper noise.
Index

A
Activation code, 15
Active take, selecting, 209
Adding empty tracks, 131
AIFF
bit-rate, 223
channels, 224
rendering, 219
sample rate, 223
saving a template, 224
templates, 223
Arming tracks to record, 38, 201
ASR  See Envelopes
Assignable FX, 186–195
adding via Plug-in Chooser, 187
adding via Plug-in Explorer, 188
adjusting for clipping, 194
assigning track to, 140
bypassing plug-ins, 190
changing plug-in order, 189
control, 186
deleting, 191
meter resolution, 193
muting, 194
naming/renaming, 195
routing to buses, 192
send, 40
soloing, 195
tracks, See Track FX
volume adjustment, 140
Audio editing, 93–129
Audio files  See Events
Audio preferences, 272
advanced control settings, 274
controls, 272–274
Audio property settings, 265
Auxiliary bus, 40
track assignment, 138
volume adjustment, 139
AVI
bit-depth, 233
channels, 234
format, 233
frame rate, 234
frame size, 235
rendering, 220
sample rate, 233
saving a template, 236
template, 232
video compression, 235

B
Bus assignment, 37
Busses, 173–185
adding plug-ins via Plug-in Chooser, 181
adding plug-ins via Plug-in Explorer, 182
adding to project, 173
adjusting faders, 178, 193
adjusting for clipping, 179
arranging plug-ins, 183
assign track to, 138
assigning plug-ins to, 181
bypassing plug-ins, 184
controls, defined, 173
deleting from project, 175
deleting plug-ins, 185
meter resolution, 178
muting, 179
naming/renaming, 180
routing to hardware, 176
soloing, 180

Bypassing
Assignable FX plug-ins, 190
bus plug-ins, 184
track plug-ins, 146

C
Color, tracks, 135
Command markers, 86
defined, 87
deleting, 90
editing, 88
moving, 88
naming, 89
navigating, 89
placing, 87
Scott Studios, defined, 86

Compression plug-in, 152
amount control, 154
attack control, 154
auto gain comp. control, 155
controlling clipping, 152
input gain control, 153
output gain control, 153
presets, 153
reduction meter, 154
release control, 155
smooth saturation control, 155
threshold control, 154

Computer ID number, 15

Converting format  See Rendering a project

Copying events, 69
time and events, 70
time selection, 69

Crossfades, 115-117
automatic, 115
curve types, 116
curve types, changing, 116
manually setting, 116
volume, changing, 117

Ctrl. key selecting, 66

Cursor, using, 65

Customizing Vegas Pro, 243-280
docking windows, 243
Explorer window, 245-252
preferences, 268-280
project grid spacing, 254
project properties, 263-267
project ruler, 253
time display window, 261-263
toolbar, 255-260

Cutting events, 73-74
ripple mode, 98
time and event selection, 73

Cutting time and events
ripple mode, 99

Cutting time selection
ripple mode, 99

D
Deleting a track, 133
Deleting Assignable FX, 191
Deleting events, 75, 76
ripple mode, 100
time and event selection, 76
time selection, 76
Deleting plug-ins, 185
Deleting time and events
ripple mode, 100
Deleting time selection
ripple mode, 100
Desktop shortcut, 14
Digital multitrack setup, 200
DirectX plug-ins, 181
<table>
<thead>
<tr>
<th>Dither plug-in, 158</th>
<th>Equipment setup, 199-200</th>
</tr>
</thead>
<tbody>
<tr>
<td>dither depth, 159</td>
<td>basic, 199</td>
</tr>
<tr>
<td>noise shape type control, 159</td>
<td>mixer, 200</td>
</tr>
<tr>
<td>presets, 158</td>
<td>with digital multitrack, 200</td>
</tr>
<tr>
<td>quantization control, 159</td>
<td>with MIDI option, 200</td>
</tr>
<tr>
<td>Docking Vegas Pro windows, 243-244</td>
<td>European contact information</td>
</tr>
<tr>
<td>Duplicating a track, 132</td>
<td>Title page</td>
</tr>
</tbody>
</table>

**E**

<table>
<thead>
<tr>
<th>Edit Details window, 124-129</th>
<th>Event edge fade, setting, 273</th>
</tr>
</thead>
<tbody>
<tr>
<td>commands category, 128</td>
<td>Event editing, basics, 69-76</td>
</tr>
<tr>
<td>customizing, 129</td>
<td>Event properties</td>
</tr>
<tr>
<td>displaying, 125</td>
<td>name, changing, 104</td>
</tr>
<tr>
<td>edit functions, 124</td>
<td>pitch shift, 106</td>
</tr>
<tr>
<td>events category, 125</td>
<td>switches, 107</td>
</tr>
<tr>
<td>markers category, 127</td>
<td>viewing name, 104, 105</td>
</tr>
<tr>
<td>media category, 128</td>
<td>Event switches, 80-112</td>
</tr>
<tr>
<td>regions category, 127</td>
<td>locking, 109</td>
</tr>
<tr>
<td>selected events category, 126</td>
<td>looping, 110</td>
</tr>
<tr>
<td></td>
<td>muting, 108</td>
</tr>
<tr>
<td>Edit history, clearing, 79</td>
<td>normalizing, 111</td>
</tr>
<tr>
<td>Edit tool, selection, 67</td>
<td>normalizing, recalculating, 111</td>
</tr>
<tr>
<td>Editing</td>
<td>Event takes</td>
</tr>
<tr>
<td>time vs. event, 66</td>
<td>deleting, 211</td>
</tr>
<tr>
<td>Email technical support, 12</td>
<td>deleting active, 211</td>
</tr>
<tr>
<td>Encoding wizard (RealMedia), 240</td>
<td>deleting from list, 212</td>
</tr>
<tr>
<td>Event editing, basics, 69-76</td>
<td>renaming, 210</td>
</tr>
<tr>
<td>Events</td>
<td>Event, recording into, 206</td>
</tr>
<tr>
<td>copying, 69</td>
<td>Events</td>
</tr>
<tr>
<td>crossfading, 115-117</td>
<td>copying, 69</td>
</tr>
<tr>
<td>cutting, 73</td>
<td>crossfading, 115-117</td>
</tr>
<tr>
<td>defined, 29</td>
<td>cutting, 73</td>
</tr>
<tr>
<td>deleting, 75</td>
<td>defined, 29</td>
</tr>
<tr>
<td>editing, 54, 56</td>
<td>deleting, 75</td>
</tr>
<tr>
<td>envelopes (ASR), 113</td>
<td>editing, 54, 56</td>
</tr>
<tr>
<td>grouping, 57, 118-119</td>
<td>envelopes (ASR), 113</td>
</tr>
<tr>
<td>locking, 54</td>
<td>grouping, 57, 118-119</td>
</tr>
<tr>
<td>moving in time, 34</td>
<td>locking, 54</td>
</tr>
<tr>
<td>moving multiple, 35</td>
<td>moving in time, 34</td>
</tr>
<tr>
<td>moving single, 35</td>
<td>moving multiple, 35</td>
</tr>
<tr>
<td>name, changing, 104</td>
<td>moving single, 35</td>
</tr>
<tr>
<td>name, viewing, 104</td>
<td>name, changing, 104</td>
</tr>
<tr>
<td>pasting, 70-72</td>
<td>name, viewing, 104</td>
</tr>
<tr>
<td>placing, 33, 34, 52</td>
<td>pasting, 70-72</td>
</tr>
<tr>
<td>properties, setting, 103-112</td>
<td>placing, 33, 34, 52</td>
</tr>
<tr>
<td>removing from video, 42</td>
<td>properties, setting, 103-112</td>
</tr>
</tbody>
</table>
ripple edits, 98–102
selecting options, 66
selecting with time, 68
snapping, 93
splitting, 96
splitting with time selection, 55
trimming/cropping, 74
Expanding a track, 136
Explorer window, 23
    all files view, 252
    auto preview, 251
details view, 252
managing media files, 246–250
previewing media files, 250
region view, 251
summary view, 252
toolbar, 245
transport bar, 32, 250
tree view, 251
using, 30, 50, 245
view options, 31, 251–252
Fader
    Assignable FX, 140
auxiliary bus, 139
track, 136
Fax technical support, 13
General editing, 65–92
cursor, 65
time vs. event, 66
General preferences, 269
Glossary, 285–298
Grid lines
    changing spacing, 254
    changing type, 94
    enable/disable snapping, 94
    snapping events to, 94
Grouping events, 57, 118–119
clearing, 119
creating new, 118
removing event from, 119
Installation, 13
    system requirements, 12
Keyboard commands, 25–27
cursor placement, 26, 65
edit, 25
event, 26
miscellaneous, 27
playback, 26
project file, 25
track view, 27
view, 27
window view, 25
Labeling Assignable FX, See Naming Assignable FX
Labeling busses, See Naming busses
Labeling tracks, See Naming tracks
Locking audio events, 109
Main window, 19
Managing media files, 246–250
    adding folder to Favorites, 250
    creating folders, 248
deleting files and folders, 249
    finding media files, 246
    moving files, 247
    renaming files and folders, 248
Marker
    deleting, 82
    naming, 81
    navigating, 82
    placing and moving, 80
Marker bar, 20
Markers and regions, 80–90
  enabling/disabling snapping, 95
  snapping events to, 95
Media files
  adding to Favorites, 250
  auto preview setting, 32
  creating folders, 248
  defined, 29
  deleting, 249
  finding, 246
  moving, 247
  opening, 32
  placing audio, 33
  placing video, 34
  previewing, 32
  renaming, 248
  video placement options, 34
Media formats for import, 29
Microsoft Encoding wizard, 231, 237
MIDI Clock output, 279
MIDI Time Code
  input devices, 276
  output devices, 278
  time display window, 263
Mix to new, template, 168
Mix to preview, 44
  status bar, 44
Mixer, 169–198
  busses, 173–185
  preview fader, 170–172
  toolbar, defined, 170
  viewing/hiding, 169
Mixer setup, 200
Mixer window, 24
Mixing multiple tracks to one track, 167
  creating template, 168
MPEG
  rendering, 219
  saving a template, 228
  template, 227
Multiple takes
  previewing, 208
  recording, 208
Mute button, 38
Muting a bus, 179
Muting a track, 137
Muting an Assignable FX, 194
Naming Assignable FX, 195
Naming busses, 180
Naming tracks, 134
Noise Gate plug-in, 156
  attack time control, 157
  presets, 156
  release time control, 157
  threshold control, 157
Normalize peak level, setting, 274
Numbers
  activation code, 15
  serial, 15
Online help, 17
  accessing, 17
  icon, 17
PDF manual, 18
Tip of the day, 18
  via the web, 18
What's This? help, 17
Online registration, 15
Organizing tracks, 134
Panning, 40, 164–166
Panning envelopes
  adding, 164
  deleting from track(s), 166
  hiding from track(s), 166
  setting points, 165
INDEX

Paste insert, 72
Paste repeat, 71
Pasting events, 70–72
    ripple mode, 101
Pasting multitrack information
    ripple mode, 102
Pasting track information
    ripple mode, 101
PDF online manual, 18
Pitch shift, 106
Placing media
    as takes, 33
    double-clicking, 34
    dragging/dropping, 33
    multiple files, 33
    same track, 33
    separate tracks, 33
Playback
    interpolate cursor position control, 274
    position bias control, 275
    pre-roll buffer control, 275
    video, 52
Playback buffer, control, 272
Playback buttons See Transport bar
Plug-in chain
    changing order, 146
    changing order from Track FX dialog, 145
    creating on tracks, 142
Plug-in chain presets
    saving (track), 148
Plug-in chain, changing order, 145, 183
Plug-in, reference, 149-159
Preference settings, 268–280
    audio tab, 272
    audio tab, advanced settings, 274
    general tab, 269
    routing tab, 270
    sync tab, 275
    sync tab, advanced settings, 276
    viewing dialog, 268
Preferences
    active take names, disabling, 105
    active take names, enabling, 105
Preset chains, 196–198
    editing, 198
    organizing, 198
    saving, 196
    saving during creation, 196
    saving from existing chains, 197
Preview fader
    adjusting for clipping, 172
    adjusting volume, 171
    hiding/viewing, 172
    meter resolution, 171
Project playback, 42
    entire, 43
    media player, 44
    mix to preview, 44
    time selection, 43
Project properties, 45
Project property settings, 263–267
    audio tab, 265
    ruler tab, 267
    summary tab, 264
    video tab, 266
Project, starting a, 30
Properties
    events, setting, 103
Q
    Quick start, 29–47
    starting a project, 30
R
    RealMedia
        rendering, 221
    RealMedia (*.rm)
        encoding wizard, 240
        saving a template, 240–241
            templates, 239
    RealMedia commands, defined, 86
Recording, 199–214
  arming tracks, 201
  choosing an active take, 209
  deleting a take, 211
  deleting active take, 211
  deleting takes from list, 212
  into a time selection, 205
  into an event, 206
  into an event with time selection, 207
  into empty track, 204
  multiple takes, 208
  previewing takes, 208
  renaming a take, 210
  selecting track input devices, 141, 202
  specifying storage folder, 213
  starting and stopping, 203
Stereo, left, right channel options, 141, 201, 202
  track setup, 141
Redo command, 78
  series of edits, 78
Redo/Undo commands, 77–79
  clearing history, 79
Region, 83
  deleting, 85
  naming, 84
  navigating, 85
  placing and adjusting, 83
  selecting, 84
Registering Vegas Pro, 15
  online, 15
  telephone, 16
Removing (track) plug-ins
  from FX Plug-in Chooser dialog, 147
  from Track FX dialog, 147
Removing plug-ins, 147
Renaming a project
  Save As..., 46, 216
Rendering
  AIFF (*.aif), 219
  MPEG (*.mp3), 219
  RealMedia (*.rm), 221
  Video for Windows (*.avi), 220
  Wave (Microsoft) (*.wav), 219
  Windows Media Audio (*.wma), 219
  Windows Media Format (*.asf), 221
  Rendering a project, 47, 62, 218–241
    audio formats, 219
    controls and templates, 222
    format options, 47, 62, 218
    streaming formats, 221
    video format, 220
Reordering tracks, 134
Ripple editing, 98–102
  cutting events, 98
  cutting time and event selection, 99
  cutting time selection, 99
  deleting events, 100
  deleting time and event selection, 100
  deleting time selection, 100
  pasting events, 101
  pasting multitrack information, 102
  pasting track information, 101
Routing hardware preferences, 270
Ruler, 21
  changing settings, 253
  offset, setting, 254
  property settings, 267
  time formats, 253
S
Saving a project, 45, 61, 215–241
  first time, 45
  options, 45, 215
  Saving As (project), 216
  Saving As dialog commands, 217
Scott Studio commands, 86, 269
Scribble Strip, 39
Scrub control, 22
Selection Edit tool, 67
Serial Number, 15
  Shift key selecting, 66
Shortcut keys, See Keyboard commands
Signal flow, 28
INDEX

Snap offset, 93
Snaping events, 93–95
  disabling, 95
  snap offset, 93
  to grid lines, 94
  to marker lines, 95
Solo button, 38
Soloing a bus, 180
Soloing a track, 137
Soloing an Assignable FX, 195
Sound editor program, 90–92
  opening from Trimmer, 124
  opening from Vegas Pro, 92
  setting up, 90
Splitting, 96–98
  event and time selection, 98
  event selection, 97
  time selection, 97
  without selection, 97
Splitting events, 55
Starting Vegas Pro, 14
Streaming media commands, 86
  for RealPlayer, 86
  for Windows Media, 86
Switches, 107–112
  locking an event, 109
  looping an event, 110
  muting an event, 108
  normalizing an event, 111
Sync. preferences, 275
  advanced control settings, 276
Synchronizing audio with video, 53, 56
System requirements, 12
  common, 12
  minimum, 12
  recommended, 12

T
Target media player, previewing on, 44
Technical support, 12
  email, 12
  fax, 13
  telephone number, 13
  web site, 12
Technical support Title page
Telephone registration, 16
Time display window, 261
  changing color usage, 262
  changing time format, 261
  MIDI Time Code settings, 263
Time selection, 67
  copying, 69
  cutting, 73
  deleting, 76
  editing, 55
  trim/crop, 75
  with events, 68
Time selection, recording into, 205
Timeline
  moving events along, 34, 41
Tip of the day help, using, 18
Toolbar, 20
  adding buttons to, 258
  hiding/displaying, 256
  moving, 255
  removing buttons from, 259
  reordering buttons on, 257
  resizing, 256
Track envelopes, 160–166
  changing panning curves, 165
  changing volume curves, 162
  deleting from track(s), 163
  hiding on track(s), 163
Track features, 131–168
Track FX, 142–159
  adding via Plug-in Chooser dialog, 142
  adding via Plug-in Explorer window, 144
bypassing plug-ins, 146
Compression plug-in, 152
creating a plug-in chain, 142
Dither plug-in, 158
Equalization plug-in, 149
Noise Gate plug-in, 156
rearranging chain order, 145
reference, 149–159
removing plug-ins from chain, 147
saving preset chain, 148
Track FX button, 37
Track List, 21
Track Number, 36
Track panning envelopes
adding, 164
adding points, 164
deleting from track(s), 166
deleting points, 165
hiding on track, 166
resetting points, 165
setting points, 165
Track View, 22
Track Volume envelopes
adding, 160
adding points, 161
colors defined, 160
deleting points, 161
resetting points, 161
setting points, 161
Tracks
adding empty, 131
arm for record button, 38
Aassignable FX send, 40
Aassignable FX, assigning, 140
auxiliary bus, 40
auxiliary bus, assigning, 138
basics, 131–141
bus assignment, 37
bus, assigning, 138
color, changing, 135
defined, 29
deleting, 133
duplicating, 132
expanding the view, 136
fader, using, 136
FX button, 37
mixing to a single track, 167
multi-purpose slider, 40
mute button, 38
muting, 137
naming/renaming, 134
Number, 36
organizing, 134
panning, 40, 164–166
recording into, 141, 204
reordering, 134
scribble strip, 39
solo button, 38
soloing, 137
view buttons, 37
view options, 135
volume fader, 39
Transport bar, 22, 42, 52
reference, 43
Trimmer window, 24, 120–124
event, placing, 121
event, placing from track, 121
events, placing from Explorer, 122
events, placing on track, 122
overview, 120
regions and markers, adding, 123
sound editor, opening from, 124
working with, 122
Trimming events, 74
time and event selection, 75
time selection, 75
Troubleshooting, 281–284
Tutorial, 49–63
aligning audio with video, 53, 56
editing time selection, 55
editing voice-over, 54
equalization (EQ) settings, 60
event editing, 56
folder, copying, 49
grouping audio and video, 57
locking events, 54
placing music bed, 58
INDEX

rendering the project, 62
saving the project (*.veg), 61
splitting an event, 55
time selection editing, 55
video compression settings, 63
video placement, 50
video playback, 52
Video Preview window, 51
voice-over placement, 52
volume envelope, 58

U
Undo command, 77
series of edits, 77
Undo/Redo commands, 77-79
clearing history, 79
US contact information Title page

V
Vegas Pro
creating a copy of a project, 216
project properties, 45
registering, 15
renaming a project, 46
rendering a project, 47, 218-241
saving a project, 45, 215
shortcut, 14
starting, 14
Vegas Pro overview, 19-28
Explorer window, 23
Keyboard commands, 25
Main window, 19
Marker bar, 20
Mixer window, 24
Ruler, 21
Scrub control, 22
Toolbar, 20
Track list, 21
Track view, 22
Transport bar, 22
Trimmer window, 24
Video preview window, 24
Windows Docking Area, 23

Vegas Pro windows, docking, 244
Video compression, 63
Video event
basics, 41
moving along timeline, 41
placement options, 34
placement, 34, 50
removing audio, 42
Video preview window, 24, 51
Video property settings, 266
View buttons, 37
View options, tracks, 135
Volume
AssignFX fader, 140
auxiliary bus fader, 139
track fader, 136
Volume envelopes, 160-163
adding, 58
deleting from track(s), 163
hiding on track(s), 163
setting points, 59, 161

W
Wave (Microsoft)
bit-depth, 226
channels, 226
formats, 225
rendering, 219
sample rate, 226
saving a template, 227
templates, 225
Web site
help, using, 18
technical support, 12
What’s This? help, using, 17
Window Docking Area, 23, 244
Windows Media Audio
Microsoft encoding wizard, 231
rendering, 219
saving a template, 231
template, 230
Windows Media Format (*.asf)
  Microsoft encoding wizard, 237
  redirector, 236
  rendering, 221
  saving a template, 237–238
  template, 237

Windows Media streaming command, defined, 86